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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws,
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or

liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation,
Inc., is prohibited

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

> D>

IMPORTANT  Identifies information that is critical for successful application and understanding of the product.

Labels may also be on or inside the equipment to provide specific precautions.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may
reach dangerous temperatures.

ARCFLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).

B> > >
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Preface

Purpose of the User Manual

This document describes the steps necessary to start development of your
PlantPAx” DCS system. Procedures step you through how to take default
PlantPAx system attributes and customize them for your specific

system requirements.

To receive the maximum benefit from this document, we assume that your
infrastructure is configured in accordance with the procedures documented
in the PlantPAx DCS Infrastructure Configuration User Manual,
publication PROCES-UMO001.

We suggest that you perform the tasks in the order that is outlined in each
chapter. However, each task has standalone screen facsimiles and step-by-step
procedures to let you skip to other chapters if necessary. Each chapter has a
flowchart that summaries the topics, similar to a mini Table of Contents.

Figure 1 shows the documents (this manual in the highlighted section) that are
available to help design and implement your system requirements.

Figure 1 - PlantPAx System Implementation and Documentation Strategy

Define and
Procure

- Selection Guide
PROCES-SGO01

) o | e

- Virtualization User Manual
9528-UM001

__ __
Develop Operate
__ | ‘ __
- Infrastructure User Manual « Application User Manual - Verify and Troubleshoot User Manual
PROCES-UMO001 PROCES-UMO003 PROCES-UMO004
«  Reference Manual « Reference Manual « Reference Manual
PROCES-RM001 PROCES-RM001 PROCES-RM001

« Library of Process Objects
PROCES-RM002
PROCES-RMO13
PROCES-RM014

e Define and Procure — Helps you understand the elements of the
PlantPAx system to make sure that you buy the proper components.

e Install - Provides direction on how to install the PlantPAx system.

e Prep - Provides guidance on how to get started and learn the best
practices to follow before you develop your application.

e Develop — Describes the actions and libraries necessary to construct
your application that resides on the PlantPAx system.

e Operate — Provides guidance on how to verify and maintain your
systems for operation of your plant.
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Preface

New and Updated Information

This table contains the changes that are made to this revision.

Topic Page

lllustration of how to build a PlantPAx application 13

Application Code Manager description and options 14,16,17
Manual Conventions For instructional purposes, this manual uses visual tools to complement the

procedures. Icons that represent system elements are shown at the start of a
section to help identify the system element that is being configured in the steps.

The element’s abbreviation is listed with the icon for identification as shown in
the example.

Use an engineering workstation
with these procedures.

D ! <«——— SystemElement Icon

<4— System Element Identifier

«— System Element Description

See Table 1 for descriptions and abbreviations of the system element icons.

Table 1 - Visual Naming Conventions

Icon Description Abbreviation Element Names Topic Page

Logix controllers « LGXCO1 - Controller 55,59,63

ii «LGXC02 - Controller
[ 1 ]

PlantPAx workstations . 0WSO1 - Operator workstation 57,135, 201,233
. Ewsor® —Englneerlngworkstatlon

PlantPAx Application servers « ASISO1 - AppServ-Info SQL server 61,201
ASIHOT - AppServ-Info Historian server

ASIVO1 - AppServ-Info VantagePoint server

ASAMO1 - AppServ-Asset Management server
ASBMO1 - AppServ-Batch server

ASEWSO01 - AppServ-Engineering Workstation server
ASOWSO01 - AppServ-Operator Workstation server

PASS « PASS01 - FactoryTalk® Directory 61

(Process Automation System Server) PASS02A - Primary HMI server
« PASS02B - Secondary HMI Server

(1)  EWSand OWS are used throughout the manual but the same procedures apply for AppServ-EWS and AppServ-OWS.
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Preface

Action Identifier

Dialog boxes have red boxes to identify areas that require some type of user
action, such as to type text or click ‘Next’.

@! Active Directory Domain Services Installation Wizard

Directory Services Restore Mode Administrator Password

The Directary Services Restore Mode Administrator account iz different from the domain
Administrator account.

Agsign a pazeword for the Administrator account that will be uged when thiz domain
controller iz started in Directary Services Festare Maode. “We recommend that you
chaose a strong password.

Pazzword: LITTTTTIT)

Lonfirm passward: |"0"0"0|

Mare about Directory Services Restore Mode password

¢ Back Cancel |

COnfigure Prog rams Menu We strongly suggest that you perform the following procedure in the system
computers to group folders under ‘Programs’ on the taskbar. When complete,
o

you access Windows and software folders by clicking the Programs | symbol.

1. Click the Windows [ symbol.
2. Click Control Panel and choose Folder Options.

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019 9



Preface

The Folder Options dialog box appears.

General | View | Search

Folder views

You can apply this view (such as Details or lcons) to
all folders of this type.

Applyto Folders | | Reset Folders

Advanced settings:
. Files and Folders
[+ Aways show icons, never thumbnails
[] Mways show menus
[#] Display file icon on thumbnails
[+ Display file size information in folder tips
[] Display the full path in the title bar
. Hidden files and folders
[ biddor

3, folders, and dri

[#] Hide extensions for known fils types
[#] Hide folder merge conflicts A

] [ Coren ] [ o]

3. On the View Tab, select ‘Show hidden files, folders, and drives’
and click OK.

4. Right-click in the taskbar, click Toolbars, and choose New Toolbar.

Toolbars 3 Address
Cascade windows Links
Show windows stacked Desktop
Show windows side by side MNew toolbar...
Show the desktop
Task Manager
Lock the taskbar

[ ] L Properties

=

5. On the New Toolbar window, designate a path for your Programs folder.
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For example:
C:\ProgramData\Microsoft\Windows\StartMenu\Programs.

Organize *  MNew folder

“El Recent places

1M This PC
_H Desktop
_E Documents
j, Downloads
_ﬂ Music
_EI Pictures
_‘ Videos
i, Local Disk (C:)

~

w

MName

L Accessibility

| Administrative Tools

1 caeMm

| Embedded Lockdown Manager
|/ Hiprom Software

| Maintenance

|/ Microsoft Office

1. Microsoft 501 Server 2008

| Microsoft SQL Server 2008 R2

L Bearlaell Avdnenatinn

Date modified

8/22/2013 11:35 AM
8/12/2015 9:06 AM
8/12/2015 8:21 AM
11/22/2014 12:06 ...
8/12/2015 %:41 AM
8/22/2013 11:35 AM
8/14/2015 2211 PM
8/11/201511:16 PM
8/11/201511:16 PM

2/12/2018 .71 ARA

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder

Filz faldar

Folder: | Programs

6. Click Select Folder.

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019
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Preface

Additional Resources

12

These documents contain additional information that concern-related

products from Rockwell Automation.

Resource

Description

PlantPAx Distributed Control System Selection Guide,
publication PROCES-SG001

Provides basic definitions of system elements and
sizing guidelines for procuring a PlantPAx system.

PlantPAx Distributed Control System Reference Manual,
publication PROCES-RM001

Provides characterized recommendations for
implementing your PlantPAx system.

PlantPAx Distributed Control System Infrastructure
Configuration User Manual, publication PROCES-UM001

Provides procedures to configure infrastructure
components for your PlantPAx DCS systems.

PlantPAx Distributed Control System Verification and
Troubleshooting User Manual, publication PROCES-UM004

Describes how to verify that your system design aligns
with PlantPAx system recommendations.

Rockwell Automation Library of Process Objects Reference
Manual, publication PROCES-RM002

Provides information on how to use the Rockwell
Automation Library of Process Objects.

Rockwell Automation Library of Process Objects:
Logic Instructions Reference Manual,
publication PROCES-RM013

Describes controller codes and tags for Library objects.
The objects are grouped by family and attached as
Microsoft Excel files to the manual PDF file.

Rockwell Automation Library of Process Objects: Display
Elements Reference Manual, publication PROCES-RM014

Provides common display elements for the Rockwell
Automation Library. For improved accessibility, the
elements are combined into one manual.

PlantPAx Virtualization User Manual,
publication 9528-UM001

Describes the catalog numbers and details for
using virtual image templates to configure
virtual machines.

Application Code Manager User Manual,
publication LOGIX-UM003

Provides procedures for installing and creating
projects and configuring library objects.

Product Compatibility and Download Center at
http://www.rockwellautomation.com/rockwellautoma-

tion/support/pcdc.page

Website helps you find product-related downloads
including firmware, release notes, associate
software, drivers, tools, and utilities.

You can view or download publications at

http://www.rockwellautomation.com/global/literature-library/overview.page.

To order paper copies of technical documentation, contact your local
Allen-Bradley distributor or Rockwell Automation sales representative.

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019


http://literature.rockwellautomation.com/idc/groups/literature/documents/sg/proces-sg001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/proces-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/proces-um004_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm002_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm013_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm013_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/9528-um001_-en-p.pdf
http://www.rockwellautomation.com/rockwellautomation/support/pcdc.page
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/logix-um003_-en-p.pdf
http://www.rockwellautomation.com/literature/
http://www.rockwellautomation.com/global/literature-library/overview.page

Chapter 1

Build a PlantPAx Application

IMPORTANT  Before starting the procedures in this manual, the following prerequisites
are assumed to be completed:

«  System requirements are defined via Piping & Instrumentation
drawings (P&ID), Input/Output (I/0) lists, User Requirement and/or
Functional Requirement Specifications (URS/FRS), and so on.

- System s properly sized by using the PlantPAx System
Estimator (PSE) and in accordance with the PlantPAx Selection
Guide, publication PROCES-SG001.
« Infrastructure (equipment, media) is configured per instructions in the

PlantPAx DCS Infrastructure Configurations User Manual,
publication PROCES-UMO0O1.

The illustration shows the basic steps for building a PlantPAx” application.

Q Documentation
Selection Guide — FROCES-SG001
::> Fieference Wanual —FROCES-RAO0L
Infrastructure User Manual — PROCES-LIM001
(==

Collect system requirements Update and refine design requirements
[P 10, 0 It required spes) {Architecture, libraries, sequencing)

Use F3E to

@ g
. rem b

system design

PROCES-UROD1

Infrestructure User Manual — FROCES-UMDOL
4528 UNO01 | PlantP & Virtualization — 9525-UMD01
R Library of Process Obje ds — PROCES-RMO02

Build development system templates by using

Infrastructure and Virtualization User Manuals Download Pracess Library from PCDC

ACMUM — L0 GIX-UM002
Architect Logical model— PROCES-UROD2
ACMbulk entry — L0 GIN-LIMO0 2

Infrastructure Uk — FROCES-UROO1
Process Stmategies — PROCES-RMO012

PlantPdax
Corfiguration
Toal

e Build HWI project — PROCEZ-UIRODZ
Alamm EBuilder —PROCES-RNID2
! [ I Configure tag alarm values — FROCES-RKA002

Use PlantP&sx: Configuration Tool; configure 1/0 and controller-to-controller com munication

Test functionality and
perform PlantPAx checldist

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019 13
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Chapter1  Build a PlantPAx Application

You can use the Studio 5000° Architect application or the Studio 5000°
Application Code Manager (ACM) with a Logix controller. The two software
tools are different in form and function:

e Architect — A visual tool that helps you design a system with
drag-and-drop capability to show equipment on a canvas. Architect
contains the Rockwell Automation Library of Process Objects to allow
for quicker import of Library objects to start projects. We show
step-by-step procedures in this section for how to add process strategies
to controllers for control of process devices.

e ACM - A tool that lets you bulk engineer code from physical devices on
the P&ID to build controller, HMI, and Historian files. There is less
programming because you can identify (decorate) reusable tags for bulk
production. The Logical Organizer Designer plug-in creates HMI and
Historian tags. The Logical Organizer Manager builds an application to
create the library. Library objects can be configured to meet the needs of
multiple applications.

For more information, see the Application Code Manager User Manual,

publication LOGIX-UMO003.

We strongly recommend that you decide the software tool to use while you
compile the I/O list with the P&ID drawing.

IMPORTANT  The procedures in this chapter focus on the Architect application because its
graphical design helps you get started from scratch with the PlantPAx
Library. The interface also aids system maintenance. ACM users typically
have more experience creating bulk core projects.

Considerations Consider the following suggestions before starting this chapter:

e The Architect or ACM application must be installed on an
Engineering workstation.

o Check for the latest version of the Process Library in the
Product Compatibility and Download Center (PCDC) before

initiating projects.

IMPORTANT  You can access the PCDC from the Architect application. See page 19
for details.

e We recommend that you perform all I/O configuration inside the
Logix Designer application.

14 Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019
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Build a PlantPAx Application

Chapter 1

Figure 2 shows a list of the topics in this chapter. Click or see the page number

fOl‘ access to a section.

Figure 2 - Studio 5000 Architect Workflow

( Start )

v

Architect or ACM Option

page 16

v

Create an HMI Application

page 20

h 4

Organize Your Controller Folders

page 25

v

Build Process Strategies

page 32

r

Sync Controller to System

page 50

v

« Using ACM Bulk Tags
« Using the Architect Palette

« Commit a Project

« Controller Organizer
« Logical Organizer

« PS_Aln_Chan
« PS PID_Aln_Chan
« PS_PF755

See Chapter 2 Multi-controller Communication
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Chapter1  Build a PlantPAx Application

Architect or ACM Option

16

Whether you are a novice or experienced user, we suggest that you review the
Architect palette (see page 17) or the ACM quick steps (depending on which
is being used) before proceeding.

Using ACM Bulk Tags

As stated in the overview, ACM execution is a matter of registering, adding,
and configuring bulk Library objects. Projects can be completed without
requiring high-end programming support. In the project work flow, engineers
configure the object parameters to meet the requirements of the current
application. The project is then created to ACD controller code.

Control strategies contain pre-engineered code in the form of Add-On
Instructions. The HMI Library provides the faceplates for the Add-On
Instruction display elements.

The decorated ACD file and library objects are published directly to the ACM
database or to a file in HSL4 format. HSL4 files comprise a library of
application code with control strategies.

You can add non-Logix user interface features, such as HMI (FactoryTalk View
SE/ME software) and Historian (FactoryTalk Historian SE software)
components, to the Library object in the Library Object Manager application.
This can be done only after the Library object has been published from the
ACD file to a folder or ACM database repository.

ACM Quick Start

The following procedures are basic steps to register a Library and start a
project. For details, see the Application Code Manager User Manual,
publication LOGIX-UMO003.

Register a Library
To extract a self-contained library, complete these steps.
1. From the directory where the ACM download folder is stored,

right-click the .zip folder and choose Extract All.

2. Click Start Menu and choose Rockwell Automation>Application
Code Manager.

Right-click and choose Register.
4. Select all extracted library files and click Open.
5. Click Finish.

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019
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Build a PlantPAx Application ~ Chapter 1

Start a Project
To create a new project, complete these steps.

1. From the main menu, select File>New and choose Project.

2. From the Object Configuration Wizard, select Basic_Project (2,1) and
click Next.

Type a project name and click Finish.

4. To add a project to a controller, right-click Controllers in the left pane,
and choose Add New.

5. From the ControlLogix Library, select a controller and click Next.
6. Type a name for the controller.
7. Select controller parameters and click Finish.

For parameter descriptions and more information, see the ACM

User Manual, publication LOGIX-UMO003.

Using the Architect Palette

If you are using the Architect application, complete these steps to review
the palette.

X
1. To open the Studio 5000 Architect application, click the Programs
symbol and choose Rockwell Software®>Studio 5000°.

The Studio 5000 Common Launcher appears.

Rockwell Software’

Studio 5000 _

Create _Open
New Project Existing Project ~
From Import Sample Project

g From Sample Project From Upload
Recent Projects

2. Open a PlantPAx project.
Wait a few minutes while the ACD files and project data load.

Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019 17
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Chapter1  Build a PlantPAx Application

The Architect canvas appears with a wire diagram of the application
hardware for your project.

A Studio 5000 Architect - PlantPax
ELE EDIT WIEW SVYNC LIBRARY MANAGEMENT TOOLS WINDOW MELP
ARG AKDC- . AOO B S Coistble - D B RR

- Fregeetn
B Lot
B Laxcor
B Loxco 1
B Loxcos
B Looicos
1% PlontPax

# & Devices

£ Process Aren 4

PlantPAx

Disiriuted Contral System

F————— 1

PASSIZA [Senens Computer) =

4 B FactoryTake Line. PASSIOA
# s Bhertiet Bhemet
2 § 172181100, 1756-EN2T, LEMCOIENDIA
+ Bl 175644, LOXCOIRDD
B 0. 1756L7S LX)

3 5% = BB M

Component Project - Descripon

Dus¥ibuted Afchaecture - Singhe Process Senver

wE st
o Derven
Moton Contrl
Patwodk Ifrastructure
Pregramemabie Cortrol Symems

5 Roclowell
Automation

# Product Creddog

Computers 2

Distréeed L0 Maduies

Wisushzaton

4 Lbaes
Logix Batch Sequence Manager (vl 0:01) (F
Procass Libeary fod CH]) Read Only)

Table 2 - Studio 5000 Architect Palette Example

Name Graphic Example

Description

1 - Project Explorer

Project Bxplorer

.
4 Projects
4 [ Lexcot
< Controller Tags
Tasks
Motion Groups
Add-On Instructions
Data Types
/0 Configuration
LGXC02
LGXCO3
LGXCO4
LGXCO5
PlantPAx
E Area
4 & Alarm
2 PlantPAx_AE
4 % Data
“@ PlantPAx_DAT
> B PlantPAx_HMI

4 Devices

@ v

1Y
[}
i

[

* B Process Area

In the upper, left corner, the Project Explorer lists the Logix Designer and
FactoryTalk® View projects that comprise the Studio 5000 Architect
Application. IMPORTANT: When you are in the Project Explorer, you are using
the Architect application. You must open a project in the Explorer to access
the Studio 5000 Logix Designer application. To avoid confusion, the words
‘Architect’ and ‘Logix Designer’ are in the respective ribbon headers.

The system template that you select contains a number of controller and
FactoryTalk View projects. Typically, there are more projects (than shown in
the graphic example) that are contained in the Project Explorer as your
system develops over time.

There is one FactoryTalk View software project titled ‘PlantPAx. The three
projects that are contained in the template are View ME, View SE Distributed,
and View SE Station Local.

The Hardware Diagrams folder contains the components on the canvas that
represent your PlantPAx system. See number 4 for more information on
the canvas.
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Table 2 - Studio 5000 Architect Palette Example

Name Graphic Example Description
2 - Toolbox In the upper, right corner, you can view hardware (switches, controllers,
associated 1/0 modules, and so forth) in the project.
Tookox vAx There are two libraries that are listed as ‘Read Only'to denote they cannot be
e b modified or managed within Architect.
4 User-defined libraries are supported in Architect. You must download the
+ Computers Rockwell Automation® Library of Process Objects from the Product
* Distributed /0 Modules Compatibility and Download Center (PCDC). See 5 - PCDC.
> Drives
> Motion Control

* Network Infrastructure
> Programmable Control Systems
* Visualization
4 |ibraries
* Logix Batch Sequence Manager (v4.0-01) (Read Only)
* Process Library (v4.0-01) (Read Only)

3 - Communications

Communications - Process Area - 1 X
|F'ASSDZA (Generic Computer) j
4 B FactoryTalk Line, PASSO02A
4 Z& BtherNet, Bthemet
o f 17212.1.100, 1756-EN2T, LGXCOTENDTA
a [l 1756-A4, LGXCO1ROD
B 0. 1756-L75, LGXCO1

In the lower, left corner, the Communications pod shows the communication
path from the PASSO1 computer to the five controllers. These paths are
pre-defined shortcuts by using the Single Process Server template.

4 - (anvas

Distributed Architecture - Single Process Server

WSD1

In the middle section, the canvas shows a graphical representation of the
system elements that comprise the application. You can drag-and-drop
elements to modify a project.

The canvas also provides access to the Product Compatibility and Download
Center (PCDC). See 5 - PCDC table description.

5-PCDC

Rockwell
Automation

In the upper, right corner of the canvas,

click the Rockwell Automation logo. The Roclkuwvell
Library filter appears to let you -Automation
download the Process Library from the

Product Compatibility and Download

(PCDC) website.

The PCDC website provides access to the latest software and
hardware updates.
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Table 2 - Studio 5000 Architect Palette Example

Name Graphic Example Description
6 - Messages At the bottom of the canvas, the Messages area provides alerts, if any, for
Output the project.

Component Project - D il
i  Project update complete. No updates required.

Create an HMI App“cation To build your HMI objects and displays through drag-and-drop procedures in

an Architect project, complete these steps.

IMPORTANT  To customize a template, see the Rockwell Automation Library
of Process Objects: Configuration and Usage Reference Manual,
publication PROCES-RM002.

1. To add the basic frame for the template, drag the Libraries>
Process Library>Templates>FactoryTalk® View SE>P2f Template from
the Library Management pane and drop it into the PlantPAx
HMI folder.

A Studio 5000 Architect - PlantPAx
FILE EDIT VIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP

oMW XoaX2-C-_x A/OO E | ControlNetC -H D & .82 2R
Projectbxglorer - %% ProcessAess - x|
4 PlantPAx Fifter...

4 Projects

* Product Catalog

B Lexcot PlantPAX 4 Libraries
- B LGxco2 B Logix Batch S M (v3.5-09) (Read Only)
. B LGXC03 Distributed Control System ogi batch wequence Manager (vo. ead Unly
Logix Batch Sequence Manager (v4.0-00) (Read Only)

i LGXC04 Process Library (v3.5-09) (Read Only)
- B LGXC0s 4 Process Library (v4.0-00) (Read Only)
4 f8 PlantPAx * 01 - Comman
4 I Area * 02 - Process Objects
E Alarm * 03 - Premier Integration
E Data

* 04 - Diagnostic Objects
]
+ Ef PlantPAx_HMI © 05 - Built-In Instructions
Graphlos * 06 - PlantPAx MPC
Logic and Control © 07 - Date & Time Math

© 08 - 64-Bit Math
* 09 - Documentation

4 10 - Templates
| -
- Displays
* Global Objects
- Images

4 Devices
* & Process Area

LGXCO1 LGKC02

* Macros

2. Inthe Library Management pane, expand Libraries>Process
Library>Common folders.
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3. Expand the FactoryTalk View SE folder and drag-and-drop into the
PlantPAx HMI folder in the Project Explorer pane.

% Studio 5000 Architect - PlantPAx
FILE EDIT VIEW SYNC LIBRARYMANAGEMENT TOOLS WINDOW HELP
e XoaX92-C-_x A/ OO = ControlNetC - D & _ B &EER .

Project Explorer - 8 X | ProcossArea - x ™

O (FRAME) P2f Header_1M
01 (FRAME) P2f Header_4M
O (FRAME) P2f Template Al
O (FRAME) P2f Template Al
01 (FRAME) P2f Template Al
O (FRAME) P2f Template Al
O (FRAME) P2f Template Al
01 (FRAME) P2f Template Al

-
M1 /COARCY M Tamanlata M

4 PlantPAx - Filter...
4 Projects * Product Catalog
: g tgigg; P’antPAX 4 Libraries
. N Lexoos Distributed Controf System * Logix Batch Sequence Manager (v3.5-09) (Read Only)
* Logix Batch Sequence Manager (v4.0-00) (Read Only)
B LGXC04 * Process Library (v3.5-09) (Read Only)
» B LGXC05 4 Process Library (v4.0-00) (Read Only)
4 & PlantPAx 4 01 - Comman
< T& Area - FactoryTalk View ME
% sam .
g ata > Displays
« = PlantPAc_HMI -+ * Global Objects
4 Graphics * Images
4 Displays * Macros

* 02 - Process Objects

* 03 - Premier Integration
> 04 - Diagnostic Objects
* 05 - Built-In Instructions
* 06 - PlantPAx MPC

» 07 - Date & Time Math
» 08 - 64-Bit Math

* 08 - Documentation

LGXCOo1

LGXCO2

> 10 - Templates

A Studio 5000 Architect - PlantPAx

4. In the Process Object folder, select the Object folder that is used in the

application and drag-and-drop into the PlantPAx HMI folder.

FILE EDIT VIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP

e %A XD

x A s OO = ControlNetC ~EI D & .8 & 8 .

Project Explorer r X IToolex
PlantPAx - Filter...
4 Projects * Product Catalog
> E LGXCO1 |'IantPAX 4 Libraries
> LGXC02 .
B Loxom ributed Control System * Logix Batch Sequence Manager (v3.5-09) (Read Only)
* Logix Batch Sequence Manager (v4.0-00) (Read Only)
» B LGXC04 * Process Library (v3.5-09) (Read Only)
- B LGXC05 4 Process Library (v4.0-00) (Read Only)
4 §& PlantPAx * 01 - Common
4 & Area 4 02 - Process Objects
T Alarm * 01- Complete
+ & Data * Cross Functional
4 Ej PlantPAx_HMI 4 10 Processing
4 Graphics \ » Advanced Analog Input (P_AInAdv)
4 Displays » Analog Input Channel (P_AIChan)
O (FRAME) P2f Header_1Mon

)
[ (FRAME) P2f Header_4Mon
O (FRAME) P2f Template Alart
O (FRAME) P2f Template Alan
[ (FRAME) P2f Template Alan
O (FRAME) P2f Template Alart
O (FRAME) P2f Template Alan
[ (FRAME) P2f Template Alan .

M ICOAKICY NH Tamanlade Dice

»

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019

* Analog Output (P_AOut)

4 Basic Analog Input (P_Aln)

* Add-On Instructions

* FactoryTalk View ME

.
[ (RA-BAS) Pracess Analogln Family-Help
O (RA-BAS) P_Aln-Advanced
O (RA-BAS) P_Aln-Quick

» Discrete Input Object (P_DIn)

LGXCM

LGXCO02

5. Repeat step 4 for each object that you need.

6. Save your work.
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Commit a Project

The Commit option sends the data from an Architect project to the
FactoryTalk View project for the respective servers: HMI, data, and alarm.

Complete the following steps:

1. In the Project Explorer pane, right-click the application (PlantPAx in

the example) and choose Commit Project.

4 Studio 5000 Architect - PlantPAx
FILE EDIT VIEW SYNC LIBRARY MANAGEMENT T
he M XpdaX2-C-_x AsD0O
Project Explorer > 3 X

PlantPAx -

Projects

- B LGXCO01

- B LGXCD02

- B LGXC03

- B LGXC04

- B LGXC05

- BT

a A Open Project in Designer

B Add ’
- B Update Project Changes...
‘ 1| Commit Project Changes... I

Delete
Show Owner Mode

Properties...
O (FEAME] P2t Template Alarm |
M (FRAMFY P2f Temnlate Alarm |

2. Click Commit.
A Studio 5000 Architect Commit Summary -

The following changes will be committed to the associated project(s); any projects containing errors will be skipped.

4 §& View SE Distributed - PlantPAx -
@ APP PlantPAx will be committed.
0 AREA Area will be committed.
© Display (FRAME) P2f Header_1Mon is available It will be appended.
© Display (FRAME) P2f Header_4Mon is available. It will be appended.
Li ] Display (FRAME) P2f Template Alarm HButtonBar_1Mon is available. [t will be appended.
© Display (FRAME) P2f Template Alarm HButtonBar_4Mon is available. It will be appended.
© Display (FRAME) P2f Template Alarm-Explorer is available. It will be appended.
Li ] Display (FRAME) P2f Template Alarm-HistoryDisplay is available. It will be appended.
© Display (FRAME) P2f Template Alarm-ShelvedDisplay is available. It will be appended.
© Display (FRAME) P2f Template Alarm-Summary is available. It will be appended. -

Always show this dialog Help | | Commit | | Cancel
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3. Click Close.
A Studio 5000 Architect Commit Progress -
Committing project changes. This process could take some time depending on the size and number of projects.

v PlantPAx
+ Finished
0 Error(s). 0 Warning(s)

4. To confirm the commit action, in the Project Explorer pane, right-click
the application (PlantPAx in the example) and choose Open Project
in Designer.

4 Studio 5000 Architect - PlantPAx
FILE EDIT VIEW SYNC LIBRARY MANAGEMENT T(
Ha M XD aX2-C-_x As0OF:"
Project Explorer > 3 X
PlantPAx -
Projects
> B LGXCO1
» B LGXco2
» B LGXCO03
» B LGXC04
» B LGXCO05
B Pla
4 B Ar Open Project in Designer
> & Add »
] Update Project Changes...

a o Commit Project Changes...
‘ Delete

Show Owner Mode
Properties...

O (FRAME) P2f Template Alarm |
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The FactoryTalk® View Studio window appears.

5. In the Explorer pane, open the
PlantPAx>Area>PlantPAxHMI>Graphics>Displays folder.

|
File View Settings Tools Window Help
i DEE|lo o &cE

Explorer - PlantPAx_HMI =]

=15 Network (LOCALHOST) ~

I PlantPAx
& Runtime Security
-k Area

+[‘_E.- Alarm

+[‘_E.- Data

=18, PlantPAx_HMI

23 System

44 Command Line
3 HMI Tags
: L. Tags
—EI Graphics
- Displays
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME

P2f Header_TMon

P2f Header_4Mon

P2f Template Alarm HButtonBar_1Mon
P2f Template Alarm HButtonBar_4Mon
P2f Template Alarm-Explorer

P2f Template Alarm-HistoryDisplay
P2f Template Alarm-ShelvedDisplay
P2f Template Alarm-Summary

P2f Template Display

P2f Template Level2 HButtonBar

P2f Template Level3 HButtonBar

P2f Template Overview Display (4)

This folder typically contains the FRAME, P2f, and RA-BAS
display files.
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Organize Your Controller
Folders

IMPORTANT  Before setting up system folders, we recommend that you review the
controller guidelines in the PlantPAx Reference Manual,
publication PROCES-RM0O1.

This section shows how to configure your controller folders by using the
following tabs in the Logix Designer application:

e Controller Organizer — Lists the execution tasks and I/O
configuration

e Logical Organizer — Sorts in terms of procedures, objects, functions,
equipment, or some other natural term or concept for a ‘logical’ model
of your application

Controller Organizer

Complete these steps to organize your controller based on the execution rate of
your tasks.

1. In Studio 5000 Architect, right-click a controller and choose Open
Project in Designer.

# Studio 5000 Architect - PlantPAx
FILE EDIT VIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW  HELP
e W XolaX9-C-. x A/ OO F | ControlNet Cable ~|[=]
Project Explorer SRR Focessie |
4 FlantPAx
4 Projects

LGXCO" ‘ Dlaa tPAX
< Con Open Project in Designer

Task Browse [ags...
Mot Update Project Changes...
Addq Update Changes from Online Controller...
) E;tz Commit Project Changes...
- B Lexcoz Properties...
- B Lexcos
- B Lexcos
- B Lexcos | ‘
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Tasks
SeeTip

26

The execution tasks appear in the Controller Organizer tab.
Periodic tasks are executed at specific rates that are based on

apphcatlon requlrements

Controller Organizer

al s

4 Controller LGXCO1
¢ Controller Tags
Contreller Fault Handler
Power-Up Handler
4 Tasks
I 4 (© Task_A_50ms
B L Task_A_MainProgram
4 (T Task_B_100ms
P4 Task_B_MainProgram
4 () Task_C_250ms
b L Task_C_MainProgram
4 (D Task_D_500ms
P L Task_D_MainProgram
= 4 (B Task E_1s
B L Task_E_MainProgram
4 (D Task F 25
P L Task_F_MainProgram
4 (B Task_G_5s
B L Task_G_MainPragram
4 (D Task_H_10s
P L Task_H_MainProgram
l\"— 4 (B _Controller_Status
B L Diagnostics
Unscheduled
4 Motion Groups

Ungrouped Axes
B Assets
" Logical Model
4 1/0 Configuration

1= Controller Organizer E’gzchugmal Organizer

TIP  The controller template contains
nine predefined periodic tasks,
eight of these named Tasks
A...H.Thereis a separate
periodic task that is named
Controller Status, which is used
to collect system diagnostics.
For example, the L_CPU Add-On
Instruction monitors resources.

ﬂ Tasks \
b (E) Task_A_50ms

b (B Task_B_100ms
b (E) Task_C_250ms
b (E) Task_D_500ms
b () Task_E_1s
b () Task_F 25
b (B Task_G_5s

b () Task_H_10s
b (B _Controller_Status

Each task is set to execute at a defined time interval from
50 ms... 10, with faster tasks given higher priority.

See the Task Configuration guidelines in the PlantPAx Reference

Manual, publication PROCES-RM001.
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2. To create a program, right-click a task and choose Add>New Program.

Controller Organizer v I X

a o5

4 Controller LGXCO1
<7 Controller Tags
Controller Fault Handler
Power-Up Handler
4 Tasks
[ @ Task_4_50ms
[ @ Task_B_100ms
[ @ Task_C_250ms

rl Task_D_SOOms
b L Task D.Ma  Add

b O TaskEls cut Chri=X

P ew Equipment Sequence...
@Task_F_Zs &l copy T Mew Equipment Sequen

14 @Task_G_Ss Import Program...

b (@ Task_H_10s b S

b (B _Controller_Sta Paste Special
Unscheduled Delete Delete
4 Motion Groups

Import Equipment Phase...

Import Equipment Sequence...

Ungrouped At Cross Reference Ctrl+E
P Assets Print
Y. Logical Model
b 174 1/0 Configuration Properties Alt+Enter

The New Program dialog box appears.
3. Type a program name (Equipment01 is the example) and click OK.

New Program -

Name: |EquipmentD‘I | | oK |

Parent: |<none> v|
[ ]Use as folder
Schedule in: |® Task_D_b00ms v|

[ Jinhibit program

Synchronize redundancy data after execution

[ ]Open properties

4. To create a routine within a program, right-click the name of the
program that you created.

5. Click Add and choose New Routine.

b B Equipgaentd

4 @ Task E 1 Add » Mew Routine...
3
bTask] y Crl+X | {? New Local Tag... Crl+W
“®TaskF2 ol c Ctrl+C New P t
) Tl ew Parameter...
b L Task | Y
4 (D Task G- HEsitz G Import Routine...
b L Task_ Delete Delete ]
4 ]
@ Task_H_ Verity
b L Task_
4 ® Control Cross Reference Ctri+E
P L Diagr Browse Logic... Ctrl+L ~
Nesrrintinn Find in Loaical Oraanizer . ~
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A Jump to Subroutine (JSR) is going to be added to the program to
execute a command. JSRs are explained later in this section.

6. Type ‘MainRoutine’ for the routine name and click the Assignment
pull-down menu to select Main.

7. Click OK.

New Routine -
Name: IMainRoutine || I oK I

Description: || Cancel

Type: | Ladder Diagram v| | Help |
In Program | - |
or Phase: 4L Equipment01 v

Assignment Im Main vI

[ ]Open Routine

The New Routine has been added.

Logical Organizer

The Logical Organizer creates an organizational model of your system. This
model is a hierarchy of your system.

IMPORTANT  Due diligence is required in the layout of your logical organizer. A
properly organized system within the logical organizer helps to simplify
application development.

Several components of your PlantPAx system depend on the organization
and hierarchy of your Process system. These components consist of
the following:

« HMIlapplication
« Alarms
User roles and responsibility
« Security
We recommend that you see these additional references:

— (Chapter 6 of the PlantPAx DCS Infrastructure User Manual,
publication PROCES-UM001

— Chapters 3...4 of this application manual
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Complete these steps to build your logical model.

1. From the controller that is being configured, click the Logical
Organizer tab.

2. Right-click the controller and choose Add>New Folder.

Logical Organizer * I x

& °F

4 @ Logical M
» L Diagn New Program...
P L Equipm v Cirl+X New Equipment Phase...
P L Task A 3] Copy CirlsC Mew Equipment Sequence...
> b Task B 0] Paste Ctrl+V I ReniEoldas I
b L Task C| -~
b L Task D Paste Special » Import Program...
P L Task_E_MainProgram Import Equipment Phase...
P L Task_F_MainProgram Import Equipment Sequence...
b L Task_G_MainProgram _
B L Tack U Aainleames —~—

The New Program dialog box appears.
Mew Program -

Name:
D 1
Parent: <none: Y] |
Use as folder
Schedule in: none:
Inhibit program

Synchronize redundancy data after execution

["] Open properties

3. Type ‘System’ for the folder name and click OK.
The folder appears in the Logical Model list for the controller.

Logical Organizer v I X

g °s

4 Legical Model LGXC01

P L Lauipment0l

P L Diagnostics ﬁ

P4 Task_A_MainProgram :
P4 Task_B_MainProgram

P4 Task_C_MainProgram

P4 Task_D_MainProgram

P4 Task_E_MainProgram

P4 Task_F_MainProgram

P4 Task_G_MainProgram
P4 Task_H_MainProgram

[@EI Controller Organizer 7‘&,_ Logical Organizer
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4. Drag-and-drop the Diagnostics folder and all Task programs into the
‘System’ folder.

IMPORTANT A Diagnostics task is included in all controller templates to provide
for troubleshooting, reporting, and alarming of controller status
and resources.

5. Right-click the controller and choose Add>New Folder.

Logical Organizer + 1

a

4 @ Logical Mode g

b L Equipment New Program...

a System ¥ Cut Ctrl+X MNew Equipment Phase...
P L Diagnos Tam Ctrl+C New Eguipment Sequence...
PoL Task AN ) ~ New Folder...
Paste Ctrl+V
b 4 Task_B_N
b & Task C_N Paste Special » Import Program...
P L Task_D_MainProgram Import Equipment Phase...
b L Task F MainPranram Imnnrt Fnninment Sannenca

6. Type a folder name and click OK.

Mew Program -
Name: I Process01 I
w Help
Parent: <none: Y] |
Use as folder
<none

Inhibit program

Synchronize redundancy data after execution
["] Open properties

7. Right-click the Process01 folder and choose Add>New Folder.

Logical Organizer * I x

a

4 =l Logical Model LGXCO1
b L Equipment01

4 W Sys Add » Mew Program...
bLO ¥ cut Cirl+X MNew Equipment Phase...
b )
LT Ijj Copy Cirl+C New Equipment Sequence...
b Paste Cri+V I New Folder... I
b 4T ' -
b LT Paste Special » Mew Routine...
P 5T Delete Delete O MNew Local Tag... Ctrl+W
P
5T Verify MNew Parameter...
P LT
[ Cross Reference Ctrl+E . __
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8. Type a folder name and click OK.

[ Jinhibit program

Synchronize redundancy data after execution

[ ]Open properties

MName: IArea{ﬂ I I OK I
Description: ~
v Help
Parent: | Process01 W |
Use as folder
Schedule in: |<none> |

9. Drag-and-drop the folder (Equipment01) into the program (Area01)

folder.

Logical Organizer

4 =l Logical Model LGXCO01
b L Equipment01

4 7 Process0
5

4 [ System
b L Diagnostics
b 4 Task_A_MainProgram
b 4 Task_B_MainProgram
b 4 Task_C_MainProgram
b

L Tacl M hMainDramram

The controller folders are ready to Build Process Strategies on page 32.
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Build Process Strategies Procedures to add process strategies to controllers apply for Architect and
ACM processes. The strategies, which are labeled ‘PS_, contain pre-connected
Process Library objects for control of process devices. Strategies are imported
into your program to help reduce implementation time of your application.

IMPORTANT  To complete these procedures, you must have unzipped the process
strategies folder within the Process Library download. See the PCDC at:

https://compatibility.rockwellautomation.com/Pages/home.aspx

The procedures are written as if they are being performed online. However, if
you are offline, the procedures can be used because they are similar.

Figure 3 - Process Strategy Example Using the P_PIDE Object

Level 01
Input

Level 010 - Analog
P AlChan ) Input Level Control 010
T010_Chen  [Pan = P_PIDE =
Vel lnpRaw . [LT010 LICo1
- 1.0 00
o Inp_PV Out CV LICO10_Out TV
e Level Control 210 00
f 0.0 0.0
: LIC210_Val 8P 1~ -
0 Level Control 210 0.0
0 1 0 0
4 Cfg_LoLoLim S d B L LIC210_Sts_InitReq &
0 ¢ Leval Contral 210 1
0 s p
A LIC210_Sts WindugHi Y -
- 5 BypActive

Level Contral 210 2F3

LIC210_Sts_WindupLo

BOR =

LIC010_CVIOF ault_Bor IntkOK

1 outp 2412

In2 NBInIkOK
2H2

LIC010_Out_CV_ChanFault

The following procedures do not encompass all available process strategies.
The examples that are shown are a cross-section of the Rockwell Automation®
Library of Process Objects that comprise the process strategies.

Program parameters are used for I/O connection. The Add-On Instruction
tags are controller-scoped tags.
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PS_Aln_Chan

The PS_AIn_Chan strategy lets you monitor a basic analog object with

channel capability.

1. From the Studio Architect application, right-click a controller that is

being configured and select Open Project in Designer.

The Logix Designer application opens within the Architect tool.

2. Click the tab.

3. Right-click the program (Equipment01 is the example) and choose

Add>Import Routine.

4. Browse the path to the Process Strategies folder and select the
(RA-LIB)PS_AIn_Chan_x_x-xx ROUTINE.L5X.

& Import Routine

I MName
S

Recent places

Look i_nil | Process Strategies VI e o

Type
ogix Designer XM...

Size |~

RA- _AlnAdv_4 ME. ogix Designer XM 3
. I (RA-LIB)PS_AlnAdv_Chan_4_0-00_ROUTINE... Logix Designer XM... 4
Desktop 2 (RA-LIB)PS_AInDual_4_0-00_ROUTINE.LSX Logix Designer XM... k
. gl-l}(RA-LIB]PS_AlnDuaI_Chan_4_D-DD_ROUTINE.... Logix Designer XM... 4
—_;__.J 2 (RA-LIB)PS_AlnMulti_4_0-00_ROUTINE.L5X Logix Designer XM... £
LiE‘rar}es 2 (RA-LIB)PS_AQut_4_0-00_ROUTINE.LSX Logix Designer XM... g
I (RA-LIB)PS_AQut_nolinltk_4_0-00_ROUTIME.L... Logix Designer XM... :
L 2 (RA-LIB)PS_CC_4_0-00_ROUTINE.L5X Logix Designer XM...
5
. 23 (RA-LIB)PS_D4SD_4_0-00_ROUTINE.LSX Logix Designer XM... 3
This PC Tha oA 1 IDAAC P-4 0oAn RALITIRE L EY ' P - whA v
= < m >
“w o
File name: |[RA—LIB}PS_AIn_&an_d_I}-DD_ROUTINE.LSX v| l Open l
MNetwork —
Files of type: [ Logx Designer XML Fies (*L5X) v Cancel
Help

IMPORTANT  See page 32 for the path to the folder that you used to unzip the

process strategies folder.

5. Click Open.
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The Import Configuration dialog box appears.

K Import Configuration - (RA-LIB)PS_AIn_Chan_4_0-00_ROUTINE.L5X X
3 ] #a

Find Within: Final Name, Description

Import Content:

-l Programs
L. by Equipment01
LoD

< Tags

[RE]

101

L wo Data Types
03 Errors/Warnings®

Verify that the Final Name and

Add-0On Instructions

Configure Routine Properties

Import Name: XT101

Operation: |Create v | O

(i) References will be imported as
configured in the References folders

Final Name: | XT101 v
Description: TagDescript ~
Find / Replace -
Type: ]
¥ Find What: | XT101 v | Find Next |
In Program:

Number of Replace with: | 7101001 v Replace
Sheets:
[Juse wildcards Replace All

[ ] search current view only

Description boxes are checked.

34

Close
Direction: (Jup (@ Down
Find el
D ) > Final Name Description
DAIias For |:|Data Type DParameter

6. Click the Find/Replace button to find all tag references of XT101” and
replace with a user-designated tag name.

Our example is “TT01001".

IMPORTANT  In the Find Within section at the bottom of the dialog box, the Final
Name box defaults with a check mark only. The first time that you
use this dialog box, you must check the Description box. Thereafter,
the Description box defaults with a check mark.

7. Click Replace All

TIP  Click Close to exit Find/Replace only if you are done using the utility.
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8. Repeat step 6 and step 7 to find all tag references to “TagDescript’ and

replace with a description.

Our example is “Temperature 01001

K Import Configuration - (RA-LIB)PS_AIn_Chan_4_0-00_ROUTINE.L5X
& % Find: [xT101 v| Ll

Find Within: Final Name, Description

Import Content:

=/ Programs

‘. by Equipment01

~-§% Tro1001

References

< Tags

Add-0On Instructions
‘i Data Types

03 Errors/Warnings®

[RE]

Configure Routine Properties
Import Name: XT101
Operation: |Create v | [la]

(i) References will be imported as
configured in the References folders

Final Name: | TT01001 v
Description: TagDescript ~
Find / Replace -
Type: i
vee Find What: | T@gDescript v | Find Next |
In Program:
Number of Replace with: | Temperature 01001 v Replace
Sheets:
[ Juse wildcards Replace Al
[ ] search current view only
Direction: O
Find
|:| Import Name Final Name Description
DAIias For |:|Data Type DParameter

9. Click Close to exit Find/Replace.
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« 3

10. Click Tags to view all parameters that comprise the PS_AIn_Chan

Str ategy.

IMPORTANT

the issue.

If there are errors, a red ‘X’ with a message appears to describe

Import Configuration - (RA-LIB)PS_AIn_Chan_4_0-00_ROUTINE.L5X

Find: |TagDescript

J &s

Find Within: Final Name, Description

Import Content:

-l Programs

[RE]

Add-On Instructions
101

- in Data Types

03 Errors/Warnings®

Preserve existing tag values in offline project

Ready

11.

] Tag ces
Import Mame Operation |@2| Final Name ~| M| Usage

Bl XT101 Create O [TTO1001 =||Local

B| XT101_Chan Create [ [TTO1001_Chan =||Local
XT107_Inp_Raw Create O | TTO1007 _Inp_Raw ==/ Input
XT107_Inp_Raw_ChanFault |Create O | TTO1007 _Inp_Raw_... |=-/|Input
XT107_Inp_Raw_ModFault  |Create O | TTO1007 _Inp_Raw_... |=-/|Input

< m >
I 0K || Cancel | | Help

Click OK to import the routine.

IMPORTANT  You must be online to view the dialog box for the next procedure.
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12.  Select Import Logic Edits as Pending and click OK.
Online Options -

For all Program Logic Edit options, all new or modified Tags, Connections, Data
Types, or Add-On Instructions referenced by imported logic and all Task, Program,
and Routine properties will be downloaded to the controller immediately.

If overwriting tags, the imported values will be written to the offine project, but will
not be downloaded to the controller.

Program Logic Edits

Choose how program logic edits will be imported. The option that is selected here will also
be applied to any edits that already exist in "Area01.'

(®) Import Logic Edits as Pending
(O Accept Program Edits
O Finalize All Edits In Program

| Cancel | | Help |

If offline, the imported values are written to the project.

The control strategy (PS_AInChan in our example) appears in the
Logix Designer application.

qap ag/bheldnn0la aa aae b /B 0 0|~ e st o1 [psanc

P_AIChan ]
o TT01001_Chan . ZAL .
TT01001_Inp_Raw Inp_Raw Val_InpRaw [ " TT01001 00
Inp_ModFault Val P Inp_PV Val 00
Inp_ChanFault SrcQ 1 Inp_PVSrcQ Val_InpPV 0
Sts_PVGood 0 Cfg_HiHiLim Sts_Em
0 Sts_PVUncertain 0 Cfg_HiLim
TT01001_Inp_Raw_ModFault Sts_PVBad 0 Cfg_LoLim
Sts_Emr Cfg_LolLoLim
0
TT01001_Inp_Raw_ChanFault
Add JSR Instructions

The Jump to Subroutine (JSR) instruction directs the controller to jump to’
and execute a separate subroutine file within the ladder program, and return to
the instruction following the JSR instruction.

We use JSR instructions to schedule the routines that are added for execution.
A JSR instruction must be created for each routine.
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1. From the Logical Organizer in the Logix Designer application,
double-click MainRoutine.

Logical Organizer * I x

a

4 =l Logical Model LGXCO1
4 7 ProcessO
4 10 Arealn
4 L Equipment01
4 =l Logic and Tags
</ Parameters and Local Tags
B0 TTO1001
4 [ System
L Diagnostics
L Task_A_MainProgram
4 Task_B_MainProgram
4 Task_C_MainProgram

v v v v

A JSR instruction can be added in the following ways:

o From the Program Control tab, click JSR (as shown in the example).
(Click the left (<) and right (>) arrows to find the Program
Control tab.)

o Click the rung, type JSR’ and press Enter. Double-click the routine
name and select the created Process Strategy.

.18.25.240\Backplane\2= R & o JHP LBL J®R RET SER TMD MCR UID UIE SFR SFF BVENT EOT AFI MO b
. No Edits 2 Redundancy » Equipment Phase Equip IJuthO Subroutine Ion’Brea{k Special HMI T
Equipment01 - MainRoutine® \If“\soﬁtme MName ?
& Q& Rl GE el b -cd & Q| b A E;Lgrfgar i

2. Ifonline, click the Finalize All Edits in Program ~ “d| jcon.

- 5 [N

U Q| U G e 2| o | TR Q) Q| ] | G B [ e o

Temperature 01001
JSR
Routine Name R
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3. Click Yes.

Logix Designer -

Finalize all edits in program 'Equipment01'.

E Finalize all 'i', 'r', 'd', 'T and 'D' rung edit zones in all ladder
routines in this program.  Finalize all edits in pending and test edits
views of all other routines in this program.

The following routines contain edits:

@ MainRoutine
B0 1101001

The Finalize All Edits in Program operation will leave the following
outputs in their last state:

Outputs in 'r', 'd', 'R' and 'D' rung edit zones.
Ex Outputs in the Original View.
o Outputs in the Original View.

£ Outputs in the Original View.

« Indicates Sequential Function Chart routines that will be reset to
their initial steps along with their stored actions being reset.

This operation cannot be undone.

Finalize all edits in program?

I| Yes I | No | ‘ Help

4. Save the Logix Designer project.

PS_PID Aln_Chan

The PS_PID_AIn_Chan strategy provides loop control with an analog object
that has channel capability.

IMPORTANT  The procedures and screen facsimiles to create this instruction are similar to
PS_AIn_Chan. For your convenience, we include the screen facsimiles that
require specific information for this instruction.

1. Repeat steps 1 through 3 on page 33.

2. On the Import Routine dialog box, browse the path to the
Process Strategies folder and select
(RA-LIB)PS_PID_Aln_Chan_x x-xx.ROUTINE.L5X.

3. Click Open.
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The Import Configuration dialog box appears.

&£ L Find

Find Within: Final Name, Description

Import Content:

Programs
L Equipment0l

References

< Tags

v,
Y.
&

03 Errors/Warnings®

Add-0On Instructions
‘i Data Types

Final Name:

Description:

Type:

In Program:

Number of
Sheets:

Preserve existing tag values in offline project

Ready

40

Configure Routine Properties
Import Name:  XIC502
Operation: |Create v | [la]

(i) References will be imported as
configured in the References folders

Import Configuration - (RA-LIB)PS_PID_AIn_Chan_4_0-00_ROUTINE.L5X

| #a

TagDescript ~
Find / Replace -

Find What: |XI‘3502 | Find Next |
Replace With: | FIco1002 Replace
[ Juse wildcards Replace Al
[ ] search current view only
Direction: (Jup (@ Down
Fin

|:|Imp0r‘t Name Final Name Description

DAIias For |:|Data Type DParameter

| OK | | Cancel | | Help |

4. Click the Find/Replace button to find all tag references to XIC502’

and replace with a user-designated tag name.
p g g

Our example is ‘FIC01002"
5. Click Replace Al
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6. Repeat step 4 and step 5 to find all tag references to “TagDescript’ and
replace with a description.

Our example is ‘Flow Control 01002"

Find: |XIC502

Find Within: Final Name, Description

Import Content:

Programs

L Equipment01

...0% FICD1002

References

-7 Tags

& Add-On Instructions
‘i Data Types

03 Errors/Warnings®

0 A

Import Configuration - (RA-LIB)PS_PID_AIn_Chan_4_0-00_ROUTINE.L5X

[ a

[ x |

Preserve existing tag values in offline project

Ready

Configure Routine Properties
Import Name:  XIC502
Operation: |Create v | [la]
(i) References will be imported as
configured in the References folders
Final Name: FIC01002 v
Description: TagDescript ~
Find / Replace -
iDe Eind What: TagDescript v| | Find Mext |
In Program:
Number of Replace With: | Flow Control p1002 v | Replace
Sheets:
[ Juse wildcards Replace Al
[ ] search current view only
Direction: )
Find
|:| Import Name Final Name Description
DAIias For |:|Data Type DParameter
OK | | Cancel | | Help
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7. Click Find/Replace for all tag references to XT502” and replace with a
user-designated tag name.

Our example is ‘FT01002"

K Import Configuration - (RA-LIB)PS_PID_AIn_Chan_4_0-00_ROUTINE.L5X X

& L Find: |TagDescript v| a8 Find/Replace.

Find Within: Final Name, Description

Import Content:
=l Programs Configure Routine Properties
‘. by Equipment01

Import Name:  XIC502

FICD1002
Refe Operation: |Create v | O
Y. < Tags (i) References will be imported as
Ya Add-0n Instructions configured in the References folders
=2 B Data Types Final Name: FIC01002 v

03 Errors/Warnings®

Description: Flow Control 01002 ~
Find / Replace -
Sz Find what: || XT502 I BETS
In Program:
Humber of Replace With: | FT01002 v | Replace
Sheets:
[ Juse wildcards Replace Al
[ ] search current view only
Direction: (Jup (@ Down
Find
|:|Imp0r‘t Name Final Name Description
DAIias For |:|Data Type DParameter
[+] Preserve existing tag values in offline project oK | | Cancel | | Help

Ready

8. Click Replace All.
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K Import Configuration - (RA-LIB)PS_PID_AIn_Chan_4_0-00_ROUTINE.L5X

9. Repeat step 7 and step 8 to find all tag references to ‘DescAnaloglnp’
and replace with a description.

Our example is ‘Flow 01002°

& L Find: [XT502

Find Within: Final Name, Description

Import Content:

=/ Programs

‘. by Equipment01

2% FICO1002
References

< Tags

101

- o Data Types
03 Errors/Warnings®

0 A

Add-On Instructions

Final Name:

Description:

Type:

In Program:

Number of
Sheets:

Preserve existing tag values in offline project

Ready

J &s

Configure Routine Properties
Import Name:  XIC502
Operation: |Create

v|D

(i) References will be imported as
configured in the References folders

[ x |

Flow Control 01002 ~
Find / Replace -

Find What: |Desm”a'°91”F' v| | Find Next |
Replace With: | Flow 01002 v | Replace
[ Juse wildcards Replace Al
[ ] search current view only
Direction: (Jup (@ Down
Find

|:|Imp0r‘t Name Final Name Description

DAIias For |:|Data Type DParameter

| OK | | Cancel | | Help

10. Click Close to exit Find/Replace.
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11. Click Tags to view all parameters that comprise the P_PID_AIn_Chan
code object.

R Import Configuration - (RA-LIB)PS_PID_AIn_Chan_4_0-00_ROUTINE.L5X x|

& 5L Find: |DescAnaloginp v| &8 Find/Replace...

Find Within: Final Name, Description

Import Content:

Programs Configure Tag References
!j Equipmentol Alias For Data Type| Description ~
FIC01002
f P_PIDE (Flo
Y. *|FIC01002_CVIOFault... | -|Local FED_BO...
i -On Instructions *|FICD1002_Intlk =|[Local P_Intlk Flow Control 01002 - I...
= E— il
o m Dafa Types “|FIc01002_0ut_cv | --d|Qutput REAL  |Flow Control 01002~ .
03 Errors/Warnings =
*|FIC01002_0ut_CV_C... | -+/|Input BOOL Flow Contral 01002- ... | =
*|FIC01002_Out_CV_M...| -/|Input BOOL Flow Control 01002 - ...
v.*|FTo1002 -J|Local P_Aln Flow 01002 - Analog ...
¥."|FT01002_Chan -|Local P_AIChan |Flow 01002 Analogl..
*|FT01002_Inp_Raw =|Input REAL Flow 01002 - Process...
*|FT01002_Inp_Raw_C.. | --|Input BOOL Flow 01002 - Process... «
< 1] >

One or more tags in import content use a data type that already exists in project and is
different.

The existing data type will be used. Data values for the tag will be converted if possible
and some values may be lost. Check to ensure tag data converts as expected.

[+] Preserve existing tag values in offline project I oK I | Cancel | | Ely

Ready

12. Click OK to import the routine.

13. If online, select Import Logic Edits as Pending and click OK.

If offline, the imported values are written to the project.
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The control strategy (PS_PID_AIn_Chan) appears in the
Logix Designer application.

LN 1 Equipmentdl - FICO1002
; T e i i 2y (O e B0 0 - iGhem |1 v|el2z  [PS_FID_AnChan

B_AlChan
. FT01002_Chan P_PIDE o=
FTO1002_Inp_Raw — inp, FICO1002
FICO1002_Owt_CV
FTO1002_lip_Faw_ModFault
! E HypActin
FT01002_Inp Raw ChanFault J Sta Fx 253
IntikCK
242
BOR: = NEntlkOK
) FICO1002_CVIOFault Bor || 2.1z
FIC01002_Out_CV_ModFault : int Qukr

in2

FICO1002_Out_CV_ChanFauli

14. Complete the Add JSR Instructions as documented on page 37.
15.  Save the Logix Designer project.

PS_PF755

The PS_PF755 strategy provides a PowerFlex® drive interface.

IMPORTANT  The procedures and screen facsimiles to create this instruction
are similar to PS_AIn_Chan. For your convenience, we
include the screen facsimiles that require specific information
for this instruction.

1. Repeat steps 1 through 3 on page 33 and page 33.

2. On the Import Routine dialog box, browse the path to the
Process Strategies folder and select

(RA-LIB)PS_PF755_x_x-xx. ROUTINE.L5X.
3. Click Open.
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The Import Configuration dialog box appears.
4. Click the Find/Replace button to find all tag references to ‘MT310" and

replace with a user-designated tag name.

Our example is ‘MT01001"

m Import Configuration - (RA-LIB)PS_PF755_4 0-00_ROUTINE.L5X X

£5 J &s

Find Within: Final Name, Description

Import Content:
Programs Configure Routine Properties

L Equipment01 Import Name:  MT310
w05 MT310
References Operation: |Create v | o

=2 < Tags (i) References will be imported as
Ya Add-On Instructions configured in the References folders
=2 Final Name: MT310 v
. i *
£3 Errors/Warnings Description: TagDescript ~
Find / Replace -
Type: Find What: MT310 v| | Find Next |
In Program:
Number of Replace With: MT01001 hd | Replace
Sheets:

[Juse wildcards Replace All

[ ] search current view only

i

Close
Direction: (Jup (@ Down
Find el
|:|Imp0r‘t Name Final Name Description
DAIias For |:|Data Type DParameter
[+] Preserve existing tag values in offline project oK | | Cancel | | Help

Ready

5. Click Replace Al
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6. Repeat step 4 and step 5 to find all tag references to “TagDescript’ and
replace with a description.

Our example is ‘Motor 01001,

Import Configuration - (RA-LIB)PS_PF755_4 0-00_ROUTINE.L5X

« 3

Find: |MT310

J &s

Find Within: Final Name, Description

Import Content:

=/ Programs

‘. by Equipment01
§% MTO1001

References

< Tags

[RE]

03 Errors/Warnings®

Add-0On Instructions

Final Name:

Description:

Type:

In Program:

Number of
Sheets:

Preserve existing tag values in offline project

Ready

Configure Routine Properties
Import Name: MT310
Operation: |Create

v|D

(i) References will be imported as
configured in the References folders

[ x |

TagDescript ~
Find / Replace -

Eind What: |TagDescript v| | Find Mext |
Replace With: | Motor 01001 v | Replace
[ Juse wildcards
[ ] search current view only
Direction: C
Find

|:| Import Name Final Name Description

DAIias For |:|Data Type DParameter

OK | | Cancel | | Help
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7. Click Tags to view all parameters that comprise the PS_PF755 strategy.

TIP Ifthere are errors, a red X with a message appears to define
theissue.

H Import Configuration - (RA-LIB)PS_PF755_4_0-00_ROUTINE.L5X

& L Find: |TagDescript v| a8 Find/Replace...

Find Within: Final Name, Description

Import Content:

-l Programs Configure Tag References
~h g'fll'lﬂ:;n;l]]ll Import Mame Operation |@2| Final Name «| MUsage ~
References T8 MT30 Create O (MTO1001 =||Local
=zl fe 1Al MT310_FaultDest Create O [MT0O1001_FaultDest | --f|Local
;.3 Add-On Instructions * B MT310_FwdPerm Create |0 [MT01001_FwdPerm |--Local
5 erorsmingge 8| MT310_np Create |03 |MTO1001_inp w|local  _
* MT310_Inp_|OFault Create O (MT01001_Inp_lOFault | -||Input -
TR MT310 Intk Create O (MT01007_Intlk =||Local
18| MT310_Msg Create [ |(MT01001_Msg =||Local
TE| MT310_Out Create O (MTO1001_Out =||Local
B MT310_RevPerm Create O [MT01001_RevPerm | --f|Local
8| MT310_RunTime Create O (MTO1001_RunTime «=||Local w
| i >
[+] Preserve existing tag values in offline project oK | | Cancel | | Help

Complete - 9 occurrence(s) found, 9 occurrence(s) replaced

8. Click OK to import the routine.

9. If online, select Import Logic Edits as Pending and click OK.

If offline, the imported values are written to the project.
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The control strategy (PS_PF755) appears in the Logix

Designer application.

Pl

| ] ] |

aver| | b

heet [1 v|of4  [P_PF755

1

FwdPermOK
2-H2 FrarbBPermCK
RevPermOK 2-H2
3-H2 ReviDPermOK
IntlkOK 3H2
4-H2 NBint kK

4H2

MT01001_Inp_IOFautt

P_PF755

MT01001

Inp

Out
Ref_GetFaultMSG
Ref_GetFaultDest
Inp_FwdPermOK
Inp_FwdNBPermOK
Inp_RevPermOK
Inp_ReviNBPermOK
Inp_IntIkOK
Inp_NBIntlkOK
Inp_IOFault
Inp_Hand

Inp_Ovrd
Inp_OvrdCmd
Inp_Reset

L]

MT01001_Inp

MT01001_Out
MT01001_Msg [

MT01001_FaultDest
Val_SpeedRef
Val_SpeedFdbk
Wal_Fault
Sts_Stopped
Sts_StartingFwd
Sts_RunningFwd
Sts_StoppingFwd
Sts_JoggingFwd
Sts_ActualDir
Sts_Alarm
Sts_AtSpeed
Sts_SpeedLimited
Sts_Awailable
Sts_BypActive
Sts_Em
Sts_Hand
Sts_Maint
Sts_Owrd
Sts_Prog
Sts_Oper

0.0
0.0

0
1
0
]
0
0
0
0
0
0
0
0
0
0
0
0
0
1

Stoppped

=N P_RunTime |
MT01001_RunTime
Inp_Starting Val_Starts
Inp_Running Val_CurRunHrs
Val_MaxRunHrs
Val_TotRunHrs
BypActive
2-F33-F3
4-F3

10. Complete the Add JSR Instructions as documented on page 37.

11. Save the Logix Designer project.
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Sync Controller to System Complete these steps to synchronize the controller changes with the system

template inside the Studio Architect software.

1. From the Studio 5000 Architect application, right-click a controller that
is being configured and choose Update Project Changes.

# Studio 5000 Architect - PlantPAx
FILE EDIT VIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW  HELP
e X e X92-C-. x A/ OO FE o ControlNet Cable ~| b5

Project Bxplorer

SRR | Froceeo i

4 PlantPAx
4 Projects
MY il 1Gxco

Open Project in Designer tPAX
< Cont 1

Browse Tags... contral System

Mot Update Project Change

Tasl

Add pdate Lhanges from Unline Controller..,
Data Commit Project Changes...
g Properties...

- B Lexcoz

The Studio 5000 Architect Update Summary window appears.

The example shows the project that is expanded with the list of changes.

Studio 5000 Architect Update Summary -

4 ] 1756-L73 - LGXCO1

© controller 'LGXCO1' will be changed from '1756-L73' to '1756-L75'.
© controller 'LGXCO1' in 'LGXCO1R00" will be moved to position '2'
© Module 'EN2T" will be added to 'LGXCO1R00", slot 1.

© The AOI called 'L_CPU_24_Up' will be updated.

© The AOI called 'P_AIChan' will be added to Studio 5000 Architect.
© The AOI called 'P_Gate' will be added to Studio 5000 Architect.

© The AOI called 'P_Aln' will be added to Studio 5000 Architect.

© The AOI called 'P_CmdSrc' will be added to Studio 5000 Architect.
© The AOI called 'P_PF755' will be added to Studio 5000 Architect.

© The AOI called 'P_PIDE_only' will be added to Studio 5000 Architect.

© The AOI called 'P_PIDE' will be added to Studio 5000 Architect.

Always show this dialog

2. Click Update.

The following changes will be updated to the associated project(s); any projects containing errors will be skipped.

Help ||| Update I | Cancel

The Ethernet Configuration dialog box appears.

3. Leave the devices and their port configuration as is, and click OK.

A wait message appears while the project is being synchronized.
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To verify that the changes are synchronized with the system, complete

these steps.

1. From the Studio 5000 Architect application, right-click a controller

strategy and chose Open Routine.

% Studio 5000 Architect - PlantPAx

FILE EDIT VIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP

oM XX 9-C-

* A/, OO < ControlNetC ~[EH DS . 8B =2BE .

Project Explorer > 3 X
4 PlantPAx -
4 Projects
4 [ LGXCO01
<! Controller Tags
4 Tasks

- (® _Controller_Status
- (® Task_A_50ms
- (@ Task_B_100ms
> (O Task_C_250ms
4 (O Task_D_500ms
> 4 Task_D_MainProgram
4 L Equipment01
<! Parameters and Local Tags
B MainRoutine

Process Arca” [

PlantPAx

Distributed Control System

{5 FICO™a"n
on MTO Open Routine

fo TTO1001

(O Task E 1s

In the Logix Designer application, the program logic appears for the

selected process strategy.

B0 snimantr - covoce. [

‘q e BRR

i [

1]

N O] ol -~ sneat |1

v |nf 2 [PS_PID_AIn_Chan |

P_AlChan ]
- FT01002_Chan o -
FT01002_Inp_Raw = Inp_Raw Val_InpRaw :: :: FT01002 0o
Inp_ModFault Val [ 2' Inp_PV Val H I:‘
Inp_ChanFault SrcQ ] Inp_PVSrcQ Val_InpPV H I:‘
Sts_PVGood 0 Cfg_HiHiLim Val_PVEUMin 'm"] B
Sts_PVUncertain 0 Cfg_HiLim Val_PVEUMax 1
0 Sts_PVBad 1 Cfg_LoLim SrcQ 0
FT01002_Inp_Raw_ModFault Sts_Uselnp N Cfg_LoLoLim Sts_PVBad o
Sts_HoldLast I:‘ Sts_PVUncertain H
Sts_Clamped [ Sts_Er[?

Sts_Replaced
N Sts_MaintReqd
FT01002_Inp_Raw_ChanFault - Sts_Em

BOR =
i FIC01002_CVIOFault_B
[
FIC01002_Out_CV_ModFault & or

0
In1 Out [+
In2

FIC01002_Out_CV_ChanFault
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IntlkOK
2-H2
NBIntlkOK
2H2

P_PIDE [}
FIC01002
Inp_PV Qut_CV FIC01002_Out_CV
Inp_CascSP Val_PV
Inp_CVIOFault Val_SP
Inp_PVSrcQ Val_CVSet
Inp_IntlkOK Val_CVOut B
Inp_NBInt/kOK. Sts_Casc I:‘
Inp_Hand Sts_Auto 1
Cfg_PVEUMin Sts_Man N
Cfg PVEUMax  Sts_BypActive I:‘
Sts_Em |:\ BypActive
Sts_Hand |:\ 2F3
Sts_00S Iﬁ‘
Sts_Maint Iﬁ‘
Sts_Owrd Iﬁ‘
Sts_Ext Iﬁ‘
Sts_Prog 1
Sts_Oper
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2. From the Studio 5000 Architect toolbar, click Edit and choose Find.

# Studio 5000 Architect - PlantPAx
FILE EDIT VIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP
a2 2 Undo Update ACD: "LGXC01"  Ctrl+Z [ —|ControlNetC -E D0 & .2 8 2 .

- - -
Proje x| Process area” [N
so% [

S

£

New Hardware Diagram P’a"tPAX

X

E Distributed Conlrof System
K Add Graphic...

O Add File..

® Add Web Link..

| A Find Cri+F |

3. From the Find text box, type the tag name.
Our example shows TT01001.
s Find =3

Find:
I|Tru1ﬂm v |I

[] Match case
[] Whole word

| Hide Options

Controller Projects: Libraries: Look for:
[] Process Area:LGHCO1
[] Process Area:LGHC02

id
[] Process Area:LGHC03 Ol
[] Process Area:LGHC04 [] Programs

[] Process Area:LGHCO5 Routines
AQls
Instructions
Instruction Operands
Folders
LA ] [None | [ ] [None |
[[] Close on Search Complete | Close | | Help |

4. Click Start Search.
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fLE cun

VIEWW  DTNU  LIDISART IVIANAGEVIEN |

TUULD  WINLUYY

The tags for the selected routine display underneath the system model
on the Studio Architect software.

neue

Do XFaX2-C-_x A/ OO HE > ControlNetC -FID0 & . 222 .

Project Explorer

~ R x

4 PlantPAx
- Projects
« B LGXCO1
<7 Controller Tags
- Tasks
> (® _Controller_Status
» (@ Task_A_50ms
» @ Task_B_100ms
» @ Task_C_250ms
4 (@ Task_D_500ms
> L Task_D_MainProgram
< L Equipment01
< Parameters and Local Tags
B MainRoutine
#r FIC01002
8¢ MTO1001
> @ Task_E_1s
» @ Task_F_2s
» (@ Task_G_5s
> @ Task_H_10s
Unscheduled Programs

< B F

toryTalk Linx, PASS01
ierNet, Ethernet

Process Area*

Rockwell
Automation

PlantPAx

Distributed Conirol System

Distributed Architecture - Single Process Server

LGXC01

LGXC02 LGXC03 LGXC04 LGXCO05

58% ML EaR

Find "TT01001" complete 5 items found

Name Kind Type Container Location Description
TT01001 Tags P_Aln ‘Controller Tags  : Process Areal.  Temperature 01001

TTO1007_Chan Tags P_AIChan Controller Tags Process Arearl . Temperature 01001 - Channel Input

TT01007_Inp_R.. Tags REAL Equipment01 Ta_ Process Area’l.  Temperature 01001 - Process Variable Input
TTO1001_Inp_R Tags BOOL Equipment01 Ta.. Process Area’l.. Temperature 01007 - Process Variable Input Channel Fault
TTO1007_Inp_R_ Tags BOOL Equipment01 Ta. Process Area’l.. Temperature 01001 - Process Variable Input Module Fault

5. Save the Studio 5000 application.

The remaining chapters in this manual describe how to continue to build your

application by adding the following:
e Produce/Consume tags
e Alarms
e Historian points
e I/O modules
e Diagnostics

e Asset management tools
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Notes:
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Chapter 2

Considerations

Configure Controller-to-Controller
Communication

This chapter describes how to establish a communication pipeline between
controllers by creating produce/consume tags with a user-defined data

type (UDT).

A Logix5000™ controller lets you produce and consume system-shared tags. A
producer controller sends data to the system. The consumer controller is
configured to consume the produced tag. The data type of the consumed tag
must match the data type of the produced tag.

- |
L L1l
LGXCo1 LGXC02
Produced Tag LGXCO01 Consumed Tag LGXCO01
Consumed Tag LGXC02 Produced Tag LGXC02

For controllers to share produced or consumed tags, the controllers
must be attached to the same network, such as a ControlNet® or
EtherNet/IP™ network.

The consumed tags require connections. An increase in the number of
controllers that consume a produced tag reduces the number of connections
the controller has available for other operations. These operations include
communication and I/O.

Consider the following suggestions before starting this chapter:
e Producer/Consumer uses Class 1 communication (I/O) to enhance
data integrity and response time.

e The Producer/Consumer configuration is available only in offline
mode. During the initial system configuration, we recommend that you
create the communication between any system tags.

e Ifacontroller is not consuming produced tags, we recommend that you
inhibit the controller connection to save bandwidth.
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Figure 4 shows the topics that are described in this section. Click or see the
page number for quick access to a section.

Figure 4 - Controller-to-Controller Workflow

( Start )

\
Create Produce/Consume Data Type

See page 57

\d
Create Controller Network

See page 59

v
Create Produce/Consume Tags

See page 63

See Chapter 3 Configure Alarms
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Create Produce/Consume
Data Type

Use an Engineering Workstation
with these procedures.

EWS

Complete these steps to create a user-defined data type (UDT) that is shared
between two or more controllers. Remember, the data type of the consumed
tag must match the data type of the produced tag.

TIP  For more information on configuring produced and consumed tags, see the
Logix 5000 Controllers Produced and Consumed Tags
publication, 1756-PM011.

1. In the Controller Organizer of the Logix Designer application, click ‘+’
to expand the Data Types folder for the producer controller.

Controller Organizer v I X

a o5

4 Controller LGXCO1
<7 Controller Tags
Controller Fault Handler
Power-Up Handler

P Tasks
P Motion Groups
4 Assets

P Add-On Instructions

[ Mew Data Type...

b Mew String Type...

b

[ Cut Ctrl+X

[ Copy Ctrl+C
Tre Paste Ctri+V

Y. Logical Maodel
2. Right-click Data Types and choose New Data Type.
The New UDT dialog box appears.

Name: PC_UDT Data Type Size: 77 Properties ~ 1

Extended Properties...

Description: 4 General

Data Type Sizi

Aembers: Description
MName Data Type Description MName PC_UDT
* b Status CONMNECTION_STATUS i
* Dint DINT[25]
* Real REAL[25]
Add Member.

W

| ok [ Cancel | [ Apply | [ Help |

3. To add members to your new data type, do the following:
a. Typeaname.
Our example is PC_UDT.
b. Click Add Member and type a name and data type.
c. Repeat step b for each new member of the UDT.
d. Click OK.
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58

IMPORTANT  The Consumer controller must use the Connection Status for the
source quality of the information. If there is a loss of
communication, the Connection Status reports the fault.

4. Save your work.

5. From the Studio 5000 Architect” application, right-click the producer

controller and choose Update Project Changes.

In the Architect project, the UDT that you created appears in the

User-Defined list for the controller.

Project Bxplorer

- 1 X

4 Projects
4 [ Lexcot
< Controller Tags
Tasks
Motion Groups
Add-On Instructions
4 Data Types
4 b User-Defined
B L_CPU_CommUse
oo L_CPU_Connlse
oo L_CPU_CPUUse
oo |_CPU_ldentity
oo L_CPU_Memlse
oo L_CPU_Out
o P_Desclist
oo P_PF755_Inp
== Ohut

—— [

[] RING_
101

oo STRING_16

101

oo STRING_20

101

oo STRING_40

101

o STRING_8
i STRING_MavTag
4 0 Configuration
' Controller Tags
Tasks

Motion Groups

Add-On Instructions
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Create Controller Network

The UDT is now in the User-Defined list for the consumer controller.

Project Explorer - 1 X
4 PlantPAx -
4 Projects
- B Lexcot
4 [ Lexcoz
< Controller Tags
Tasks

Motion Groups
Add-On Instructions
4 Data Types
4 b User-Defined
B L_CPU_CommUse
oo L_CPU_Connlse
oo L_CPU_CPUUse
oo |_CPU_ldentity
oo L_CPU_Memlse
oo L_CPU_Out

H STRING_16

o STRING_20
H STRING_40
4 /0 Configuration
[ [0] 1756-L75 LGXCO2
- B Lexcoz

This section describes how to add controllers and place the Producer controller
definition into the Consumer controller. This action creates a network
communication path.

IMPORTANT  To modify controller properties and add local communication adapters,
see the PlantPAx® Distributed Control System Infrastructure Configuration
User Manual, publication PROCES-UMO001.

Complete these steps.

1. On the Architect canvas, click and drag the adapter of the Producer
controller and drop into the Consumer controller.
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Chapter 2

Configure Controller-to-Controller Communication

For our example, LGXCO02 is the Producer controller and LGXCO01 is
the Consumer.

P’a"tPAX Distributed Architecture - Single Process Server Rockwell

& Automation
Distributed Controf Systam

Adapter

LGXCO5

2. Use the defaults and click OK.

i Configure Module -
Type: 1756-EN2T 1756 10/100 Mbps Ethernet Bridge, Twisted-...
Vendor: Rockwell Automation/Allen-Bradley

Parent: LGXCOTENOTA

Name: LGXCO2ENDT

Description:

1756 10/100 Mbps Ethernet Bridge, Twisted-Pair Media

Slot:

Electronic Keying: | Compatible Module |'|

Address / Host Name

() Private Network: 192.168.1.
O [ fatih=s 17218 1 105
) Host Name:

If necessary, you can change the IP address and then click OK.
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3. On the Architect canvas, click and drag the controller for the Producer
controller and drop into the Consumer controller.

Rockwell

Distributed Architecture - Single Process Server

PlantPAx

Distributed Controf Systam

-

y

Controller

LGXCOZ

Automation

LGXCO3

LGXCO4

4. Use the defaults and click OK.

7 Configure Module -
Type: [1756175 v
Vendor: Roclkwell Automation/Allen-Bradley
Parent: LGXCOZEND1
Name: [LGxcoz
Description: Template Application with only task layout pre-nstalled |~

W
Slot: ==
Revision: 3 1 &

LGXCO5

5. Repeatstep 1 through step 4 but with LGXCO01 as the Producer
controller and LGXCO02 as the Consumer.
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The respective controllers are now linked and can communicate.

Project Explorer - 1 X
. -
4 Projects
4 [ Lexcot
< Controller Tags
Tasks

Motion Groups
Add-On Instructions
Data Types
4 /0 Configuration
[ (0] 1756-L75 LGXCO1
4 f] [1] 1756-EN2T LGXCO1ENDTA
4 f] [1] 1756-EN2T LGXCOZEND1
i [0] 1756-L75 LGXC02
i [2] 1756-EN2T LGXCO1END1B
i [4] 1756-EN2TR LGXCO1ENO2
4 [ Lexcoz
< Controller Tags
Tasks
Motion Groups
Add-On Instructions
Data Types
4 /0 Configuration
[ [0] 1756-L75 LGXCO2
4 f] [1] 1756-EN2T LGXCOZEND1
4 f] [1] 1756-EN2T LGXCO1ENDTA
i [0] 1756-L75 LGXCO1
B Lexcoz
B Lexcos
B Lexcos

6. Save your work.
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Create Produce/Consume Complete these steps to attach produce/consume tags to a UDT for an
Ta gs application controller.

1. Inthe Architect menu bar, click View and choose
Produce/Consume Tags.

IMPORTANT  Step 1applies if you do not have Produce/Consume tabs on the
bottom of the Architect application. Otherwise, click an existing
Produce/Consume tab.

# Studio 5000 Architect - PlantPAx
FILE EDIT VIEW SYNC LIBRARY MAMNAGEMENT TOOLS WINDOW  HELP

*3 2 W | ¢ Refresh F5 A ~ O O F < ControlNet Cable ~|[E] [
Project Explon ¥ Standard Toolbar m
4 m v Project Explorer -

4 F +  Communication PlantPAX
“ b Disgram Ovenview Distributed Control System

v Toolbox

¥ Output

I PLc:duce_-"Ccnsurr‘eTags I
1/0 Aliases

2. In the Produce/Consume Tags window, click Add.

Process Area™ = xi

P’antPAX Distributed Architecture - Single Process Server Au'l‘nooll'c.l;ﬂ:::

Distributed Controf System Py s

]
.
LGXCO5

| 585 - A - -
Produce/Consume Tags - Frocess Area Produce/Consume Tags - Process Area

Ci Controller C Tag DataT) -
. N tar: R | o Consumer Coniroller Consumer Tag | Data Type - Producer Controller Producer Tag RPl{ms] Class

*

Produce/Consume Tags - Process Area SERERIERS

m
=]
=
i)
i
il

Produce/Consume Tags - Process Area [0S

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019 63



Chapter 2

Configure Controller-to-Controller Communication

64

The Consumer Tag dialog box appears.
3. Select ‘LGXCO01I’ in the Controller text box.

7 Consumer Tag -
Controller:  fI| LGXCO1 v
Tag Name: [[[LGXC02 | [=]
Description:

Type: Consumed
Alias For:
Data Type: PC_UDT v
Exermal Access: | Read/Wiite v |
Amay Dimensions
Dim 2: Dim 1: Dim 0:
0 = [0 = [0 z
Information

Producer tag must be defined.

4. Type ‘LGXC02’ as the tag name.
5. Select PC_UDT from the Data Type pull-down menu.

The message ‘Producer tag must be defined” appears.

6. Click Connection.
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The Producer Tag dialog box appears.

Make sure that the Producer controller is listed.

7 Producer Tag -

Controller: | LGxCO2 v |
Tag Name:  [LGXCO2 | [=]
Description:

Type: Produced T
Alias For:

Data Type: PC_UDT

Extemal Access: | Read/Write v

Amay Dimensions
Dim 2: Dim 1: Dim 0:

0 =1 [n =1 3
U vl Y Y »

RPI: [500.0 5| ms Allow Unicast Consumer Connections

Information
Produced tag "LGXC02:LGXC02" of data type "PC_UDT" will be
created.

7. Set an RPI value and click OK.

Use the highest permissible RPI for your application. Follow the
standard rule, which is, the RPI must be two times faster than the
execution.
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The Consumer Tag dialog box reappears.

Observe in the Information box that you are creating a consumed tag
with the same UDT as a produced tag with your selected RPL

7 Consumer Tag -

Controller:  [LGXCDT

v]

Tag Mame: |LGXCDZ | l:l
Description:

Type: Consumed
Alias For:

Data Type: | PC_UDT v |

Exemal Access: | Read Wiite

Amay Dimensions
Dim 2: Dim 1: Dim 0:
0 = [0 = [0 z
Use Unicast Connection over BtherMet/IP
Information

Consumed tag "LGXC01:LGXC02" of data type "PC_UDT" with
produced tag "LGXC02:LGXC02" and RPI "500.0" will be created.

N

8. Click OK.

9. Repeat step 1 through step 7 with ‘LGXCO02’ as the Producer controller
and ‘LGXCO01’ as the Consumer.

The created tags appear in the Produce/Consume Tags window.

Produce/Consume Tags - Process Area

C Controller C Tag DataType -  Prod Controller Producer Tag RPI(ms) Class
PC_UDT  LGXCO2 : i
LGXCO2 LGXCO1 PC_UDT LGXCO1 LGXCO1 500.0
*
| Add | | Edit | | Remove |

Produce/Consume Tags - Process Area JUUNRCELE
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IMPORTANT  Make sure that the Logix Designer application is closed before you
Commit a project.

10. Right-click in each controller and choose Commit Project Changes.

# Studio 5000 Architect - PlantPAx
FILE EDIT VIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW  HELP
e Xoa X9k A/ OO f o ControlNetCable ~[[=] [

Project Bxplorer ~ B X § Process frea _

4 PlantPAx

g PlantPAx
4 c :
: G Open Project in Designer ributed Control System
B Lo Browse Tags...
- B g Update Project Changes...
B U i
-8 Al Commit Project Changes...

“ Devic Properties...
" B Provoss o I
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Notes:
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Chapter 3

PlantPAx

Configure Alarms

This chapter describes how to configure your process alarms in the
PlantPAx" system.

IMPORTANT  Forinformation on the HMI template referenced in this chapter, see the
Rockwell Automation Library of Process Objects: Configuration and Usage
Reference Manual, publication PROCES-RM002.

Alarms are a critical function of a distributed control system. Effective alarm
systems direct the attention of an operator to improve the productivity, safety,
and environment of a process plant. The PlantPAx system follows industry
standards that govern alarm management.

This chapter does not cover the engineering practices that are required to fully
apply alarm management standards. However, we describe the procedure that
is required to implement alarms on the PlantPAx system. The steps make sure
of system performance and alignment with the functionality expectations of
the industry standards.

In addition, this chapter includes how to configure visualization components,
including an alarm summary, alarm log viewer, and alarm banner (shown in the
graphic). When a controller detects an alarm condition, the server publishes
the information to a subscribing Operator workstation via FactoryTalk® Alarm
and Event Services.

ﬁ:ﬂ % @ >< = El e Process01

Distributed Conirof System
YOS ==280F DL [NoFiten v|RDED
¥ | L | Event Time Alam Name Mezszage
A 6/5/2018 4.33.54 PM TT01001_Alm_Le Temperature TT03001 Low Alam; Val= 0.0;

& a 6/5/2018 4:33:54 PM TTO3001_Am_Lo Temperature TT03001 Low Alarm; Val= 0.0;

IMPORTANT Install the Alarm Builder Tool to simplify alarm tag creation. Each alarm
object that comprises the Library of Process Objects must be enabled for the
tool to create the alarm.
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Figure 5 contains the topics that are described in this chapter. Click or see the

page number for quick access to a section.

Figure 5 - Alarm Workflow

[ Start }

r
Configure the Alarm Builder Tool by using the
procedures in the Rockwell Automation® Library of
Process Objects, publication PROCES-RM002

Configure an Alarm Group

See page 71

v
Configure an Alarm Banner

« Alarm Banner
« Alarm Sounds
See page 75

) 4
View an Alarm Summary

See page 80

r
Configure an Alarm Log Viewer

See page 83

v

View Alarm System Configuration

See page 86

r
See Knowledgebase Answer ID 466418 at
https://rockwellautomation.custhelp.com/ for more
information on Alarm roll-up and filtering.

Configure Historian

See Chapter 4
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Consider the following suggestions before starting this chapter:

Considerations
o Tag-based alarms are recommended to generate alarms in the PlantPAx
system. Device-based alarms can be used, but we recommend that you
limit their use to enhance system performance.

e Perform any alarm configurations in Chapter 8 of the PlantPAx
Distributed Control System Infrastructure Configuration
User Manual, publication PROCES-UMO001.

e Before you configure alarms, organize and group your alarms based on
your system. The alarms are organized by Level 1 through Level 3 as
shown in the example.

e For more HMI template information, see the Rockwell Automation
Library of Process Objects: Configuration and Usage Reference
Manual, publication PROCES-RMO002.

= Alarm and Event Setup - RNA//$Global/PlantPAx/Area/Alarm/PlantPA

IR 1[E1[)

All Alarms | Messages | Tag Update Rates |

| ‘ Type |all v

ALL Alarms

MName Type Input Tag A

Level 1

—

Ungrouped Alarms

-

Process01 Group

System Group

Group Gt
Group Gt

-*-

Processol

Level 2 ’ =l Areall
‘—’ Equipmentd1
Equipment02
- Areal2
Equipment03

Equipment04

Level 3

+ . System
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COnfigure anAlarm Group This section describes how to configure a group of alarms for a specific process

area. Complete these steps for each group of alarms for each process area.
p p group p

The following example shows a controller that has two areas.
e Area0l contains Equipment01 and 02.
e Area02 contains Equipment03 and 04.

ﬁ Logix Designer - LGXCO1 [1756-L75 31.11] - 0O x
Y FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP

= RUN ~ g - ¥
= oK I T@%I QE_I:—I'H]P-1\172.18.25.240\Eackp|ane\2* * = B 4 Ik A4 A
= st - e
L om Ur:;rgy o Offfine f. Mo Forces b No Edits 2 Redundancy E: Favorites' Add-On Safety
Logical Organizer + 1 X
a o=

4 @ Logical Model LGXCO1

4 7 ProcessO
4 10 Arealn
4 L Equipment01
4 =l Logic and Tags
<! Parameters and Local Tags
B MainRoutine
da FICO1002
do MTO1001
do TTO1001
4 4L Equipment02
4 =l Logic and Tags
<! Parameters and Local Tags
B MainRoutine
fo FIC02002
do MT02001
do TTO2001
4 10 Areal2
4 L Equipment03
4 =l Logic and Tags
<! Parameters and Local Tags
B MainRoutine
do FICO3002
do MT03001
&0 TTO3001
4 L Equipment04
4 =l Logic and Tags
<! Parameters and Local Tags | %] 0 Errors || ! 0 Warnings || (i } 0 Messages
B MainRoutine
do FIC04002
fo MT04001
do TTO4001

b 1 System

5 controller Organizer i3 Logical Organizer

@Search Results Watch

Ready Communication Software: RSLinx Classic =
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1. Use Alarm Builder to import your alarms as documented in the
Rockwell Automation® Library of Process Objects Reference Manual,
publication PROCES-RM002.

IMPORTANT  When using Alarm Builder, it is expected that the Process Tree is
created. To create the group organization, you must create the
display association.

We recommend that you create an entire system organization by
attaching multiple controllers, different programs, routines, and so
forth. These items can be part of one group to be the foundation of
the alarm grouping.

-3 System
—B Process01
=169 Area01
. 283 Equipment01

+/8 Logix Code
; 63 Tags
=169 Area02

=149 Equipment03
. @8 Logix Code
63 Tags
=149 Equipment04
/& Logix Code
63 Tags

| Controllers & HMII§ Process Treel

2. In the FactoryTalk View Studio software, open
PlantPAx>Area>Alarm>PlantPAx_AE>Alarm and Event Setup.

Explorer - PlantPAx_HMI

= @ Network (LOCALHOST)
- PlantPAx
@ Runtime Security
-ICH Area
—[‘_E.- Alarm
I PlantPAx AE
Ik Data
S PlantPAX_HMI
—EI System
I “.441 Command Line
223 HMI Tags
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The Alarm and Event Setup window appears.
E Alarm and Event Setup - RNA://$Global/PlantPAx/Area/Alarm/PlantPAx_AE HE

O] e % [a]

All Alarms |Messages | Tag Update Rates |
| | Type |l v
ALL Alarms Name - Type Input Tag Ack Req'd Alarm
Ungrouped Alarms FIC01002_Alm_Fail Digital [Area/Data::[LGXCO1]FICO1... true false
= PlantPAx_AE FIC01002_Alm_HiDev Digital /Area/Data::[LGXCO1]FICOL... true false
= Process01 FIC01002_Alm_HiHiDev  Digital [Area/Data::[LGXCO1]FICOL...  true false
=] oy Areall FIC01002_Alm_IntlkTrip  Digital /Area/Data::[LGXCOLIFICOL...  true false
JEETEED FICD1002_Alm_LoDev  Digital JArea/Data::[LGXCO1IFICOL...  true false
Equipment02 FIC01002_Alm_LoloDev  Digital /Area/Data::[LGXCOLIFICOL...  true false
) Areal2 FT01002_Alm_Fail Digital JArea/Data::[LGXCOLIFTO10...  true false
EEE:EEZ:EEE FT01002_Alm_Hi Digital [Area/Data::[LGXCO1]FTO10... true false
- System FT01002_Alm_HiHi Digital [Area/Data::[LGXCO1]FTO10... true false
) FT01002_Alm_Lo Digital [Area/Data::[LGXCO1]FTO10... true false
FT01002_Alm_LolLo Digital [Area/Data::[LGXCO1]FTO10... true false
FT01002_Chan_Alm_Fail  Digital [Area/Data::[LGXCO1]FTO10... true false
TT01001_Alm_Fail Digital [Area/Data::[LGXCO1]TTO10... true false
TTO1001_Alm_Hi Digital [Area/Data::[LGXCO1]TTO10... true false
TTO1001_Alm_HiHi Digital [Area/Data::[LGXCO1]TTO10... true false
TTO01001_Alm_Lo Digital [Area/Data::[LGXCO1]TTO10... true false
TT01001_Alm_Lolo Digital [Area/Data::[LGXCO1]TTO10... true false
TT01001_Chan_Alm_Fail  Digital [Area/Data::[LGXCO1]TTO10... true false
< m H

Alarms - 18 items | Default max shekve time: 480 Minutes

By following the Alarm Builder procedure, it is expected that the Alarm
and Events Grouping is similar to the Process Tree organization.

3. To add more groups, right-click on your project (PlantPAx in the
example) and choose Add Group.

Or, if you like, you can drag-and-drop groups and alarms.

4., Click the Save H icon.
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Config ure an Alarm and This section how to configure the visual and audible components of an
Event Banner alarm state.

For more information on how to customize an HMI template, see the
Rockwell Automation Library of Process Objects: Configuration and Usage
Reference Manual, publication PROCES-RMO002.

Alarm Banner

Complete the following steps to configure an alarm banner that provides a
visual representation of the alarm status.

1. In FactoryTalk View Studio, open the display name based on
the following:

o Single monitor — The name of the display is
(FRAME) P2f Header_1Mon

¢ Four-monitor — The name of the display is
(FRAME) P2f Template Alarm HButtonBar_4Mon

PlantPAx_AE
&l Alarm and Event Setup
## Data
=3 PlantPAx_HMI

=13 System

#4 Command Line

153 HMI Tags

f & Tags (FRAME) P2f Header_1Mon - /PlalntPAx//Area (Displ_ay)

153 Graphics Alarm and Event Banner Design View
I Displays D LED

(FRAME) P2f Header_1Maon

(FRAME) P2f Header_4Mon
(FRAME) P2f Template Alarm HButtonBar_1Mon

(FRAME) P2f Template Alarm HButtonBar_4Mon ; FRAME) P2f Template Alarm HButtonBar 4Mon - /PlantPAx//Area (Displa:
(FRAME) P2f Template Alarm-Explorer Alarm and Event Banner Design View
(FRAME) P2f Template Alarm-HistaryDisplay 1

(FRAME) P2f Template Alarm-ShelvedDisplay
(FRAME) P2f Template Alarm-Summary
(FRAME) P2f Template Display

(FRAME) P2f Template Level2 HButtonBar
(FRAME) P2f Template Level3 HButtonBar

[ R ~

2. To access the Alarm and Event Banner Properties dialog box,
double-click in the icon bar.
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3. In the Event Subscriptions tab, click Browse (ellipsis ...).

|Genem|lCqumns Status Bar EVe”tSUbSCfipﬁ0”S|States|Sort |Common|

Event subscriptions: Subscribe to events where:

Priority [v]Urgent [v]High [v] Mediurm [v] Low

Scopes:

(Any Scope)

Add Browse... Femowve

——

Remuove Ewent sources (wildcards are supported):

Rename {4y evvant sourca)

The Select Scope window appears.

4. Click Process01 and click OK.

=3 PlantPAx
E@ Area

EI@ Alarm

cep

[0 Equipment03
{1 Equipment04
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5. To use the scope defaults on the Alarm and Event Banner Properties

dialog box, click OK.

|Genem|lCqumns|StamsBal| EVe”tSUbSCfipﬁ0”S|States|Sort |Common|

Ewvent subscriptions: Subscribe to events where:
Default . .
Priority V] Urgent [+ High ] Medium [v]Low
Scopes:

Areafalarm:PlantFAx_AE:Processil

Add Browse... | | Femowve

Remuove Ewent sources (wildcards are supported):

Rename {4y evvant sourca)

Browse... || Add... | | Edit... | | Femowve

I oK I | Cancel | | Apply | | Help |

Once configured, the alarm banner appears as shown in the example.
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Alarm Sounds

Complete the following steps to configure sounds that provide an audible alert
for an alarm.

1. Repeat step 1 and step 2 on page 75.
2. Click the States tab.

3. Check the desired sound actions in the Sound column and click

Configure Sounds.
Alarm and Event Banner Properties
| Genemll Columns I Status Bar | Event Subscripti |::| States |Common |
Select a state to view and set itz properties.
Show event type Priority | Text Background | Blink Sound
I3 ‘. In Alarm Unacknowledged | Urgent . .
High B [ |
weour | Wl | (] E
o [l | W O
‘/ In Alarm Acknowledged Urgent . l:‘ D D ixing Tank1 almost empty
High B O O O ’ﬁ'mgTuM level low
Medium . l:‘ O O ixing Tank1 valve 1 close time exc|
Low . . O O
4 Mormal Unacknowledged | Urgent . l:‘ O Mixing Tank1 almost empty
High [ | ] [0 Widng Tank1 level low
Medium . l:‘ O T e 1 close time ex
Low . l:‘ D Mixing Tank1 level less than 0. Sen
I| Configure Sounds |I Elink Fate |Medium V| | Test Rates
[ ok ][ cancel || oply Help

The Alarm Sound Configurator dialog box appears.

IMPORTANT  We recommend that you change the default beep to different
sounds according to the alarm priority. The default beep is the
sound that your local computer generates.

4. For each alarm priority, select a sound file from the pull-down list.
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5. When you are finished selecting sound files, click OK.

Sounds | Status Tags

Urgent | Default Beep

High | Default Beep

Medium | Default Beep

Low | Default Beep

ssp e st

Your configured Alarm Sound Configurator dialog box looks similar to

the following figure.

Sounds | Status Tags

—_—

Urgent [J| Highest_A.wav W

High | High_A.wav W |

Medium | Medium_A.wav W |

tow flonpnee ]
Beep Rate seconds

If necessary, it is possible to send sound information to the controller to

create a control for a physical horn that can be configured in the

Status Tags tab.

Status Tags

Urgent |

Heh |

Medium |

Low |
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View an Alarm Summary

80

Complete these steps to view alarms in Summary mode.

For more HMI template information, see the Rockwell Automation
Library of Process Objects: Configuration and Usage Reference Manual,
publication PROCES-RMO002.

1. In the FactoryTalk View Studio software tree, open
PlantPAx>Area>PlantPAx_HMI> Graphics>Displays>(FRAME) P2f
Template Alarm-Summary.

Explorer - PlantPAx_HMI B
| E1#® PlantPAX_AE ~

..j8] Alarm and Event Setup

Ik Data

S PlantPAX_HMI

23 System

734 Command Line

3 HMI Tags

: L. Tags

—EI Graphics

& Displays

-[E] (FRAME) P2f Header_1Mon

-[E] (FRAME) P2f Header_4Mon

-5 (FRAME) P2f Template Alarm HButtonBar_1Mon

-5 (FRAME) P2f Template Alarm HButtonBar_4Mon
)
)

-[5 (FRAME P2f Template Alarm-Explorer

-[E (FRAME) P2f Template Alarm-HistoryDisplay
-5 (FRAME) P2f Template Alarm-ShelvedDisplay
-[E)] (FRAME) P2f Template Alarm-Summary|

-[5] (FRAME) P2f Template Display

[E (FRAMEY DY Tamnlata | aual? HRittAnRar

2. Double-click in the summary object.
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The Alarm and Event Summary Properties dialog box appears.

Ewent subscriptions:

| Appealancel Columns | Toolbar | Status Bal| EventSubscriptions| Display Filtelsl Sort | Statesl Behaviml Common|

Subscribe to events where:

Default
Priority [v]Urgent [v]High [v] Mediurm [v] Low
Scopes:
Areafalarm:PlantFAx_AE:Processil
Add I Browse... I | Femowve
Ewent sources (wildcards are supported):
[Any event source)
Browse... || Add... | | Edit... | | Femowve
| oK | | Cancel | | Apply | | Help |

3. In the Event Subscription tab, click Browse (ellipsis “...”) under the

Scope text box.

The Select Scope dialog box appears.
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4. Select Process01 and click OK.

=3 PlantPAx
Ea Area
Ela Alarm
E? PlantPAx A
EI Process01
: Areal
{3 Equipment01

Ea Area02

CI Equipment03
.10 Equipment04
[0 System

- Data

I oK I Cancel

The Alarm Summary dialog box appears.

m’gﬂ!ﬂf& &_ﬁx = E E\L'I\rr;?\:;:;msmmort Process01

YOI ==8TEH @G NoFien v KODEQ

! | & | Event Time | Mlam Name | Message
6/5/2018 4:33:54 PM TT01001_Am_Lo Temperature TT03001 Low Alam; Val= 0.0;
I A ML 6/5/2018 43354 PM TT03001_Am_Lo Temperature TT03001 Low Alam; Val= 0.0;
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Configure an Alarm Log
Viewer

You can view and print alarm history databases from the Alarm and Event log.

Complete these steps.

IMPORTANT  For more HMI template information, see the Rockwell Automation

Library of Process Objects: Configuration and Usage Reference Manual,

publication PROCES-RM002.

1. In the FactoryTalk View Studio software tree, open

PlantPAx>Area>PlantPAx_HMI>Graphics>Displays>

(FRAME) P2f Template Alarm-HistoryDisplay.

—EI Graphics
& Displays
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME
-[3 (FRAME

P2f Header_TMon
P2f Header_4Mon
P2f Template Alarm HButtonBar_1Mon
P2f Template Alarm HButtonBar_4Mon

AN Alarm-rEnio
(FRAME) P2f Template Alarm-HistoryDisplay
RAME] PZT Template Alarm-

-5 (FRAME) P2f Template Alarm-Summary

[ /CDARADY D Tamamlata Dicmlar

The Alarm and Event Log Viewer Properties dialog box appears.

2. Double-click in the (FRAME) P2f Template Alarm-HistoryDisplay

object.

The Alarm and Event Log Viewer Properties dialog box appears.

3. On the Display Filters tab, click Add and type the name of the filter

(Process01 in the example).
4. Select a group and click Add Where Condition.
The Filter Wizard dialog box appears.

5. Select a "Where <Group>' from the pull-down list (Contains in the

example).

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019

83


https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm002_-en-p.pdf

Chapter3  Configure Alarms
6. Click Browse ("... ellipse) and select a group name (Process01 in
the example).
= (FRAME) P2f Template Alarm-HistoryDisplay - /PlantPAx//Area (Display)
[F VT w0OE =
! | 9| Event Tme | Alam Name | Condiion Name | Message |
Alarm and Event Log Viewer Properties X
General| Columns | Toolbar| Display Filters | States | Commen |
Initial display filter Field names:
‘(ND Fiter] v ‘ Alarm Class ~
Al S 9 2
P e Filter Wizard -
Display filters: Computer
Condition Mame whi @
Rocessl] Condition Quality =2 TR
Currentalue ‘Cumams V‘
Ewvent Category
Event Source |Pmcessl]1| ‘ l:l
Event Time
I OK |I ‘ Cancel |
Message
ST?I:‘P:M-,.- e Add Where Caondition
Display events where
Remove
Add todify..
Remove AND OR
Fename { y NOT
Limit number of records returned to:
No message select]
| OK | | Cancel ‘ | Apply | | Help ‘

84

7. On the Application window, click the Program pull-down arrow.

PlantPAx

@) ] | Current User:
ﬁ >< = EI EWS4S\ADMINISTRATOR Process01
Distributed Conirol System [
Process0l v | T G 0 & E
.NO F”ter' Time | Alarm MName | Condition Mame | Message
oce

8. Select a program (ProcessO1 in the example) to view the alarm log.

You can also configure global objects to filter and announce alarms by
alarm group. The objects are in the Rockwell Automation Library of
Process objects.

9. To filter by alarm group, complete these steps.
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a. From the Alarm Objects in the Library global objects folder,
drag-and-drop the Alarm object onto the Navigation screen.

Equip01

L evel 2 Alarm Group Annunciation - Use this object with ar
an in a level 2 alarm sub-group that is represented b
the navigati on.

Value Description
Area/Alarm:PlantPAx_AE FTAE Server Path:Server Name (Ex. FTAE Area:F
Process01 Alarm Group Name (Level 1)

Areall Alarm SubGroup Name (Level 2 #101 FTAE Server Path-Server Name (Ex. FTAE_Area:FTAE Svror 7
Equipment01 Alarm SubSubGroupName (Level 3) #102 Alarm Group Name
#103 Alarm Sub Group Name

For example:

#101 FTAE_Area:FTAE_Svr (or :FTAE_Svr if the server is in the root),
#102 Process

#103 Unit

Level 1 Alarm Group Annunciation/Mavigation - Use this ¢
any alarm in the level 2 alarm sub-group that is represent

#101 FTAE Server Path:Server Name (Ex. FTAE_Area:FTAE_Swvror
#102 Alarm Group Mame (Level 1)
#103 Alarm Sub Group Name (Level 2)

0K | | Cancel

om onm

b. Right-click the global object and choose Global Object
Parameter Values.

The Global Object Parameter Values dialog box appears.
For the #101 parameter, type the Alarm server name.

c
d. For the #102 parameter, type the Level 1 Alarm group name.

o

For the #103 parameter, type the Level 2 Alarm group name

™

If necessary for the #104 parameter, type the Level 3 Alarm
group name

g. Click OK.
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View Alarm System
Configuration

The System folder includes the L_CPU instruction and the L_ModuleSts
alarming. Complete these steps to view the alarm system.

1. In the Application tree, open the Area program and choose

Alarm>PlantPAx_AE.
2. Double-click Alarm and Event Setup.

Alarm and Event Setup - RNA://$Global/PlantPAx/Area/Alarm/PlantPAsx_AE

==/

B I

All Alarms ] Messages] TagUpdate Rates }

| | Tvee a v

ALL Alarms Name v Type Input Tag Ack Req'd AlarmasaTag  Group Alarm Class
ungrouped Alanms LGXCOIEMND1_Module_Sts_IOFault Digital JArea/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
= FlantPas_AE LGXCO1END2FFO1_Module_Sts_IOFault Digital JArea/Data:: [LGXCO1]Program:Dia... true false Diagnostics L_Module...
5 Prucessd)l LGXCOIENO2MTO1001_Module_Sts_IOFault Digital [Area/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
5 areacl LGXCOI1EMD2MTO1002_Module_Sts_IOFault Digital JArea/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module. ..
Equipnentd1 LGXCO1EN02MTO1003_Module_Sts_IOFault Digital Jarea/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
Cquipmentaz LGXCO1END2MTO1004_Module_Sts_IOFault Digital Jarea Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
- Areat2 LGXCO1END2PAD1_Module_Sts_IOFault Digital [Area/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
Equipment3 LGXCOIEND2ZRO1AI01 Module_Sts_IOFault Digital JArea/Data:: [LGXCO1]Program:Dia... true false Diagnostics L_Module...
Equipmentae LGXCOIENO2RO1A001_Module_Sts_IOFault Digital [Area/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
LGXCO1EMD2RO1_Module_Sts_IOFault Digital JArea/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module,..
= System LGXCO1ENO2RO2DI01_Module_Sts_IOFault Digital Jarea/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
| MR LGXCO1END2RO2DINZ_Module_Sts_IOFault  Digital JAreaData::[LGXCO Program:Dia...  true false Diagnostics L_Module. .
LGXCO1ENDZR02DI03_Module_Sts_IOFault  Digital [Area/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
LGXCO1END2RO2D001 Module_Sts_IOFault Digital JArea/Data:: [LGXCO1]Program:Dia... true false Diagnostics L_Module...
LGXCOIENO2RO2D002_Module_Sts_IOFault Digital [Area/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
LGXCO1EMD2R02_Module_Sts_IOFault Digital JArea/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module,..
LGXCO1END2_Module_Sts_IOFault Digital Jarea/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
LGXCOZEND 1_Module_Sts_TOFault Digital Jarea Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
LGXC02_Module_Sts_IOFault Digital [Area/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
SW001 Module_Sts_IOFault Digital JArea/Data:: [LGXCO1]Program:Dia... true false Diagnostics L_Module...
SW002_Module_Sts_IOFault Digital [Area/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
SW003_Module_Sts_[OFault Digital JArea/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module,..
SW004_Module_Sts_[OFault Digital Jarea/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
SW005_Module_Sts_TOFault Digital Jarea Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
SW006_Module_Sts_IOFault Digital [Area/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
SW007_Module_Sts_IOFault Digital JArea/Data:: [LGXCO1]Program:Dia... true false Diagnostics L_Module...
SW008_Module_Sts_IOFault Digital [Area/Data::[LGXCO1]Program:Dia... true false Diagnostics L_Module...
< m >

Alaims - 27 items Defaul max shelve time: 430 Minutes

86

3. Click Diagnostics to view information that has been automatically

generated.

If you are using L_StsModule, the Alarm Builder Tool, by default,
creates and populates a system alarm summary.
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Configure Historian Data Collection

Possessing the right information at the right time is critical for decision
making. FactoryTalk® Historian software captures data for reports to help
maximize plant-floor objectives and productivity. The software uses historical
points (tags) in the system to produce analytical data.

Analytical data includes process variables, trends, estimations, and
statistical reporting.

IMPORTANT  This chapter includes procedures for how to manually create Historian tags,
digital states, and Asset Framework. We recommend using the PlantPAx®
Configuration Tool (see page 122) for creating bulk tags for large
process systems.

Considerations: Consider the following suggestions before starting this chapter:

e Perform any necessary configurations that are contained in the
PlantPAx Distributed Control System Infrastructure Configuration
User Manual, publication PROCES-UMO001.

o The procedures in this chapter use the ‘System Management Tool” and
PI System Explorer within FactoryTalk Historian software. The tool is
available for Historian Asset Framework management computers, such
as server, node interface, and EWS.

e Microsoft” Excel” software is required to enable the bulk editing
capability. An additional license is required to use PI Datalink.
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Figure 6 contains the topics that are described in this chapter. Click or see the

page number for quick access to a section.

Figure 6 - FactoryTalk Historian SE Workflow

( Start )

r
Create Historian Points

See page 89

r
(reate Digital States

See page 97

h 4
Import Digital States

See page 99

v
Define Historical Points

See page 102

¥
Pl Builder Bulk Editing

+ Using the Template
See page 105

h 4
Import Asset Framework Templates

See page 109

r
Configure Asset Framework Elements

See page 113

r
Search Event Frames

« Finding Faults for Analysis
«  Event Frames Reports (Pl Builder)

See page 115
r
PlantPAx Configuration Tool « (Configure Asset Framework Server
« (reate Historian Tags by Using PlantPAx Configuration Tool
See page 122 « Verify Asset Framework Library and Elements
h A
See Chapter 5 Configure /0 Modules
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Create Historian Points

Use an Engineering Workstation
or a Historian server with these
procedures.

EWS01 or ASIHOTA

Complete these steps to create historian points by using the FactoryTalk®
Administration Console.

1. Click Rockwell Automation® software and choose FactoryTalk
Administration Console.

2. Select the network for the type of FactoryTalk directory.

3. In the Explorer pane, right-click an application (PlantPAx is our
example) and choose Add Individual Historian Points.
4

File View Tools Window Help

Explorer .
=5 Network (PASSD1)

= CEF Area Delete

+L_EF Alg Mew Area...
47k Da
+ % Pla Add New Server r
_D System Discover Historian Points... |
D Actio Add Individual Historian Points...
+D Polic Backup...
#{1 Comg
+-§5 Metw Resource Editor...
+D Users Security...
+[Z1 Conn

Properties...

4. On the Add Historian Points dialog box, click Browse Tags.

Add points ta server: Froduction Historian

Using data collection interface: FTLD1

Default scan rate: |§[‘I]‘I zecond v|

Tag attributes for new points: Default Configuration

PlantPd: v

From application:

Tags to add:

Add Histarian Points -

Tag Mame FTH Server Interface Scan Clazz  Config File From Application
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S. In the Tag Browser window, select an object tag (TT01001 in the
example) in the Folders pane on the left side of the window.

Select Tag(z)
Foiders Cantents of “#rea/Data:LGXCOT /Onine/TTOT001"
=) PFDC_FaultCod: ~ Access Rights Description  ~
%23 Program:Areal] &
4 (23 Program:Diagne al_raul ReadOnly
-1 Program:Task & | @ vl Hibilim  ReadOnly
#00 Program:Task B || & vy Hilim  ReadOnly
w20 Program:Task_C & Val_Inppv ReadOnly
-0 ProgramTask || &y olim  ReadOnly
#-0 ProgramTaskE | o\ ol olim  ReadOnly
0 ProgamTask P f 5\ \toge  ReadOnly
y (21 Program:Task_C & Val_Notify ReadOnly
+-_] Program:Task_H -
03 SMC50_FautCo || € VelLOwner  ReadOnly
L SMCEex Eauc. | € VALPVEUMax  ReadOnly
d _ & Val PVEUMin  ReadOnly
T Than | | € ValPVMaiC.. ReadOnly I
v | & ValPYMinC... ReadOnly v
e Bl B -- B
Tagfiter: | v| [ AddTagljtolit |
Selected tag]
ivea/Diata[LGHCONTT 01001 Val ~
Home area: / [ Remave | | Clear |
==

6. In the pane on the right side of the Tag Browser window, double-click
the tag to configure as a Historian Point.

Val (Process Variable Value) is the example.
7. Click Add Tags to List and click OK.
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The Add Historian Points dialog box reappears with a list of
selected tags.

Add Historian Points -
Add points ta server: Production Historian
Using data collection interface: FTLD1
Default scan rate: |[‘I]‘I second V|
Tag attributes for new points: Diefault Configuration
From application: | FlantPéx A |

Tags to add:
Tag Mame FTH Server Interface Scan Clazz  Config File From Application
frea/Data:[LGECOTTO... Production His...  FTLD1 [111 seco...  Default Configuration  PlantPas
< m >

o

8. Click OK.

FactoryTalk Historian uses System Management Tools (SMT™) to create
and maintain historical points. You must have the proper historian
server connection.

9. Choose Rockwell Software®>FactoryTalk Historian SE>
System Management Tools.

10. In the Servers Pane (or the Servers and Collectives pane if you have a
collective), select the Historian server.
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11. In the System Management Tools pane, select Point Builder.

File View Tools Help

Collectives and Servers ¢HI@I|§ 2 | @ 0 points
Seardh T

= £ Server Point  Point Source  Point Type  Point Class = Descriptor

Collective: ASIHO1
[+ asih01a  Primary
[] ASIHO1B  Secondary

General |.Archive I Classic I Security I System |

Seardh

b Alams Name: | | | Rerzme | PiServer: [asihta v

b Batch Descriptor: | |
I» Data

I Interfaces Point class: |dassic v| Paint source:

I IT Points . L

b Operation Foint type: Digital set: V|

4 Points Eng Units: | | Display digits:
Digital States
Performance Equations Exdesc: | |
.
Paint Classes Source tag: | |
Point Source Table
Totalizers

I+ Securty

SYSTEM\Administrator | piadmin B

12. Click the Search @ button.
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13. In the Tag Search window, type the Tag Mask and click Search.
The tag appears on the Tag Search window.
14.  Select the tag and click OK.

Basic Search | Advanced Search I Alias Searchl

Pl Server: Poirt Type: Point Class:

[AsHorashota EiE ][

T: Paint Source: Engineering Units:
*=Wild Card -

| List Count: 1

The point name and entire path appear on the Point Builder window.

To opt for a shorter point name, continue with the next step; otherwise,

go to step 17.
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15.  Select the tagand click Rename.

File View Tools Help

Collectives and Servers FH & A | @ 1 point
Seardh 0

Server  Point Poirt Source  Point Type  Point Class ~ Descriptor ~ Point Security
Collective: ASIHO1 ash0la PlantPAx Area Data-PlantPAx_DAT:LGXCO1.TT01001.Val  FTLD Foatd?  classic piadmin: Afrw
[+ asih01a  Primary

[] ASIHO1B  Secondary

System M;
Seardh

I» Alarms
I> Batch <] m

I» Data
b Intedfaces General |.Archive I Classic I Security I System |

b IT Points Name: [PlantPAx Area.Data:PlantPAx_DAT:LGXCO1.TT01001.Val || Rename I Pl Server: |ashlla v

I» Operation
4 Points Descriptor: | |

Digital States . X .
: : _Fl'LD
Performance Equations Point class: |C|assm: | Point source: _

Paint Classes

Poirt Source Table Eng Units: | | Display digits:

To.talizers Exdesc: |
I+ Securty

|
Source tag: | |

SYSTEM\Administrator | piadmin B

16. In the Rename PI Point window, type a new name and click OK.

Current name: |PlantPAx Area Data:PlantPAx_DAT:LG)

MNew name: I [TT01001.Val I

[ ok ][ Canesl |

17.  In the General tab of the Point Builder dialog box, type a tag description
and engineering units.

General I.M:hive I Classic I Security I System |

Name: TTO1001.Val | [Rename | PiServer: [asih0ta v

Descriptor: | Temperature 01001 |

Point class: | classic | Point source:
Poirt type: Digital set: | |

ES ] | Display digits:
Exdesc: | |
Source tag: | |
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18. Click the Archive tab to configure the range (Zero and Span), typical
value, and all exception and compression data for the historical point.

IMPORTANT  Usually, Minimum Range Value = Zero, Span = Maximum Range
Value minus Minimum Range Value. The Typical Value is between
the Minimum Range Value and the Maximum Range Value.

Genemll Archive I Classic I Security I System |
Typical Value:r 85|I Zen:u:|| -2DD| Span: ﬁ

Scan Archiving Step Shutdown Compressing
® 0n ® 0n 2 on ® 0n ® 0n
Oof Oof ®off Oof Oof
Exception Deviation Compression Deviation

025] [Eng. Units v

| D.5| |Eng. Units W

Day Hr Min Sec Day Hr  Min

Min. Time: mmm Min. Time: mm
Mex Tme: [0 o] 10] 0] MexTme:[ 0] e[ 0|

w
@
3]

19. Click the Classic tab to view the historical tag path (instrument tag) that
includes the Data server name.

Our example has the FactoryTalk Linx name, PlantPAx_DAT.
The historical point link is broken if any change is made to the
FactoryTalk Linx application name.

| General I Archive || Classic § Security I System |

Location1: Conversion factor: Userlrt1: [ 9
Location2: [ 0] Fitercode: [0 userhi2 [0
Location3: Smarerotcods: [ 0] UserReall: [ 9
Locationd: Total code: [ 0] UserReal2: [ 9

Location5: Ijl

Instrument tag: | PlantP A/ Area/Data:Plant P Ax_DAT [LGXCOTTO1001.Val |
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20. To monitor the last historical data, select Current Values and click the

Search & tool.

[+ asih01a  Primary
[] ASIHO1B  Secondary

System Management Tools

I Interfaces
I IT Points
I» Operation
I» Points

I+ Securty

SYSTEM\Administrator | piadmin

i Pl System Management Tools (Administrator) I;Ii-
File View Tools Help
Collectives and Servers Q & ] @ &“] 7]
Seards Vet Tag Name  Server  Collective  Timestamp Value Engineering Units = Descriptor
Collective: ASIHOT TTO1001.Val ash0la ASIHO1  10/28/20156:23:50 PM  22.39998

Session Record

21. In the Tag Search window, type a tag mask or "*" for all tags, and click
Search.

A taglist appears on the Tag Search window.
22.  Select any tags that you wish to monitor and click OK.

23. To see values change as they periodically refresh, click the ‘Play’ button.
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Create Digital States

Historian points can be defined as analog or digital. Digital points can be used
to enumerate the process states, thus creating a relationship between the value
and the text state name. For example: 1 = Good.

1. Using SMT with the proper historian server connection, select Digital
States and click Add a Digital Data Set.

]

File View Tools

Add a Digital Data
Set Button

Collectives and Servers

Seardh

Collective: ASIHO1

asihll1a
[] ASIHO1B  Secondary

Primary

Seardh

I» Alarms
I Rateh

Table 3 - Source Quality Data Examples

System Management Tools

BE |

Digital States - Pl System Management Tools (Administrator)

Help

(]

A L asih(ia State Ciny
| Add a digital state set to the selected server l

BHEH B

e Name

As an example of how to create your own Digital Data Set, review

Table 3.

Parameter Data Type

Description

SrcQ SINT

Final PV source and quality.

GOOD 0=1/0live and confirmed good quality

1=1/0 live and assumed good quality

2 = No feedback configured, assumed good quality

8 = Device simulated

9 = Device loopback simulation

10 = Manually entered value

16 = Live input, off-specification

17 = Value substituted at device/bus

18 = Value substituted by maintenance (Has and not Use)
19 = Shed, using last good value

20 = Shed, using replacement value

32 = Signal failure (out-of-range, NaN, invalid combination)
33 =1/0 channel fault

34=1/0 module fault

35 =Bad /0 configuration (for example, scaling parameters)

TEST

UNCERTAIN

BAD
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2. Type a Digital Set name (SrcQ in the example).
3. Type a state name as shown in the Description column of Table 3.
New rows are automatically added as information is entered.

Unused values can be Undefined states.

File View Tools Help

Search
: State State Name:
Collective: ASIHOT 0 Bood - /0 Live ond confmed
¥ ash0ta  Primary G,,m._ e Wmma“
[[] ASIHO1B  Secondary ! ot =
2 Good -

Seardh 2
[» Alamms
I» Batch
I» Data
I Interfaces
I IT Points
I Operation
4 Paints
Performance Equations
Paint Builder
Point Classes
Point Source Table
Totalizers
I+ Securty

SYSTEM\Administiotor [piodein [ |:

4. Save your changes.
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Import Digital Sets and
States

Instead of manually entering Digital Sets and States, use Process Objects to

import them.

The Digital Sets and States are available from the Historian folder in the
Process Library. The Historian information is in a subfolder (Tools & Utilities)
of the Files folder in the Process Library download.

Complete these steps.

1. Using SMT with the proper historian server connection, click

Digital States.

2. Click the Import button.

]

File View Tools Help

Collectives and Servers
I3

Collective: ASIHO1

asihl1a  Primary

[] ASIHO1B  Secondary

System Management Tools
I3
I» Alarms
I» Batch
I» Data
I Interfaces
I IT Points
I» Operation
4 Points
enommance Cquations
Point Builder
Paint Classes
Point Source Table
Totalizers
I+ Securty

1

4 &K aihD‘Ia State

Digital States - Pl System Management Tools (Administrator)

= )

Stﬂ Import set(s) and states(s) from a file
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i file with sets and states:

3. From the Import Digital Set(s) dialog box, click the folder icon.
4. Selecta .CSV file from the dialog box.

File Preview
Sets in file:

Set

COwverwrite Options
(®) Do not overwrite existing sets

() Prompt before overwriting existing sets
(2 Automatically overwrite existing sets

O Import set with a different name if set already exists|

Import set(s)to server: |asihﬂ1a

T |_E » ThisPC » Documents » W G| | Search Documents

Organize « MNew folder
™ Pe
¢ Favarites Rlame) flype
B Desktop I|@ (RA-LIB) DigitalSet_ProcessObjects v4.00-... Microsoft Excel C...
j, Downloads

5l Recent places

1M This PC
_H Desktop
_E Documents
j, Downloads
_ﬂ Music
_EI Pictures
_‘ Videos
i, Local Disk (C2)

w

File name: | (RA-LIB) DigitalSet_ProcessObjects v4.00-01.csv

5. Click Open.
6. Click Create Set(s).

Comma delimited file with sets and states:
CA\Users\ Admiristrtor SYSTEM\Documents'\(RA-LIE) Digtal!

File Preview
Sets infile: 38
Set
BP_Aln_Val_Fault
P_Aln_Val_5Sts
vl [ByP_AOut_Val_Fault

COwverwrite Options

(®) Do not overwrite existing sets

O Import set with a different name if set already exists
O Prompt before ovenwriting existing sets

O Automatically ovenwrite existing sets

Import set(s)to server: |asihﬂ1a
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A minimum number of the recommended Digital Sets is created. This
procedure does not create the basic Digital Set file for all Process

Objects digital states.

R Digital States - Pl System Management Tools (Administrator) = =] 2=
File View Tools Help
Collectives and Servers 3 » = . :l nﬁ 3@
Searal 2 A l@ asihlla | State State Name
Collective: ASIHO1 i S}
asih0la  Primary ‘)( Import Digital Set(s) = o -
ASIHD1E  Second
O e Comma delimited file with sets and states:
[C:\Users\Adrinistrator SYSTEM\Documents\(RA-LIE) Digtak]
pialamcontrol
pisqcalam File Preview
- Sets infile: 38
System Management Tools - Set State 0 "
Search L P_Aln_Val_FaL P _Aln_Val_Fauit None
b Alarms P_Aln_Val_sts P_Aln_Val_Sts PV Good
b Batch P_AOut_Val_Fg 4 P_AOut_Val_Fault None »
I Data P_ADut_Val_5 [l Fn amoo ven .
I Interfaces P_D4SD_Val_f <l m >
I+ IT Paints P_D45D_Val_$
[+ Operation P_DBC_Val_Fz Overwrite Options
4 Points P_DBC_Val_St (®) Do not overwrite existing sets
Digital States P_Din_Val_FaL () Import set with a different name if set already exists
Performance Equations P_DIn_Val_5Sts () Prompt before overwriting existing sets
Paint Builder P_DoseFM_Va () Automatically overwrite existing sets
Point Classes P_DoseFM_Va
Point Source Table P_DoseWS_Ve Import set(s) to server: |asihD1a W |
Totalizers P_DoseWS5_Ve
b Securty P_DOut_Val_F [Craeset) || Cose |
P_DOut_Val_§
P_HiloSel_Val
[BY P_LLS_Val_Fa
E P 11S Val St
Session Record
10/28/2015 6:51:28 FM IfSYSTEM"-Administlator} PI-DSE> Set '\c"aI:Not'rfy' sucessfully imported to server asihl1a Iflmport} -~
L
SYSTEM\Administrator | piadmin

7. Click Close.
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The digital set is available only to a digital points type. The FactoryTalk
Administration Console automatically creates a Float32 (Real) point type for

each new point.

IMPORTANT  Before continuing with this section, it is necessary to include the

Digital Historical point such as SrcQ (see step 1 on page 89 through
step 11 on page 92).

This section shows how to change the point type.

]

Point Builder - Pl System Management Tools (Administrator)

File View Tools Help

Collectives and Servers
Seardh

Collective: ASIHO1
asihl1a  Primary
[] ASIHO1B  Secondary

System Management Tools

Search 2

I» Alarms

I» Batch

I» Data

I Interfaces

I IT Points

I» Operation

4 Points

Digital States

Point Source Table
Totalizers
I+ Securty

FHE B N@
2 :

==

2 points

o SRS i

asih0la TT01001.5rcQ

FTLD classic

piadmin:

ZSmOTE 110700 Vel

<

FILL F 051 Classic

General |Archi\re I Classic I Security I System |

Name:  |TT01001.5cQ

| (B ] s

Descriptor: |Tempevature 01001

Point class: |classic

Point type: | Float32 VI Digital set:

Point source:

Eng Units: | Display digits:
Exdesc: | |
Source tag: | |
Session Record

SYSTEM\Administrator | piadmin

1. To be able to change the digital set, select Digital from the Point

type pull-down.
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File View Tools

2. Click the Digital set pull-down menu and select a Digital Set (SrcQ in

the example).

Help

Collectives and Servers

Search pel

sd X BBe

2 points

Collective: ASIHO1
[+ asih01a  Primary
[] ASIHO1B  Secondary

System Management Tools

Search pel

I» Alarms

I» Batch

I» Data

I Interfaces

I IT Points

I» Operation

4 Points
Digital States
Performance Equations
Point Builder
Paint Classes
Point Source Table
Totalizers

I+ Securty

Server  Point
asihl1a TT01001.5rcQ
asihlla TTO1001.Val

Paint Source

FTLD
FTLD

<] [T

Point Secur
piadmin: Al
piadmin: Al

Poirt Type
Float32
Float32

Poirt Class ~ Descriptor
classic
classic

General |.Archive I Classic I Security I System |

Name:  |TT01001.5cQ

| [Rename | PiServer: [asihta v

Descriptor: |Tempemture 0om

Point class: | classic

| Pointsource:

Point type: | Digtal v| Ibigital set

v

Eng Units: |

Exdesc: |

Source tag: |

SYSTEM\Administrator

piadmin

P_DoseFM_Val_Fault
P_DoseFM_Val_Sts

P_Valve_Val_Fault
P_Valve_Val_Sts
P_VSD_Val_Fault

UFD_State
Val_Mode
Val_Notify

~

3. Click the Save E icon to store the Historian point.
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]

4. Click Current Values and search for our tag to view the Digital set value
corresponding to the point value.

File View Tools

Collectives and Servers

Collective: ASIHO1
asihl1a  Primary
[] ASIHO1B  Secondary

System Management Tools
Search 2
I» Alarms

I» Batch

4 Data

Rockwell Au

Help

Callec & XK
sear »r Tag MName

TT01001 . Val

Current Values - Pl System Management Tools (Administrator)

_I:I-
dEE e

Server
TT01001.5rcQ  asihlila
asihl1a

Collective
ASIHO1
ASIHO1

Timestamp Value

10/28/2015 7:06:28 PM  Uncertain - Value substi...
10/28/2015 7.06:46 PM  21.88334

Engineering Units ~ Descriptor
Temperature 01001

C Temperature 01001
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Pl Builder Bulk Ed|t|ng The PI Builder spreadsheet provides for bulk tag editing. Complete the

following steps.

IMPORTANT  Before starting this section, Pl Builder must be configured as a Microsoft
Excel add-in. See the Excel add-in subsection in Chapter 9 of the PlantPAx
Distributed Control System Infrastructure Configuration User Manual,
publication PROCES-UMOO1.

1. Open the Microsoft Excel software.

2. Click PI Builder and choose PI Points>Find PI Points.
F ™ R e Bookl - Microsoft Excel -0 -

Home Insert Page Layout Formulas Data Review View Pl Datalink Pl Builder (2] 9 = =
Data Server: @ ASIHO1 ~ i x () Select Al \/«’ i:g & | | o [ Show Values in Rows [Headers @ About
Asset Server: (@ AsIS01 ~ ( ) Deselect All

DShowValuesinColumns "_??'Settings eHeIp
Publish Delete Pl Library Elements Event Refresh ~

Database: @ PlantPAx =

E“Resetto Template | |pgints = - - e .
Conpeciors Build * APl Points | Attribute Data References Resources
Al - F | .7, Find Pl Points... |
A B < B E P @  anDigital States 1 J K L M N 0
T3 Find Digital States...

S = A R ST )

I |3

The Tag Search dialog box appears.
3. Type an object between the asterisks (“T'T01001* in the example) and

click Search.
The asterisks are a wild-card search that finds all tags associated with
the object.

- Tag Search -
Server(s): |ASIHII|1 [
[ [ e
Name Data Server De @

OTI‘DIDDI.Sch ASIHO1 Tempe|
& TT01001.Val ASIHD1 Tempe
&% TT01001.Val_Fault ASIHO1 Tempe|
£ m »
3 results returned in 0. 126712 seconds. |
| Cancel | | Reset |

4. Click OK.
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5. Click OK to use the default for the objects types and column headers on
the spreadsheet.

Object Type: |PIPoint

Object Types: 1 selected, Columns: 51 selected

=-[W]General

E Description
- []digitalset
[l displaydigits
E engunits

- [Wlexdesc
E future

E pointsource
E pointtype

. [#ptdlassname
E sourcetag
|:| MewMame
1 LA A rbivan

| Clear all || Select all ||Mc.regttributeCc.lun'.ns...

w

Description:

The columns in this group are required. They may not be
deselected and neither the group nor the 'Selected(x)' column
may be moved.

The spreadsheet populates information under the respective

default headings.

9= Book1 - Microsoft Excel =B x

Home Insert Page Layout Formulas Data Review View Pl Datalink Pl Builder & e o 3
Data Server: '@ ASIHO1 - I% x (x) Select All 0‘ ﬁ & | | E Show Values in Rows Ij Headers OAbout
Asset Server: ‘ASIS{H e

( ) Deselect All Show Values in Columns @Settings eHeIp
Publish Delete Pl Library Elements Event Refresh
Database: e FlantPhx = .'n Reset to Template | pgints = - - Frames = N = ‘<> Errors
Connections | Build fa | Retrieve | Attribute Data References | Resources |

M = fe | Selected(x) IZ|
A B | ¢ ] D | E F [ e [ w [ o0 v T «x ] L E
|Selected(x) IName ObjectType Description digitalset displaydigits engunits exdesc future pointsource pointtype ptclassnal |

X TT01001.5rcQ PlPoint Temperature 01001 SrcQ 1 TT01001 0 FTLD Digital classic

X TT01001.Val PIPoint Temperature 01001 5C TTO01001 0 FTLD Float32  classic

X TT01001.Val_Fault PIPoint Temperature 01001 P_AIn_Val_Fault 1 TT01001 0 FTLD Digital classic

Operations Completed:

Processing PIPoint ‘TTO1001.5rcQ'
Processing PIPoint TTO1001.Val'
Processing PIPoint TTO1001.Val_Fault'
The requested action is complete,

MO = = e
2|8]e|s]s|s]c]s |5 8] |5 ] o @] |aun|aw|s ]

6. Click Close.
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7. Change your configuration or duplicate the point.

8. Click Publish.

FL™ e Book1 - Microsoft Excel =0 -
Home Insert Page Layout Formulas Data Review View Fl Datalink Fl Builder =] e o @ &3
Data Server: ? ASIHOT ~ L,# x (x} Select All ) ' i:-g % H ﬂ |:| Show Values in Rows Ij Headers oAbout
Asset Server: QASIS[N = ( ) Deselect All \ ’/ b |:| Show Values in Columns gf‘ Settings e Help
Publish jDelete Pl Library Elements Event Refresh
Database: @PlantPAx' E',“Resetto Template | pgints « - - Frames = = 8> Errors
Connections Build £l Retrieve ] Attribute Data References Resources
- fx | selected(x) v
A B c D E F G H I J K L
1 |Selected(x) IName ObjectType Description digitalset displaydigits engunits exdesc future pointsource pointtype ptclassna
2 x TT01001.5rcCy PlPgint Temperature 01001 SrcQ 1 TT01001 0 FTLD Digital classic
3 x TT01001.Val PIPoint Temperature 01001 5C TT01001 0 FTLD Float32  classic
4 |x TT01001.Val_Fault PIPoint Temperature 01001 P_AIn_Val_Fault 1 TT01001 0 FTLD Digital classic
5
6
7

9. Click OK to print the information on the spreadsheet.

Edit Mode:

Publish Options

Create and Edit v

D

Publish Selected Objects

Operations Completed:

Processing PIPoint TT01001.5rcQ’
Processing PIPoint TT01001.val'
Processing PIPoint TT01001.Val_Fault'
The requested action is complete.

Close

10. Click Close.

Using the Template

Rockwell Automation provides a Historian template inside the Process Library
that shows suggested points that can be used as digital Historian points. To
access the Library folder that contains the template, see page 99.

You can select the object points ('x' in the Select(x) column next to the desired
point) and edit them according to your needs.
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The Export Tags functionality is available to create, edit, or delete

Historian points.

= :
HOME INSERT
“D % Calibri
Eg -
Paste B I U-
Clipboard Font
Ad4 h
A B
1 |Select(x) Tag
2 P_DIn
3 x L5100.5ts_PV
4 |x LS100.Val_Sts
5 |x Ls100.val_Fault
5 P_DOut
7ox XY100.Val_Sts
g x X¥100.val_Fault
9 P_ACut
10 |x XC100.Val_CvOut
1% XC100.Val_Sts
12 [x XC100.Val_Fault
13 P_Aln
14 % XT100.val
15 x XT100.SrcQ.
16 |x XT100.Val_Fault
17 P_AlnAdv
18 |x XT200.Val_RoC
19 % XT200.Val_Ref
20 |x XT200.val
21 x XT200.SrcQ.
22 |x XT200.Val_Fault
23 P_AInDual
24 |x XT300.val
25 XT300.Val_PVA
» 10 Processing

(RA-LIB) Template_ProcessObjects v4.00-07.xlsx - Excel

PAGE LAYOUT FORMULAS DATA REVIEW VIEW VANTAGEPOINT PI DATALINK
== = General M L_po‘J Q
=E==&x= B $-% 0 99 Conditional Formatas Cell

’ " Formatting~ Table~ Styles~
s Alignment [F] Number s Styles
Fe
C D E F G H | J

archiving changedate changer compdev compdevpercent compmax cOmpmin COMpPressing convers

1 piadmin [} 0 28300
1 piadmin 1] [ 28300
1 piadmin 1] 1] 28800
1 piadmin 1] [ 28300
1 piadmin 1] 1] 28800
1 piadmin 0.5 0.5 28800
1 piadmin 1] 28800
1 piadmin [} 0 28300
1 piadmin 0.5 0.5 28800
1 piadmin 28300
1 piadmin 1] [ 28300
1 piadmin 0.5 0.5 28300
1 piadmin 0.5 0.5 28800
1 piadmin 0.5 0.5 28800
1 piadmin [} 0 28300
1 piadmin 1] [ 28300
1 piadmin 0.5 0.5 28300
1 piadmin 0.5 0.5 28800
Mators Valves Procedural Control Regulatory ¢ ... 4

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019

(=]

=RE=RE =R == (=]
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?E - 0O
Pl BUILDER Signin
Insert = 2 - A 'I
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e Sort & Find &
EiFormat~ &~ Fifter - Select -
Cells Editing
K L M
creationdate creator datas
1 1 piadmin piadn
1 1 piadmin piadn
1 1 piadmin piadmn
1 1 piadmin piadn
1 1 piadmin piadmn
1 1 piadmin piadn
1 1 piadmin piadmn
1 1 piadmin piadn
1 1 piadmin piadmn
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Import Asset Framework
Templates

Complete these steps to import templates for Asset Framework, which
provides a means to organize your process equipment assets. We providc Asset
Framework templates with the download of the Rockwell Automation

Library of Process Objects.

1.

To open the Asset Framework server, click Programs>Rockwell
Software®>FactoryTalk Historian SE>System Explorer (64-bit).

. Microsoft Visual Studio 2010 4
. FactoryTalk Activation * | . Rockwell Software
» | . FactoryTalk Historian SE . Startup 4
Systemn Explorer (84-bit) .. FactoryTalk Tools | VMware 3
System Explorer . RSLinx ¥ | | Windows Accessories 4
. Uninstall FactoryTalk Historian Analysis Service FactoryTalk Administration Console . Windows System 4
. Uninstall FactoryTalk Historian Asset Framework || Desktop
Q PC settings
p Search
ﬁ Store
2. Click Yes to create a user database.
Create Database *
o The AF server 'ASIS01" only contains the system configuration database.
IMPORTANT Stepsz and 3 are J lé. Would you like to create a user database at this time?
necessary only the first
time that you name
a database.
3. Type the name of the user database and click OK.
o Database Properties = = -
. General
—=
Description:
Server: |A51501 | §
Extended Properties (0)  Security
o | o]
The PI System Explorer dialog box appears.
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4. Click Library in the lower, left pane.
5. Right-click the database name and choose Import from File.

File View Go Tools Help
°Database P Query Date -~ (© ﬁ' |OBack 5] |H¢ Checkln %3} « |[£]Refresh ||' New Template ~ | |SearrhEiementTempiates Pl

me: |Planﬂ9Ax

scription: |

erver:  [AsIS01

¥ Checkln Extended Properties (0) Security
f ¥} Undo Check Out

Rename

Security...
#f  Properties

2| ElEmENT LateEgories
Reference Type Categories
Table Categories

PlantPAx Modified:4/10/2017 9:21:37 AM.
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File View Go Tools Help

WWASISOT\PlantPAx - Pl System Explorer (Administrator) -

Configure Historian Data Collection ~ Chapter 4
6. Click Browse (ellipsis “...) in the Import From File dialog box.
7. Browse in your system files to the (RA-LIB)
AssetFramework_Templates .xml and click Open.
@ x

'#, Reference Types

Allow Create

@Database P Query Date -~ (© @ Back H, Checkln <2 « [#]Refresh | @ New Template - |Sean:h Element Templates O v|
Library PlantPAx
@ PlantPAx General |Coums |
- Templates
B 7 X
- (y Element Templates Import from File I_I |
eI % Event Frame Templates |
+- |%g Model Templates Fille: -
+-- i Transfer Templates | I|— |
@ Enumeration Sets Import Options

[[] create or Update PI Points

Tables

4. Downloads

= Recent places

1M This PC
j Desktop

| Documents

4. Downloads

(7 Elements J' Music
|=={ Event Framg =| Pictures
 Library =T

e Unit of Mead

] Analyses

PlantPAx Modif

Open -
T | .« Downloads » Historian W C..| | Search Historian » |
Organize « Mew folder == - E @
¢ Favorites - Mame - Date modified Type Size
B Desktop | (RA-LIB) AssetFramework_Templates vd.... [|/28/2017 2205 PM XML File 3

L

m >

File name: | (RA-LIB) AssetFramework_Templates v4.00-00xml

v| xml files (*axml) W

Cancel

IMPORTANT  The Asset Framework templates are included in the Historian files
with the Rockwell Automation Library of Process Objects download.

8. Click OK and Close.

Import from File

File: ||D\,D0wnloads\,Hishnrian\(RA-LIB) AssetFramework_Templates v4.DD-DD.me||

Import Options

Allow Create

Allow Update
Automatic Check In

[[] create or Update PI Points

Cancel

Import from File

Operations Completed:

Processing AFAnalysisTemplate 'Fault Analysis'
Processing AFElementTemplate 'P_ValveMP_Val_Fault’
Processing AFElementTemplate 'P_ValvesO'
Processing AFAnalysisTemplate 'Data’

Processing AFAnalysisTemplate 'Fault Analysis'
Processing AFElementTemplate 'P_VSD'

Processing AFAnalysisTemplate 'Data’

Processing AFAnalysisTemplate 'Fault Analysis'
Processing AFElementTemplate 'P_VSD_Val_Fault'
The requested action is complete.

<
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The database now contains the Library object templates.

File  View Go Tools Help
°Database P Query Date -~ (© ﬁ' |OBack 5] |H¢ Checkln %3} « |[£]Refresh |‘a New Template ~ | |Searrh Element Templates O ~

[~ ||| seneral Counts

Mame: |Planﬂ9Ax

Templates
Bl [y Element Templates
@ C_Interface_FTLD Description: |
(& C_Interface_Perfmon
(& C_Perfmon Server: |A51501
(& C_Perfmon_ASAM Extended Properties (0) Security
(& C_Perfmon_ASIH
(& C_Perfmon_ASIS
(& C_Perfmon_PASS
f@LCrU
(& L_Shortcut
(& P_AIn (‘—
() P_AInAdv
(& P_AInDual
() P_AInMulti
(% P_AOUt
(% P_D45D
(% P_DBC
{§ P_DIn
() P_DoseFM
(& P_Dosews
(% P_DOUt
(& P_Fanout
(G P_HiLosel

Objects

PlantPAx Modified:4/28/2017 2:21:42 PM.
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Configure Asset Framework ~ Complete these steps to associate the tags with Historian elements, which are
Elements the Process object templates.

1. Click Elements in the lower, left pane of the PI System Explorer
dialog box.
An Element tree appears in the top, left pane.
TIP  The term ‘element’is used in the Asset Framework software.
For PlantPAx system purposes, ‘element’ can be considered

synonymous with ‘objects’in the Rockwell Automation Library
of Process Objects.

2. Right-click Element and choose New Element.

o | WASISO1\PlantPAx - PI System Explorer (Administrator) = [ = -
File  Search View Go Tools Help

@Database P Query Date ~ © @ Q) Back H, Checkln ) « [#]Refresh |3 New Element ~

Elements | Elements
& Elemer Group by: [] Category [ | Template
T}, Elemen ew Elermen -
(3, El tl' @ Mewkl t o)
MNew Model
lil ewMode ame | Description Category Type Template @ |

P  Add Element Reference... ere are no elements configured for this database. Elements are the fundamental organizational

i object block of AF, typicall d to t t f ts,
Arrange By , fobjectblocko typically used to represent an asset or group of asse

.j R ) Element
=
— e » Model
Paste d Element Reference

B Paste Reference
E  Import from File...

& Security...

E—

== kvent Frames
i Library

e Unit of Measure
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3. Select P_Aln and click OK.

Parent: |PlantPAx
Add child element using the reference type:
=+ Parent-Child

Element Template:

&P _AInDual
P _AInMulti
&P _Aout
(@P_D45D
(P _DEC
(&P _DIn
(@P_DoseFM
(P _DoseWs

4. Type the tag that is being assigned to the object, such as P_Aln.
5. Click Check In.

File  Search View Go Tools Help

°Database P Query Date ~ © ﬁ' |°Back OIH‘, Check In I} v [£] Refresh ||j New Element = |

Elements TT01001
- ) Elements General | child Elements | Attributes | Ports | Analyses | version |
S TT01001
(L3, Element Searches e |
Description: | Simple Analog Input |
Template: |P_Aln ”ﬁ Type: |None |
Categories: |10 Processing & pefauit Attribute: | <hone> |

Extended Properties (0} Annotations (0} Security
Find: Parents Children Event Frames
Models Layers Connections

6. Click Check In again.

Mame This Session  Path Type User

W] Jlpata True TT01001'\Data Analysis SYSTEM\Administrator
[l &Fault Analysis True TT01001'Fault Analysis Analysis SYSTEM\Administrator
[V v TTo1001 True TT01001 Element SYSTEM\Administrator

A |[ one

|:| Create New Version

Effective Date: |5/30/2017 2:13:01.32PM | ]|
Comment:

[] only show database Chedk-In dialog when Shift key is down.

The current historical value is accessed from the Attributes tab.
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Search Event Frames

7. Click the Attributes tab.

8. Click the Refresh button [#Refresh |

File  Search View Go Tools Help

°Database P Query Date -~ (© ﬁ' @ Back ) |H, Checkln <2 /IRefreshI ‘iF New Element ~ =] New Attribute

Elements TT01001
= Elements | General | child Elements | Attributes |ports | Analyses | version
& TTo1001 Group by: [] Category [ ] Template
(L3, Element Searches —
Filter ¥l v|
&t l|0|§ MName | Value @
¢ = & sreQ Good - 1jO live and assumed good quality
. &F val 0
E & Val_Fault None

Complete these steps to search for event frames. Abnormal conditions trigger
an event, with date, time, and duration of the event.

1. Click Elements in the lower, left pane.

2. Click the Analyses tab on the PI System Explorer dialog box.

File  Search ¥iew Go Tools Help
oDatabase % Query Date ~ © ﬁ @ Back () H, Checkin ¥} « |#]Refresh | F Mew Element -

Elements TT01001
E- d Elements General | Child Elements | Attributes | Ports || Analyses Wersion |
. (3 TTO1001 .
f... £ Element searches lﬂ ] | Mame: Fault Analysis

| Search Elements

e m [HE MName Backfilling Description:
] Data
O feo G i Fault
@ ® T Fault Analysis |
Analysis Typee () Expression () Rollup

(@) Event Frame Generation

P_Aln_Val_Fault Functions
Insert functions into the expression
All

Event Frame Template:

Name Expression
Abs

StartTrigger| 'Val Fault'<>"None™
— Acos
EndTriseer 5 And
StartTrigger true for 0 o
x)
Return the absolute value of an integer or re
Example: Abs(1)

~ [[] Generate child root cause event frame before parent event frame starts

Duration:

Name: Root Cause
Category: |

Scheduling: (@) Event-Triggered () Pericdic .
Connected to the Pl Analysis

Trigger on [Any Input Service.

TTO1007 Modified:5/30/2077 2:14:04 PM. Version: 1/1/1970 12:00:00 AM, Revision 1
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The same fault information is available from Analyses in the lower,

left pane.
| \WASISO1\PlantPAx - Pl System Explorer (Administrator) == -
File View Go Tools Help
@ Database [% QueryDate » (D @ Q) Back H, Checkln ¥} « (2] Refresh
Analyses Analyses
__(_3"'0055 a filter & 0 total analyses selected (0 on this page) 1-20f2 (< | = o
7] P
[] status B Element MName Template Backfilling Start 0 selected analyses
Al (2) O & fio TTo1001 Data Data Stop 0 selected analyses
— Backfill 0 selected analyses
[ @ | TT01001 Fault Analysis Fault Analysis
Analysis Details @ Pending Operations
Mo pending operations
Overview | Errors And Warnings |
| Fault Analysis configuration ®) Status
Analysis type: Event Frame Generatiocn In AF:
J Elements Description: In PI Analysis Service:
Element path: TT01001
ieentirames Template: Fault Analysis
“1 Librai Schedule: Natural
;‘Q = Categories: Fault < W v
ez Unit of Measure
m Analyses Analysis configuration
Analyses

Finding Faults for Analysis

Complete these steps to search for event frame events to assess faults.

1. Click Event Frames in the lower, left pane of the PI System Explorer
dialog box.
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2. Right-click Event Frame Searches and choose New Search.

File  Search View Go Tools Help
°Database P Query Date ~ © ﬁ' |°Back (5] |H¢ CheckIn %} « |[#] Refresh |[—|New Event Frame |

Search Event Frames o

- [ d
B Transfer Searches
b =g Transfer Search

uery

BT qo

Mew Search |

Mew Attribute Search
Mew Event Frame
Refresh

[ Analyses

0 Event Frame Searches

3. Select the desired search criteria and any filters.

| Enter Event Frame Criteria

Criteria

Search: |Siarh'ng Before v| [] In Progress

Search start: [12/31/3998 11:59:53 pM |[F]|[ » | (1 Al Descendants

MName:

Element Name:

Category:

I
|I: [] category [] Template
Valves | StartTime {53

4. Click Search.

The search results for the selected criteria appear at the bottom of the

dialog box.
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5. Click OK.

:"I0 Processing

Criteria

Search: |Siarh'ng Before v| [] tn Progress
Search start: [12/31/9999 11:58:59 PM =] » | [¥] all Descendants

Criteria

MName:

Element Name: Search: |Siarh'ng Before W | [] in Progress

Search start: [12/31/9999 11:58:59 PM =] » | [¥] all Descendants

Category: IO Processing W

X X X X

Templ, <All= v
Fd Add Criteria ~

MName: *
Element Name: *
Group by: [ Category [ oo 10 Processing v| %
Gantt |Durah'on |Stzrt Templ <al= W K
Fd Add Criteria ~
Results

Group by: [] Category [ | Template
|5i... [06:26:34.6732025] 5/...|Duration 3 |~

0:03:44.035

1:40:13.181

Symbol shows duration of fault by length of the line.

= Fault Analysis 2017-05-30 14:25:30,249 H 0:03:35.346 "

6. Toview clements (tags) that are associated with the fault for the selected
search criteria, double-click a fault.

7. Click the Referenced Elements tab.

File  Search View Go Tools Help
a Database [ Query Date - (U ﬁ' @ Back ) |H, Checkln @ v Refresh | = New Event Frame |Searrh Event Frames pe
rent Frame Searches Referenced Elements (B tributes
3 Event Frame Search 1 Group by: [ ] Category [ ] Template

""" [=={ Fault Analysis 2017-05-30 14:25:30.249
[=={ Fault Analysis 2017-05-30 08:23:58.940 Fiter £ 4

------ == Fault Analysis 2017-05-30 08:12:27,907 .||3 Name . Description Category Type Template @

------ == Fault Analysis 2017-05-30 08:02:30,923

amsfir Searches ® | 47TT01001  iSimple Analog ... |10 Processing | Naone P_AIn ’
"¢ Transfer Search 1

Each tag (and description) that is assigned to the element appears.
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8. To view a description of the abnormal condition, click the

Attributes tab.

@]

File  Search View Go Tools

@Database P Query Date ~ © @ ) Back

WWASISO1\PlantPAx - Pl System Explorer (Administrator)

Help

H, Checkln «2

« [#] Refresh | = New Event Frame

MNew Attribute

BE |

£Xd

| Search Event Frames

Event Frames

Fault Analysis 2017-05-30 14:25:30.249

rent Frame Searches

3 Event Frame Search 1

------ == Fault Analysis 2017-05-30 14:25:30.249
------ == Fault Analysis 2017-05-30 08:23:58.940
------ == Fault Analysis 2017-05-30 08:12:27,907
------ == Fault Analysis 2017-05-30 08:02:30.923
ansfer Searches

3 Transfer Search 1

< m >

| General I Child Event Frames I Referenced Elemen

(7 Elements

== Event Frames

i Library

e Unit of Measure

] Analyses

Group by: [] Category [ | Template

| Fiter

£

@ |

# ¢ 8|8 Name

1 Attribute

Event Frames Reports (Pl Builder)

This section describes how to generate reports by using the information that is
collected from the Event Frames (PI Builder spreadshect).

IMPORTANT  The PI Datalink tool used in this section is optional and requires a license.

1. Open the Template_ProcessObjects spreadsheet, which is included in
the download with the PlantPAx Library of Process.

2. Select the PI DataLink tab and click Explore.

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019

PR Book1 - Microsoft Excel == -
Home Insert Page Layout Formulas Data Review View Pl Datalink Pl Builder & e o B o2
— = C\:j‘» H
B & 6 B Yol|7]— QB 5 @
Current Archive | Compressed Sampled Timed | Calculated  Time Explore fCompare | Search Asset | Properties | Update | Resources
Value Value~ Data - Data~ Data Data~  Filtered = =3 " " Filter -
Single Value Multiple Value Calculation Events Search Properties | Update
Al - I v
A B c D E G H I J K =
1
2
3
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3. Click the Add button to add an attribute.

Bookl - Microsoft Excel

Home Insert Page Layout Formulas Data Review View Fl Datalink Fl Builder =] 0 o =
v G4 OB B "~ QB 5 @ .
e O© ) About
Current Archive | Compressed Sampled Timed | Calculated  Time Explore Compare | Search Asset | Properties | Update
Value Value~ Data - Data~ Data Data~  Filtered = " " b Filter Help
Single Value | Multiple Value | Calculation | Events | Search | Properties | Update | Resources |
a1 - |
A | 8 c | o [ e | F [ & | w Explore Events
13
— Database
14
1 [\\ASISOT\PlantPAx

T i N N N Vo VORI

| Falif Anaiysis 2017-05-31 05,0032 7

=i Fault Analysis 2017-05-31 09:04:00.156

Columns to display
[] Select all

[+ Event name ~
[¥] Start time

End time

Duration

Event template
Primary element
Primary element path
Element template

100K K& &

Number of child event levels Output cell
o v] ['Sheet115As1

v [ ok |[ Ay
M 4 » M| Sheat1 “Sheat? Shestz ¥#1 Ml [ [

4. Click the desired additional attribute.

Browse events and select attributes to add as column headers

=

- = Fault Analysis 2017-05-31 08:50:33.773
- = Fault Analysis 2017-05-31 09:00:32.757
- = Fault Analysis 2017-05-31 09:04:00.156

5. In the bottom, right pane, select the desired ‘Columns to display’ ans

click Apply.
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The events under the filter section appear in the report array.
———
Pl == Bookl - Microsoft Excel =
Home Insert Page Layout Formulas Data Review View Pl Datalink Pl Builder & e = EH
nfd @ OB E “ - QB H @ 3o
= | G) About
Current Archive | Compressed Sampled Timed | Calculated  Time Explore Compare = Search  Asset | Properties | Update
Value Value~ Data - Data~ Data Data~  Filtered - " = b Filter Help
Single Value | Multiple Value | Calculation | Events | Search | Properties | Update | Resources |
Al - (- I |{=PIEFDat["\\ASISOl\PIantPAx",""-ld",""",0,""",""","‘”,""","‘","”,"","active in range","start time ascending”,"™,"™,"", T
A B | ¢ [ o [ E F 2| Explore Events v x
1 |Start time End time Duration Primary el Val_Fault Database Event name
2 | 30-May-17 08:23:59 30-May-17 10:04:12 0 1:40:13 Bad Input
- [\\ASISOT\PlantPAx - |
3 | 30-May-17 14:25:30 30-May-17 14:29:06 00:03:35 TT01001 High
4 | 31-May-17 08:50:34 31-May-17 08:57:25 00:06:52 TT01001 High Search start Event template
5 | 31-May-17 09:00:33 31-May-17 09:01:14 00:00:41 TT01001 High *1d - v |
: 31-May-17 09:04:00 31-May-17 09:05:32 00:01:32 TT01001 High Search end Element name
z | | |
9 o Element template
10 [] Limit to database level " v|
11
12 More search options
13 Preview
= = Events (5 found)
15 i p={ Fault Analysis 2017-05-30 08:23:58.940
16 == Fault Analysis 2017-05-30 14:25:30.245
17 == Fault Analysis 2017-05-31 08:50:33.773
L = Fault Analysis 2017-05-31 09:00:32.757
18 I = Fault Analysis 2017-05-31 03:04:00.156
19
20
21
22 Columns to display
23 [a] Select all
24
25 [] Event name ~
o [# Start time
27 [+ Endtime
= [+ Duration
= [] Everttemplate
[w] Primary elemert
£ [] Primary element path
31 [] Blement template "
32 —
33
= Number of child event levels Qutput cell
o v] ['Sheet11sAsT |
35 =
36
e
4 4 » M| Sheetl Sheet? ~“Sheet3 ~¥J nEN| Il v [

Ready
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PlantPAx COnfiguration Tool The toolis used for creating tags in Historian based on the Asset Framework
model. The procedure assumes that the tool is installed after being
downloaded from the Rockwell Automation Library of Process Objects.

Configure Asset Framework Server

For optimum tool performance, you must make sure that the Asset Framework
server is configured as described in this section.

1. To open the Asset Framework server, click Programs>Rockwell
Software>FactoryTalk Historian SE>System Explorer (64-bit).

. Microsoft Visual Studio 2010 4
. FactoryTalk Activation * | . Rockwell Software
» | . FactoryTalk Historian SE . Startup 4
Systemn Explorer (84-bit) .. FactoryTalk Tools | VMware 3
System Explorer . RSLinx ¥ | | Windows Accessories 4
. Uninstall FactoryTalk Historian Analysis Service FactoryTalk Administration Console . Windows System 4
. Uninstall FactoryTalk Historian Asset Framework || Desktop
Q PC settings
p Search
ﬁ Store

2. In the PI System Explorer, click File and choose Connections.

@]

File | Search View Go Tools Help

(@ Datsbase.. Ctrl+0 D & | QBack )
FE  Query Date...

Server Properties...

Connections...

H, Checkin  Ctrl+S
%) Undo Check Out
Load Library...

Save as Library...

%] New Model
ﬂ Mew Element

The Servers dialog box appears.

3. Right-click data collective (ASIHO1) and choose Properties.
Servers =0 -

) Add Asset Server % Add Data Server @ Connect @ Setas Default 5 Properties (@ Buffering Manager =
Fiter o |
Mame Host User Buffer Status Description Type [
: : L i Unknown Data Collective
WASIsol @ Add Data Server ! Asset Server f
' Add Asset Server
Disconnect
Switch Collective Member
@ Connect to Collective Member...
[#] Refresh
< > Remove.. | >
Buffer status updal %3 properties

The Properties dialog box appears.
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4. Rename or configure this connection as necessary for your system.

SIHO1A.System. PlantP Ax.local|

Connection Timeout: |10 | seconds
Data Timeout: |50 | seconds
D: [fos5a146-c100-4F1d-bda7-35eF12fe07ca |
Time Zone: |(uTc-08:00) Pacific Time (US & Canads) |
Version: [3.9.395.80 |
Alases: ASIHO1A

ASIHD1B

Lo | concel ][ oo

5. Click OK.

6. Right-click asset server (ASIS01) and choose Properties.

':'aAdd Asset Server @ Add Data Server @ Connect © Set as Default 4 Properties @Bm"fering Manager

[ Fiter o -
Mame Host User Buffer Status Description Type
WASIHM ASIHO1A.Sys... SYSTEM\Admi... Unknown Data Collective

| ASISO1 localhos - Asset Server

CVCTTRALA i

‘ Add Asset Server
':'-:I Add Data Server

Disconnect
Create Collective...
Refresh

< | > Remove.. |
Security...
#f  Properties

The Properties dialog box appears.

Buffer status update is complete.

7. Rename or conﬁgure thiS connection as necessary fOI‘ your systcm.

General |P|ug—1.ns | Libraries I Identities | Mappings I Counts |

Name: [asts01 | [ Rename |

Description: |

Host: ocahost ‘ Port: | 5457

Account: ‘ ‘ Timeout: |300

ID: ‘ b233bc67-6891-44ae-a333-25c751682750

Time Zone: ‘(UTC-OS:OO) Eastern Time (US & Canada)

Version: ‘Ser\rer:Z.?.S.?lﬁG; Database:2.7.5.7166

Alases: localhost

Extended Properties (0)  Security
Configure Active Directory Access for Contacts

ok [ cencel || ooy |

8. Click OK.
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Create Historian Tags by Using PlantPAx Configuration Tool

This procedure assumes that the controller, HMI server, and the alarm server
are configured for using the PlantPAx Configuration Tool. For tool
configuration procedures, see the documentation that is supplied with the tool.
The tool is contained in the download with the Rockwell Automation Library
of Process Objects.

1. Open the PlantPAx Configuration Tool.
2. Right-click Historian Servers and choose Add Historian Server.

ol PlantPAx Configuration Tools for Tat
File View Tools Windows Help

0=

=¥ Logix Controllers

—fﬂ LGXCO01

: 12| Associated HMI Application = PlantPA»
.-, FactoryTalk View SE Network

# HMI Server Name = PlantPAx_HMI
B HMI Server Area Name = Area

4y Data Server Area Name = Area/Dat
4y Data Server Name = PlantPAx_DAT

=M HMI Alarm Servers
=M PlantPAx_AES

Add Historian Server...

The Add Historian Server dialog box appears.
3. Type the name of the Historian server and click OK.

Add Historian Server -

Name: I Praduction Historian|| |

Description: | |

Cancel

The Select Controllers dialog box appears.
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4. Type the server or collective name and select applicable controllers.

Mame: Production Historian

Description:

FTLD Interface Number. ~ [1 |

Server or Collective Name: I ASIHO I

Point Source Name: |FTLD |

Select Controllers and Enter Data Server Information

Application Data Area Full Path Data Server Name Ez::‘;e Shoricut

Mame
LGXC01 PlantPAx Area/Data PlantPAx_DAT LGXCO1

Select Controller

FactoryTalk Application Name. Data Server Name and Device Shortcut Name must be provided when using FTLD point source.
Data Server Name is not required when point source is not FTLD.

The default data server name used by FactoryTalk is "RSLinx Enterprise”.

(Data Area Full Path example: "MorthPlant/Datal")

Click OK.

6. In the left pane, right-click the Historian server that you just created
(Production Historian in our example), and choose Import to Asset

Framework (AF) Database.

File View Tools Windows Help
0E ]

EIE Logix Controllers
=@ LGXco1
: Associated HMI Application = PlantPAs
® FactoryTalk View SE Network
B HMI Server Name = PlantPAx_HMI
B HMI Server Area Name = Area
I Data Server Area Name = Area/Dat
I Data Server Name = PlantPAx_DAT
-1y Data Server Device Shortcut Name
=4k HMI Alarm Servers
-4 PlantPAx_AES

Change Controllers Associated with Historian Server...

Rename Historian Server...

Remove Historian Server
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In the right pane, the Build Tags Setup window appears.
7. Click Connect.

Setup | Information | Build |
Pl Point Builder Options
Pl Server: Naot Connected
Options...
AF Server Naot Connected
AF Database Mot Connected i
Pl Point Builder Logix Data Type Definitions
| c 2 | Use the data types in the following controller to edit the definitions:
onnect.
[Lexcot v
‘ Definitions... ‘
Process Library Version
V4_0 W
PlantPAx Elements to Importto AF Database
ProcessTree v
8. Click OK twice.
Connect -
PlServer:  [ASIHDIA v OK Connected -

Connected to Pl Server ASIHOTA
AF Server: |A5|5ﬂ1 W | Connected to AF Server ASIS01
Connected to AF Database PlantPAx

AF Database: | PlantPx v]
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The Build Tags window reappears.
9. Click Options.

B

Pl Point Builder Options

Options...

Pl Point Builder Logix Data Type Definitions

Use the data types in the following controller to editthe definitions:

LGXCO1 v

Definitions...

Process Library Version

V4_0 v

PlantPAx Elements to Importto AF Database

|ProcessTree v|

Pt

The FactoryTalk Historian Import File Builder Options

dialog box appears.

FactoryTalk Historian Import File Builder Options

Naming |Version | Descriptors | Adjustments | Securityl Parameters | File Importl Tags |

Options for the Historian Data Point Name:

Include the controller name. Check the box ifthe same tag names are used in more than one controller - this will create ungiue Pl
Paoints for the controller tags: for example, "Controller1. TI123", "Controller2. TI123", etc.

Process Library Version

V4_0

CK

| | Cancel
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The option, if selected, adds the controller name as a prefix to Historian
tags. For example, LGXCO l.<tagname>.

For our example shown, the option is not checked. Therefore, the
controller prefix is not included in the Historian tag names.

10. Close the FactoryTalk Historian Import File Builder Options
dialog box.

11. In the right pane, click the Build Tags Information tab.

Setup Ilnfurmatmnl| Build |

State / Enumeration Sets |Temp|ates | Categories | Elements |
PAX Library State Sets File Name: C:\Program Files (x86)\Rockwell Automation\PlantPAx Configuration Tools for Tags, Alarms, Historian\PAxF THLibraryFiles\PAX_V4_0\W4_0_FTH_DigitalS
PAX Library State Sets: | v
Pl Server Digital State Sets AF Database Enumeration Sets
Digital State Sets: v Enumeration Sets
The following is a summary of comparsion ofthe library state sets and Pl Server state sets. The following is @ summary of comparsion of the librar
Sets that are notfound in the Pl Server are added on import Sets that are not found in the AF database are added
Sets that are differentwill be overwritten with the library sets on import. Sets that are differentwill be overwritten with the library
Double-click on a row to view the differences - if any. Double-click on a row to view the differences -if any.
Libray Set Name Different Not Found e Libray SetName Different Fde e
P_Aln_Val_Fault O = ound |-
P_Aln_Val_Sts O P_Aln_Val_Fault O
P_AOUt_Val_Fault 0 ATV L
P_AOut_Val_Sts O P_AQut_Val_Fault O
P_D4SD_Val_Fault O P_AOut_Val_Sts O
P_D45SD_Val_Sts | P_D4SD_Val_Fault 1
P_DBC_Val_Fault O P_D4SD_Val_Sts O
P_DBC_Val_Sts O P_DBC_Val_Fault O
S, — — hd P DAC Va| St [l bl v

Review the information.

12. Click the Build tab.

‘ Setup | Information IEulld I

Status:

I‘ Build

Abart Build

13. Click the Build button.
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14. Click OK.

‘ Setup | Informauon‘ Build ‘

Status:

000c2957dd44" ~
FIC01002

AFDatabase change event
Action="SubObjectChange'. |dentity='"Element’, UniquelD="242b3bb6-699b-11e8-80dc-000c2951dd44', ParentiD="242b3bb3-699b-11e8-80dc-

000c2951dd44"
Equipmentd1

Abort Build

\AFDatabase change event

Action="SubObjectChange', |dentity='"Element’, UniquelD="242b3bb3-699b-11e8-80dc-000c2951dd44', ParentiD="242b3bb0-699b-11e8-80dc-
000c2957dd44"

Areall

\AFDatabase change event
Action="SubObjectChange’, Identity="El d44', ParentiD="00000000-0000-0000-0000-

000000000000
Process0l Completed adding Logix elements to AFDatabase.

AFDatabase change event
Action='DirtyCleared'
PlantPAx

\AFDatabase change event

\Action="SubObjectChange’, Identity="Element', UniquelD="242b3bad-699b-11e8-80dc-000c2951dd44', ParentlD="00000000-0000-0000-0000-
000000000000

System

6/6/2018 11:06:11 AM Exited Adding AFElements to AFDatabase PlantPAx v

The build process completes.

| setup [ Information | Build |

Status

AFDatabase change event ~
Action='SubObjectRefresh’, Identity='"Element, UniquelD="242b3be3-699b-11e8-80dc-000c2951dd44', ParentiD="242b3bd7-699b-1128-80dc-
000c2951dd44'

TT03001

AFDatabase change event

Action="SubObjectRefresh’, Identity='"Element', UniquelD="242b3be8-699b-11e8-80dc-000c2951dd44', ParentD="242b3be6-699b-11e8-80dc-
000c2951dd44

FIC04002

Abort Build

AFDatabase change event

Action='SubObjectRefresh’. Identity='"Element’. UniquelD="242b3bec-699b-11e8-80dc-000c2951dd44', ParentD="242b3be6-699b-1126-80dc-
000c2951dd44’

FT04002

AFDatabase change event

Action='SubObjectRefresh’, Identity='"Element, UniquelD="242b3bef-699b-11e8-80dc-000c2951dd44', ParentiD="242b3be6-699b-118-80dc-
000c2951dd44'

MT04007

AFDatabase change event

Action="SubObjectRefresh’, Identity='"Element’, UniquelD="242b3bf2-699b-11e8-80dc-000c2951dd44', ParentiD="242b3be6-695b-11e8-80dc-
000c2951dd44

TT04001

6/6/2018 11:08:00 AM  Exit AddAFElementsToRoot.
Elapsed execution time = 00:00:02.2168705

15. Close the PlantPAx Configuration Tool.
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Verify Asset Framework Library and Elements

After using the PlantPAx Configuration Tool, you must verify that the Asset
Framework library and elements are properly imported into the Asset
Framework database.

1. To open the Asset Framework server, click Programs>Rockwell
Software>FactoryIalk Historian SE>System Explorer (64-bit).

. Microsoft Visual Studio 2010 4
| FactoryTalk Activation * | . Rockwell Software
» | . FactoryTalk Historian SE | Startup 4
Systemn Explorer (84-bit) . FactoryTalk Tools b VMware 3
System Explorer 1, RSLinx b | . Windows Accessories 4
. Uninstall FacteryTalk Historian Analysis Service [} FactoryTalk Administration Console 1 Windows System 4
. Uninstall FactoryTalk Historian Asset Framework || Desktop
ﬂ PC settings
p Search
ﬁ Store

The PI System Explorer window appears.
2. Click the Library folder.

File View Go Tools Help
@Database P Query Date -~ (© ﬁ' @Back ) |H, Checkln <} « [#]Refresh | @ New Template - |Searrh Element Templates O v|

BementTemplates

6 FlantPAx Group by: [| Category
- Templates o~
[ Element Templates
a Event Frame Templates A| Description Category Type @ -~

Model Templates Historian Fact... | Computer Element

i Transfer Templates
@) Enumeration Sets (& C_Interface_Perfmon |PI Perfmon Int... | Computer Element

'#, Reference Types (& C_Perfmon Standard Com... |Computer Element

=

Tables . (& C_Perfmon_ASAM AssetCentre C... |Computer Element

% Table Connections
- (] Categories (& C_Perfmon_ASIH Historian Com... |Computer Element

(€] Analysis Categories (& C_Perfmon_ASIS SQL Server Co... |Computer Element
Attribute Categories
(&) Element Categories

Reference Type Categories (& L_Shortcut R5Linx Enterpr... | Computer Element

Table Categories (& P_AIn Simple Analog ... |10 Processing Element
(R P_AInAdy Analog Input ... |IO Processing Element

() C_Perfmon_PASS PASS Compute, .. | Computer Element

(& P_AInDual Dual Analog In... | IO Processing Element
(& P_AInMulti Multi Analog In... | IO Processing Element

(f P_AInTest Simple Analog ... |10 Processing Element
(& P_AOUL Analog Qutput | IO Processing Element
(& P_D4SD Discrete Contr... |Valves Element

51 Hements (& P_DBC Deadband Con... |Regulatory Co... |Element

{—| Event Frames (& P_DIn Digital Input 10 Processing Element
(& P_DOUt Digital Output 10 Processing Element

(& P_Fanout Fanout Control  |Regulatory Co... |Element

(& P_HiLaSel High Low Selec... |Regulatory Co... |Element

el lead | en Cantral | Bracedural Cn Flamant

C_Interface_FTLD Modified:6/6/2018 11:06:01 AM.

3. Verify the contents of the library.
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4. Click Elements.

File  Search View Go Tools Help

aDat,abase [ Query Date - (@ G oBack [ ] E‘; Checkln <} « Refresh ‘3 New Element ~

Elements

Search Elements
FIC01002

5 Elements ‘l Child Elements I Attributes I Ports I Analyses I Version |
- (@ Process01
G Areadl

|[Fco1002

Desaription: |Flow Control 01002

Template: |P_P]DE

B

||| Default Attribute

Categories: |R.egulabory Contral

(J Equipment0d2 Extended Properties (0)  Annotations (0)
G Aread2 Find: Parents Children
- @ System Models
(£}, Element Searches

Security
Event Frames
Layers Connections

FIC01002 Modified:6/6/2018 11:06:11 AM. Version: 1/1/1970 12:00:00 AM, Revision 2

5. Verify the elements.

6. Close the PI System Explorer.
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Notes:
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Chapter 5

Configure I/0 Modules

The PlantPAx" system features flexible, intelligent I/O instrumentation to
maximize production and reduce downtime. This chapter describes
basic techniques for configuring plant-wide communication via I/O modules.

The ControlLogix" system is chassis-based and provides the option to
configure a control system that uses sequential, process, motion, drive control,
deterministic, and I/O capabilities. Ethernet remote I/O modules transmit
end device feedback to controllers. The data includes diagnostics, temperature
measurement, and counter-inputs for process control.

Procedures in this chapter describe how to configure the devices that are shown

in Figure 7.

Figure 7 - Example of PlantPAx Distributed 1/0 Modules

Supervisory Network
Control Network

1/0 Network

Safety Network
Trunk - (Native)
Management

Rockwell Automation Publication PROCES-UMO03C-EN-P - June 2019 133



Chapter5  Configure 1/0 Modules

Figure 8 contains the topics that are described in this chapter. Click or see the
page number for quick access to a section.

Figure 8 - 1/0 Infrastructure Workflow

Add Remote 1/0 Chassis

See page 135
« 1756 Analog Input Module
A 4 « 1756 Analog Output Module
Configure 1/0 Modules - 1756 Digital Input Module

« 1756 Digital Output Module

« 1756 Low-speed Counter Module
See page 133 « Process I/0 Linking Devices

« Motor Control Center Components

A

Configure Redundant 1/0 Modules

See page 169

F
Add a Stratix® Switch Connection

See page 174

Add Diagnostics

See page 177

See Chapter 6 Assign 1/0 and Diagnostics
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Add Remote I/0 Chassis

Use an Engineering Workstation
with these procedures.

EWS

This section describes how to add a remote I/O chassis and configure a ring

supervisor, if applicable. Make sure that the chassis size matches the installed
rack size.

Complete these steps in Logix Designer.

1.

In the I/O Configuration tree, right-click the remote I/O network
under the adapter and choose New Module.

Controller Organizer v I X

a o5

4 Controller LGXCO1
b1 Tasks
4 Motion Groups
Ungrouped Axes
b Assets
Y. Logical Model
pl 1/0 Configuration
4 B9 1756 Backplane, 1736-A7
[ [0] 1756-L75 LGXCO1
4 [ [1]1756-EN2T LGXCOTENDA
&= Ethernet
4 [ [211756-EN2T LGXCO1ENDIB
&= Ethernet
4 [ [4]1756-EN2TR LGXCOTEND2

H Mew Module..,

mport Module..,

Discover Modules...
&l Paste Ctrl+V

Print L4

2. In the Catalog tab of the Select Module Type dialog box, select a
network adapter and click Create.

Select Module Type

Catalog | Module Discovery | Favorites

|Eﬁ.-‘ff Search Text

For M

Tipe... | [ Clear Filters Hide Filiers 2

[=]  Module Type Category Fitters Module Type Vendor Fitters ~
[] CIP Mation Converter Advanced Energy Industries, Inc. l:‘
Communication Endress+Hauser
[ Communications FANUC CORPORATION
[ Communications Adapter o FANUC Robotics America o
= e & run e
<] m [T> <] m [T>
¥ (Catalog Mumber Description Vendar Category ~
1747-AENTR 1747 BEthemet Adapter, 2-Port, Twisted-Pair Media Roclkwell Autom...  Communication
£ 10100 Mbne Ft ge Fiher Madia leweall & o coomnication
100 Mbps Ethemet Bridge, Twisted-Pair Media  Rockwell Autom....
DO CNZ T oo [0/ U0 MDps Cihemet ondge, £-For, [Wisled-r...  nocrwel ALom...
1756-ENZTR 1756 10/100 Mbps Ethemet Bridge, 2-Port, Twisted-P...  Rockwell Autom... Communication
1756-ENZTSC 1756 10/100 Mbps Ethemet Bridge, Twisted-Pair Medi... Rockwell Autom... Communication | ™
< m >

142 of 548 Module Types Found

[[] Clese on Create
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3. On the New Module dialog box, type a module name and set an
IP address.

n New Module -

General® | Connection | Module Info | Intemet Protocol I Port Corfiguration I Time Sync |

Type: 1756-EN2T 1756 10100 Mbps Ethemet Bridge, Twisted-Pair Media

Vendor: Roclkwell Automation/Allen-Bradley

Parent: LGXCO1ENQ2 I Ethemet Address I

Name: [LoxcotEnD2R01 || O Pivate Network: 1921681, 0

Description: ~ (®) |P Address: | 172 018 . 2 .1
- O Host Name:

Module Definition

[oorse |

Revision: 10.001
Electronic Keying: Compatible Module
Rack Connection: Rack Optimization
Time Sync Connection: None
Chassis Size: 17
Status: Creating QK | | Cancel | | Help

4. Click Change.
5. On the Module Definition dialog box, do the following.

Module Definition*® -

Bevision: 10 W 001+%

Electronic Keying: Compatible Module

Rack Connection:
Time Sync Connection: I|Time Sync and Motion
Chassis Size:

(G ] [

a. See step 6 for the Rack Connection.

b. In the Time Synch Connection pull-down, select Time Synch
and Motion.

c. In the Chassis Size pull-down, select a value for the number of chassis
slots for this remote chassis.

d. Click OK.
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6. Ifyou use a rack connection as ‘Rack Optimization), make sure to
configure the proper Requested Packet Interval (RPI) under the
Connection tab.

If you are not using a rack option, you have to set an RPI for each device.

IMPORTANT  The option ‘Use Unicast Connection over EtherNet/IP’ defaults. For a
redundant controller, you must disable this option.

7. Click OK to change the module definition.
8. Click OK again to add the module.
9. To add additional network adapters, repeat step 1 through step 7.

See Configure I/O Modules on page 138 for how to add analog and
digital I/O modules.
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COnfigure | /o Modules A wide range of I/O modules can be used with smart devices and motors for

process control in the PlantPAx system. This section describes how to
configure analog and digital I/O modules.

Procedures in this section use preferred PlantPAx I/O network modules with
example settings for ControlLogix, HART, Process device, and motor
control modules.

Logix5000™ controllers can be configured with local and remote I/O modules

in multiple networks.

Figure 9 - Example of /0 Network Modules

For color legend, see page 133.

Primary Controller Secondary Controller

Control Network

1/0 Network

1715 Redundant I/0 ControlLogix® 1/0

ows

Field Devices
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ControlLogix analog I/0 modules are
interface modules that convert
analog signals to digital values for
inputs. Conversely, the modules
convert digital values to analog
signals for outputs. Controllers use
these signals for control purposes.

1756 Analog Input Module

After you create a Logix Designer application and add a communication

module to the project (see page 135), complete the following steps to create a
module in the project.

This procedure shows how to add an 8-channel isolated HART analog input
model to a 1756 ControlLogix controller.

1. In the Controller Organizer of a Logix Designer application, right-click
the remote I/O backplane and choose New Module.

Controller Organizer v I X

&l °s

P Controller LGXCO1
P Tasks
4 Motion Groups
Ungrouped Axes
P Assets
Y. Logical Model
pl 1/0 Configuration
4 B9 1756 Backplane, 1736-A7
[ [0] 1756-L75 LGXCO1
4 [ [1]1756-EN2T LGXCOTENDA
&= Ethernet
4 [ [2]1756-EN2T LGXCD1END1B
&= Ethernet
4 [ [4]1756-EN2TR LGXCOTEND2
4 £ Ethernet
f] 1736-EN2TR LGXCOTEND2
4 ] 1756-EN2T LGXCO1ENOZRO1

Discover Modules...

The Select Module Type dialog box appears.

Select Module Type

Catalog ||‘U'Iodule Discovery | Favortes

|Eﬁfﬁr565.rr>ﬁ Text for Modt DE.... | Clear Filters Hide Filters 2
[=]  Module Type Category Fitters ~ Module Type Vendor Fitters
Analog = Advanced Micro Controls Inc. (AMCI) =
[ Communication Hardy Process Solutions
[ Contraller Hiprom Technologies
[ Digital Molex Incorporated
i Bl e T T T AP YA Y v
< m > < m >
¥ (Catalog Mumber Description Vendar Category ~

1756-IF8H

‘I?SG—IFSIH Analog Input
Be-1H Lhannel Non-lsolated R 10 Analog Inpy Rockwell Autom Analog

1756-1R6I

Roclkowell Autom...  Analog

& Channel Isolated RTD Analog Input

Roclkowell Autom...  Analog
1756-IR T8I 8 Channel RTD/Themocouple Analog Input, |solated Rockwell Autom...  Analog hd
< m >
26 of 150 Module Types Found Add to Favorites
[[] Clese on Create | Create | | Close | | Help |
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The Analogbox is checked in our example so analog modules are our

selection choices in the middle of the dialog box.

You can also sort by vendor in the top right filter box.

A Logix Designer application also gives you an option to select available
modules when you are online in the system. The Module Discovery tab
lists modules that the Logix Designer application automatically detects

on the backplane.

3. Ifonline, select a module and click Create.

TIP  Ifyou are offline, in the Catalog tab of the Select Module Type dialog box,

select an analog module and click Create.

Select Module Type
| Favorites
Modules Revision Additional Information Action
1756 Backplane, 1756-A7
# [01] 17564F8IH 1.001 | Create
# 02117564832 3.006 Create
#) (03] 1756-EN2TR 10.010 Create
#1041 17560F8IH 1.001 Create
# [05] 1756-0F8H 2001 Create
# [06] 1756-DNEB 10.004 Create
The New Module dialog box appears.
L] New Module
General” | Connection | Module Info | Configuration I Alam I HART Device Info I Calibration
Type: 1756-IF8IH 8 Channel Isolated HART Analog Input
Vendor: Roclkwell Automation/Allen-Bradley
Parent: LGXCO1END2RO1
Name: LGXCO1ENDZRO1AIDT Slgt:
Description: -
W
Module Definition
Series: A
Revision: 1.001
Electronic Keying:  Compatible Module
Connection Data ~
Input Data Analog Only
Configure HART D... No "
Status: Creating QK | | Cancel | | Help

4. On the General tab, do these steps:
a. Type a name for the module.
b. Type a description for the module.

c. Select the slot number for the module.
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5. In the Module Definition box, click Change.

The Module Definition dialog appears.

Series:
Revision:

Electronic Keying:

Connection:

Module Definition*®

[onf?

Compatible Module
Data

Input Data:

Analog and HART by Channel

Configure HART Device(s):

es

Coordinated System Time:

T

Data Format:

Float

| Cancel | | Help

6. Complete the following actions.

Parameter

Action

Values

Connection

From the pull-down menu,
select a connection type.

Data - has more tabs on the
Module Properties dialog box
than Listen-only because of
configuration settings for alarms,
calibration.

Listen-only - has no
configuration data, does not send
output data.

Input Data

From the pull-down menu,
select a data input mode.

+ Analog Only

«Analog and HART PV

« Analog and HART by Channel
For details, see the ControlLogix
HART Analog 1/0 Modules User
Manual, publication 1756-UM533.

Configure HART Device

Select whether to enable the
Configure HART Device feature.
This feature is available only for
the 1756-IF8IH and 1756-0F8IH
modules when data format is
Analog and HART by Channel. If
you select Yes, a HART Command
tabis added to the configuration
dialog, in which you specify
configuration values to be sent

Values that can be added in the
HART Command tab are PV Damping
(seconds), PV Units, PV Upper
Range, PV Lower Range, PV Transfer
Function.

to the HART device.
Coordinated System Time Not configurable. Timestamped.
Data Format Not configurable. Float.

7. Click OK.

A warning message asks you to confirm changes to the module

definition.

8. Click Yes.

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019

M


http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1756-um533_-en-p.pdf

Chapter 5

Configure /0 Modules

142

9. Click the Connection tab.
(] New Module -

| Geneml|| Connection™ I'dodule Info™ I Configuration™ I HART Command™® I HART Device Info* | Calibration™

Requested Packet Interval (RPI):

Al ms(11.0-7500)
[ Inhibit Module
[ Major Fautt On Controller  Connection Fails While in Run Mode

Use Unicast Connection over BtherMet/IP

10. In the RPIbox, type a value to specify a time interval when the data is
sent to the controller.

IMPORTANT  AnRPIthat s set too fast can affect controller performance. We
suggest that you specify an RPI that is two times faster than task
execution or based on inherent properties of the signal being
measured. For example, a 250 ms task requires a 125 ms time, but
temperature measurements can be set slower as they are unlikely to
change that quickly.

11. Leave the default checkbox ‘Use Unicast Connection over EtherNet/IP’.

IMPORTANT  The Unicast checkbox must be disabled (no check mark) for a
redundant controller.

Enable HART Channel Data

Complete these steps to configure each channel for HART data.

1. Click the Configuration tab.
(] New Module -

| General® | Connection® | Module Infoi Corfiguration® '—IART Command® | HART Device Info™ | Calibration™

Channel
s |« s ] s8] 7|
Scaling
. High Signal: High Ehgineering: Input Fiange:
See Appendix A for NAMUR standard ( | 20.0000) mé = | 1000000 oo et
vaIuerangesdEpending on module. \[ Low Signal: Low Engineering: Diigital Filter: Ij: e
. | 4.0000) ma = | 0.0000]

Beal Time Sample (RTS): M55 e

[T R T

2. Check Enable HART for each applicable channel and click OK to

create the module.

We recommend that you Enable HART for any channel that has a
connected HART device. The information is displayed on the HART
Device Info tab and accessed by FactoryTalk® AssetCentre software.
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You can check Enable HART on channels that have HART field
devices attached.

3. Ifonline, reopen the module properties dialog box and click the HART
Command tab to specify HART device parameters for each channel.
These values are sent to the HART device.

4. Click ‘Enable HART Device PV Range Configuration (Command 35,
Command 47).

IMPORTANT  If you enable the HART device for a PV range, the functionality
provides a continuous update of the variables. The data is exposed
as tags in the /0 module. If you do not want a continuous update of
the variables, remove the check in the ‘Enable HART Device PV
Range Configuration’box.

| General I Connection I Module Info I Configuration | HART Command | HART Device Info* | Calibration

Channel

[l Enable HART Device P Damping Configuration (Command 34)

B Damping:

Enable HART Device P Range Configuration [Command 35, Command 47)

PV Units: € [ ]

P Upper Range: | 850.0000 |
P Lower Range: |-2UU.UUUU |
P Transfer Function: | Linear v |

P Damping, P Range and PY Transfer Function values are wiitten to the HART device
connected to the channel.

Status: Running | OK | | Cancel |

5. Setarange for the highest and lowest values for the PV in the specified
engineering units.

6. Click Apply.
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7. Click the HART Device Info tab.
8. Click Set Device Info.

The Set Device Info button is enabled when the controller is online.

| General I Connection I Module Info I Configuration I HART Commandl HART Device Info™ [:alibmtion |

Channel

v 1| 2| s | s¢]| 5| 8| 7| SetDewceInfo
Tag: TTO1001 Manufacturer 1D: Endress+H auger
Message: AREADT Device Type: TMT1E2
Device ID: 5573646
Descriptor: TEMP 01001 Final Azzembly Mumber. 0
Date: 14172010 Set Device Info -
“wiite Pratect: Mo
Tag: 'I'I'DIDDI
W
Upper Range Yalue: 850,00 T Message: ‘AREADI ‘
Lower Range Yalue:  -200.00 T
[ramping: 0.50 5 Descriptor: TEMP 0100 1|
| ———————— |
Transfer Function: Linear
[coprrrompevee | [_set_J}-
SW Urits: T
T Urits: T | oK | | Help |
P Unrits: Unknawn units : 0
Status: Running | 0K | | Cancel | | Apply | | Help |

9. Type a tag name, message, and descriptor for the HART device on the
selected channel and click Set.

This information is sent to and stored in the HART device.

10. Click OK.
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1756 Analog Output Module

This section describes how to enable output parameters for a 1756-OF8IH
analog module.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 139...142.

The example shows a naming convention for the 1756-OF8IH
analog module.

L] New Module -
General® | Connection | Module Info | Output State I Configuration I Limits I HART Device Info | Calibration |
Type: 1756-0F8IH 8 Channel |solated HART Analog Output
Vendor: Roclkwell Automation/Allen-Bradley
Parent: LGXCO1ENDZRO1
Name: I LGXCOTENDZRO1ACD| I Slat:
Description: -
v
Module Definition
Series: A
Revision: 1.001
Electronic Keying:  Compatible Module
Connection Data ~
Input Data Analog Only
Configure HART D... No "
Status: Creating QK | | Cancel | | Help

2. Click the Output State tab.
(] New Module -

| General® I Connection™ I Module Irrfo|| Output State™ I:anfigumtion' I HART Command* | HART Device Info™ | Calibration™ |

Channel
2 | s | 4 s & 7|
[]Bamp in Fun Mode
Fiamp Rate: 0.0000 /3
Output State in Program Mode Output State in Fault Mode
(®) Hold Last State (®) Hold Last State
(20 User Defined Yalus: 0.0000 (20 User Defined Yalus: 0.0000
Fiamp to Uzer Defined ¥ alue Fiamp to Uzer Defined ¥ alue
Communications Failure
‘wWhen communications Fail in (®) Leave outputs in Program Mode state
Program Mode: () Change outputs to Fault Mode state

The dialog box is divided into four sections:

e Ramp Rate
e Output State in Program Mode
e Output State in Fault Mode

o Communications Failure
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3. With an individual channel button selected, use the information in
Table 4 to configure the parameters.

Table 4 - Output Parameter Configuration

Select

Transitions

Ramp in Run Mode (Parameters

available in Hard Run mode)

Ramp Rate

Check the box and type a value to limit the speed at which an
analog output signal can change. This option helps prevent fast
transitions in output from damaging equipment that the
output controls.

Output State in Program Mode (

Parameters not available in Hard Run mode)

Hold Last State

Click to leave the current output at its last value.

User-Defined Value

(lick and type a specific value to use when the owner controller is
switched into Program mode. Value range is from
-9,999,999....99,999,999, default is 0.

Ramp to User-Defined Value

If Hold Last State — This field is disabled.

User-Defined Value — Check if you want the output to ramp to the
user-defined value at the specified ramp rate.

If unchecked, output signal steps to the User-Defined Value

immediately when you enter Program mode.

Output State in Fault Mode (Parameters not available in Hard Run mode)

Module enters Program mode state if the Connection from Logix is inhibited. If communication later fails,
all channels of the module remain in Program mode.

Hold Last State

(lick to leave the output signal at its last value.

User-Defined Value

Click and type a specific value to use if a fault occurs. Value range is
-9,999,999...99,999,999, default is 0.

Ramp to User-Defined Value

If Hold Last State — This field is disabled.

If User-Defined Value — You can check this option if you want the
output to ramp to the user-defined value at the specified ramp rate.

If unchecked, the output signal steps to the user-defined value

immediately when you enter Fault mode.

Communications Failure

If communication fails while in Run mode, the output signal goes to its Fault mode state. If
communication fails while in Program mode, the output signal behaves as follows.

Leave outputs in Program Mode
state

Click to leave output signal at the configured Program mode value

Change outputs to Fault Mode
state

Change output signal at configured Fault mode value if a
communication fails (connection from controller breaks).

Proceed to Enable HART Channel Data on page 147
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Enable HART Channel Data
Complete these steps to set up each channel for HART data.

1. Click the Configuration tab.
(] New Module -

| General® I Connection™ I Module Info™ I Qutput State|| Corfiguration™ |I-IART Command* | HART Device Info™ | Calibration™ |

Channel

Scaling

[dmsto20ma v
High Signal: High Engineering: Ltiotiki=ne=:
20.0000 mh = 100.0000 Sioreer Okt 0.0000

Low Signal: Low Engineering: [ Hold far Initialization
4.0000 mh = 0.0000

Keep HART Replies for: 15 : 3

Pazs through: | Once per bwo channels scanned W |

2. Check Enable HART for each applicable channel.

We recommend that you Enable HART for any channel that has a
connected HART device. The information is displayed on the HART
Device Info tab and accessed by FactoryTalk® AssetCentre software.

Click OK to create the module.

4. Ifonline, reopen the Module Properties dialog box and click the HART
Device Info tab.
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5. Click Set Device Info.

The Set Device Info button is enabled when the controller is online.

| General I Connection I Module Info I Qutput State I Configuration I HART Commanc'| HART Device Info I‘:alibmtion

Channel

0 1| 2] 3| & 5| & | 7| Set Device Info. .

Tag ovoi00z2 Manufacturer 1D: Metzo Automation

Message: AREA O Device Type: 229
Device [D: TB4723

Descriptor: WalWVE 01002 Final Azzembly Mumber. 0

Date: 1/15/2006 oL Set Device In ]
Diag

“wiite Pratect: Mo

W

Upper Range Value:  100.00 4 Message:

Lower Range Yalue:  0.00 4

[ramping: 0.00 3z pETrEE

Transfer Function: Mot Uszed

SW Urits: 4

TV Units: % [ o [ hep |

P Unrits: bar

Device Tag, Message or Descriptor do not match the values stored with

the project. Press "Set Device Info to update these values.

Status: Running | QK | | Cancel | Help

6. Type a tag name, message, and descriptor for the HART device on the
selected channel and click Set.

This information is sent to and stored in the HART device.

7. Click Set.

1756 Digital Input Module

This section focuses on how to configure individual points of the module for
On/Off detection and actuation.

Complete these steps.
ControlLogix Digital I/0 modules are
input/output modules that produce

information when needed by using 1. To name the module, select the chassis slot, and define the RPI,

the produce/consume model. repeat step 1 through step 11 on pages 139...142.

Digital modules also provide . .

additional system functions, such On the respective Select Module Type dialog box, choose a 1756-IB16D
as system Time Stamp of data and diagnostic module or a 1756-IB32/B module.

diagnostic detection.
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The diagnostic (‘D’) module has tabs for diagnostics output data
while the output module has only Output Data. The graphics are

examples only.

1756-1B16D 16 Point 10V-30V DC Diagnostic Input
Roclkwell Automation/Allen-Bradley
LGXCO1ENDZRO2

Type:

LGXCO1ENDZRO2DI0M

Module Defirition Type: 1756-1832/B 32 Point 10V-31.2V DC Input
Series: Vendor: Allen-Bradley
= Parent: LGHCO1ENDZRO2

3004 Name: LGXCOIEND2RO2DI0 | S

Compatible Module
Description:

Comm Format : Ilnpu‘t Data vI
Revision: Electronic Keying: |Compatible Keying v|

Revision:

Electronic Keying:

Connection Data

Status: Creating

[#] Open Module Properties

2. On the Connection tab, select an RPI and click OK.

) Connecti
Pairts Requested Packet Interval (RPI} nnecton
Diagnostics (ms}

over
EtherNet/IP

[ trhibit Module

[]Major Fault On Controller If Connection Fails While in Run Mode

Module Fault
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3. Click the Configuration tab.

IMPORTANT  Skip the next two steps if you are not using the Change of State
functionality.

4. Do one of the following in the Enable Change of State columns:

e To enable COS for point range, check the corresponding Off to On
or On to Off box.

e To disable COS for a point range, clear the corresponding Off to On
or On to Off box.

[ Mew Module -

- General” Configuration
- Connection®

Input Filter Time (ms}
Off -= On| On -= Off

00-07]1 w1 [¥)
08-15]1 w1 W

Points

hable Change of State for Diagnostic Transitions

5. Click OK.
6. Click the Points tab.
(] New Module -

- General” Points
i Connection”
- Module Info

Enable Change of State | Enable Diagnostics for Enable
Point %] Diag.

Off-=0n On-=0ff Open Wire Latching

0o
01

03
04

06
07

05
10

12
13

13 Y
13 Y
Kl<]&]&]<]<]&]]R]<]&]]<]R]]<]
Kl<]&]&]<]<]&]]R]<]&]]<]R]]<]

15

Status: Creating I QK I | Cancel | | Help
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7. Do one of the following in the Enable Change of State columns:

e To enable COS per point, check the corresponding Off to On or On
to Off box.

e To disable COS per point, clear the corresponding Off to On or On
to Off box

8. Click OK to create the module.

For more information, see the ControlLogix Digital I/O Modules User

Manual, publication 1756-UMO058.

1756 Digital Output Module

This section describes how to configure output states if the module goes into
Program mode or Fault mode.

Complete these steps.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 139...142.

On the respective Select Module Type dialog box, choose a
1756-OB16D diagnostic module or a 1756-OB32 module.
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The diagnostic (‘D’) module has tabs for diagnostics output data

while the output module has only output data. The graphics are
examples only.

General”
Connection
Module Info

Type: 1756-0B16D 16 Point 19.2V-30V DC Diagnostic Output
Roclkwell Automation/Allen-Bradley
Parent: LGXCO1ENDZRO2

Name: J[Lexco1Eno2R020001) | I Slat:

Description:

Module Definition

Series:

Revision: 3.003

Blectronic Keying: Compatible Module
Connection Data

Output Data Data

Module Info )
i Type: 1756-0B32 32 Point 10V-31.2V DC Output
i Configuration o

Vendor: Roclkwell Automation/Allen-Bradley
Parent: LGXCO1ENDZRO2

Name: |[Lexco1EnozRoz0002

Description:

Module Definition

Series:

Revision: 2.004

Blectronic Keying: Compatible Module
Connection Data

Output Data Data
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FPulse Test

2. After you define the RPI on the Connection tab, click the

Configuration Tab.

Qutput State During Enable Diagnostics for

Program Mode

Fault Mode Output Verify| No Load

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

Off

(838 Y
(838 Y
(838 Y

G

Failure

If communications fail in

Program Mode:

(®) Leave outputs in Program Mode state
(O Change outputs to Fault Mode state

] Qutput State During
Program Model Fault Mode

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

Off Off

G

i Failure

If communications fail in
Program Mode: (®) Leave outputs in Program Mode state

(O Change outputs to Fault Mode state

3. From the Program Mode pull-down menu, choose the module output

state during Program mode:
e On
o Off

o Hold (Retain current output state)
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The low-speed counter module is
used in Process applications to save
controller bandwidth. The module
can be used as a pulse totalizer

for flowmeters or a speed sensor

in conveyors.

4. From the Fault Mode pull-down menu, choose the module output state
during Fault mode:

e On
o Off

o Hold (Retain current output state)
5. Click OK.

For more information, see the ControlLogix Digital I/O Modules User
Manual, publication 1756-UMO058.

1756 Low-speed Counter Module

This section describes Configuration tabs so the counters can count pulses
from devices such as proximity switches and photoelectric sensors. The counts
are presented as an accumulated count or frequency.

Complete these steps.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 139...142.

On the respective Select Module Type dialog box, choose a
1756-LSC8XIBS8I module.

2. After you define the RPI on the Connection tab, click the
Configuration Tab.

You can associate hardware inputs of the module to the counters.

MNew Module -

| General” I Connection™ I Module Inf* Input Corfiguration ':ounter Configuration |

Hardware Input Ties

Up / Down Count Enable Reset Count Preset Count Counter Input Filter Time (ps)
Countet T:fpz? [ invert T:fpz? [ invert T:fpz? [ invert T:fpz? [ invert Counters Off-=0n On-=0ff
0 |Mone [w| [ |[None|w) [ [Wone w| [ [MNone ] [ 07 0z 03
1 |Mone [l [ |[None|w) [ [Wone w| [ [MNone|w] [
2 |Mone [w] [ [None|w| [ [MNone|w| [ [None W] [
3 |MNone |w) ; None |w| ; None |w| ; None |w| ; (i) Tied Counter Features are
4 |None |wf [ ] |[MNone |w|| [] |[MNone |w| [ ] |[MNone |w| [] also available in Output tag.
5 |MNone|[w| [ |[None|w) [ [Wone w| [ [None o] [ See Help.
6 |Mone [w] [ [None|w| [ |[MNone|w| [ [None W] [
7 |Mone [w] [ [None|w| [ [MNone|w] [ [None v

Hardware Input Filters

Input Point | "] Enable Fitter Input Filter Time (ps)
= Points
0 L Off-=0n | On-=0ff
1 L 07 0= =
2 L
3 L]
4 L]
5 L]
3 L]
7 L]
Status: Creating OK | | Cancel | | Help
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3. Select a counter to tie the counter control function to a standard
hardware input.

The state of the external input device controls the designated counter
4. Check Invert to change the input count direction, if applicable.
5. Use the pull-down menus to choose the desired input filter times.

6. Click the Counter Configuration tab.

Mew Module -

| General” I Connection” I Module Info I Input Configulatiorl Counter Corfiguration I

Counter

V) 1|2|3|4|5|6|?|

Calculate Average Frequency Qver: pulses
Frequency Calculation Timeout: aong ms ["]Enable Filter of this Counter

Fllter values for all counters

Window Defined In Off->0n 25ps, On->Off 50ps
0 Counts [¥)
1 Counts Y]

® Window OnjOff, Preset and Rollover values
are defined in Output tags for this module,

Counter
Input Input Tie
Configuration
Up !/ Down None
Count Enable None
Reset None
Preset None

Status: Creating | Cancel | | Help

7. Click a counter to configure frequency per pulses.

8. Click OK to create the module.

For more information, see the ControlLogix Low-speed Counter

Module User Manual, publication 1756-UMS536.
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These modules are referred to as linking
devices because they provide a gateway
between Ethernet and ControlNet
networks to FOUNDATION Fieldbus and
PROFIBUS PA networks.
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Process 1/0 Linking Devices

This section shows how to configure Fieldbus Foundation and PROFIBUS PA
linking devices to communicate field device information via Common
Industrial Protocol (CIP™) networks to a Logix controller.

Complete these steps.

1. Right-click the network of the remote I/O, and choose New Module.

2. On the respective Select Module Type dialog box, choose a
1788-EN2FFR (fieldbus) or 1788-EN2PAR (PROFIBUS) module.

3. Name the device and type an IP address.

n Module Properties: LGXCO1ENO2 (1788-EN2FFR 1.001) [=][=]E=
General |Connedion Module Info I Configuration I Intemet Protocol I Port Configuration I MNetwork |
Type: 1788-EN2FFR. Foundation Fieldbus Linking Device
Vendor: Hiprom Technologies
Parent: LGXCO1ENDZ I Ethernet Address I
MName: I LGXCO1ENDZFFO1 I O Private Network: 192.168.1. -
Description: ~ (®) 1P Address: | 172 . 18 . 2 . 2
- O Host Name:
Module Definition
Revision: 1.001
Electronic Keying: Compatible Module
Connection: Output
Status: Offine [ ok || cance | Anply Help

4. On the Connection tab, set the RPI value and click OK.
For more RPI information, see the Important on page 142.
Click OK.

6. In the Controller Organizer, double-click the linking device.
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The Module Properties dialog box appears.
7. Click the Configuration tab.

Controller Organizer v [8 Modute roperis Loxcorenez arssenzrrs oo« [

a o5

Controller Fauft Hand | General I Connection I Module Info | Corfiguration J intemet Protocol I Port Corfiguration I Network |
ontroller Fault Handler ~

s B onine O | B-a| Ba| o5

4 Motion Groups

b Asset A Overview E Prosonic-M A H
ssets B vaster (16) 00 XY “icoeinio11-so00451comel———cLive List

- b Status

Y. Logical Model
pl 1/0 Configuration
4 B9 1756 Backplane, 1736-A7
[ [0] 1756-L75 LGXCO1
b [1]1756-EN2T LGXCOTENDA
4 [ [2]1756-EN2T LGXCD1END1B
&= Ethernet
4 [ [4]1756-EN2TR LGXCOTEND2
4 £ Ethernet
f] 1736-EN2TR LGXCOTEND2
4 [ 1756-EN2T LGXCO1ENOZRO1
4 B9 1756 Backplane, 1736-A7
f] (0] 1756-EN2T LGXCO1ENOZRO1
f] [111756-IFBIH/A LGXCO1EMOZRO1AIOT
f] (4] 1756-OFBIH/A LGXCO1END2RD1ADDT
4 ] 1756-EN2T LGXCO1END2RD2
4 B9 1756 Backplane, 1736-A7
f] (0] 1756-EN2T LGXCO1END2RD2
f] [111756-1B16D LGXCO1ENO2RO2DIOT
f] (4] 1756-0B16D LGXCO1END2RO2DO01T
f] (5] 1756-0B32 LGXCO1EN02R02D0OD2
f] (6] 1756-LSCBXIBAI/A LGXCO1ENDZROZDIDI
f] 1788-ENZPAR/B LGXCD1ENOZPADT
fl PowerFlex 755-EENET LGXCO1ENOZMTO1001 v |jf| Status: Running ok | [ Canesl

Tz= Controller Organizer &E‘Logical Organizer

Controller Organizer v % [0 Mo propertes oxcorenoz rzss enzean 200 < [

a o5

Controller Fault Hand! | General I Connection | Module Info I Intemet Protocol I Port Corfiguration I Network | Corfiguration |
ontroller Fault Handler ~

Power-Up Handler Wersion 2.005

4 Tasks ED | " | " | o-l + | _'

Online

4 Motion Groups
b Assets
Y. Logical Model

00 n Wicropilot M 12

F) 1/0 Configuration 01 13
4 B9 1756 Backplane, 1736-A7
02 14
[ [0] 1756-L75 LGXCO1
b [1]1756-EN2T LGXCOTENDA 03 15
4 fJ [2]1756-EN2T LGXCO1END1B
@ Ethernet _ 04 16
4 [ [4]1756-EN2TR LGXCOTEND2
; 05 17
4 g Ethernet A Oscilloscope

f] 1736-EN2TR LGXCOTEND2 06 18
4 [ 1756-EN2T LGXCO1ENOZRO1

4 B3 1756 Backplane, 1756-A7 07 19
§ [0]1756-EN2T LGXCOTENOZRO1 = =
8 (1] 1756-IF8IH/A LGXCO1ENO2RO1AIOT
8 [4] 1756-OF2IH/A LGXCOTENO2ROTAO01 09 21
4 f] 1756-EN2T LGXCOTEND2R02 = =

4 B9 1756 Backplane, 1736-A7
f] (0] 1756-EN2T LGXCO1END2RD2 11 23
f] [111756-1B16D LGXCO1ENO2RO2DIOT
f] (4] 1756-0B16D LGXCO1END2RO2DO01T
f] (5] 1756-0B32 LGXCO1EN02R02D0OD2
f] (6] 1756-LSCBXIBAI/A LGXCO1ENDZROZDIDI
f] 1788-EN2FFR/B LGXCO1ENO2FFOT

1788-EN2PAR/B LGXCO1ENO2PADT

7l PowerFlex 755-EENET LGXCO1ENOZMTO1001 v | Status: Runring Cancel

Tz= Controller Organizer &E‘Logical Organizer
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Low-voltage motor control centers (MCC)
house starters, soft starters, and drives as an

alternative to wiring each device individually.

Simplified programming creates a single
network for complete machine control.

158

Once the linking device is connected to the controller, you can see the
linking device in the Configuration tab.

e Master green in the configuration tree = linking device is online

e Master gray in the configuration tree = linking device is offline

For more information, see the following documents:

e FEtherNet/IP™ and ControlNet® to FOUNDATION Fieldbus
Linking Devices User Manual, publication 1788-UM057

o EtherNet/IP and ControlNet to PROFIBUS PA Linking Devices
User Manual, publication 1788-UMO058

Motor Control Center Components

This section describes how to configure MCC components, including
PowerFlex® drive, SMC™, and overload relay examples.

IMPORTANT  This section shows how to configure the PowerFlex 755 drive. You can use
basically the same procedures for configuring other PowerFlex drives.

The Datalinks must be configured before using the respective PowerFlex
procedures. For Datalink information, see the following Rockwell
Automation® Library of Process Objects Add-On Instructions:

PowerFlex 755 (P_PF755), publication SYSLIB-RM040
«  PowerFlex 753 (P_PF753), publication SYSLIB-RM044

PowerFlex 755 Example
Complete these steps.

1. In the I/O Configuration tree, right-click the remote I/O network and
choose New Module.

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019


http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1788-um057_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1788-um058_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/syslib-rm040_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/syslib-rm044_-en-p.pdf

Configure [/0 Modules  Chapter 5

2. From the Select Module Type dialog box, select a PowerFlex 755 module
and click Create.

Catalog | Module Discovery | Favorites

| Eter Search Text for Module Tipe... Clear Filters

Module Type Vendor Fitters
Advanced Energy Industries, Inc.
Endress+Hauser

FANUC CORPORATION
FANUC Robotics America

FLIO P

Module Type Category Filters
DPlto Dual Port EtherNet/IP
DPlto EtherNet/IP

Drive

DSl to EtherNet/IP

r. . Plae doma.

JRIRIRIRIE]

-~

¥ (Catalog Mumber Description Vendor
PowerFlex 755 HiPwr-EN...  AC Drive Rockwell Autom....
P Fleq

PowerFlex 755-EENETC... PowerFlex 755 AC Drive via Embedded Ethemet - CIP ... Rockwell Autom...  Drive,Motion D

PowerFlex 755-EENETC... PowerFlex 755 AC Drive via Embedded Ethemet - CIP ... Rockwell Autom...  Safety,Drive Motid ¥
m

152 of 545 Module Types Found

[[] Clese on Create

3. Type a name and IP address for the drive.

General” |Conned.ion Module Info I Port Configuration I Drive: |

Type: PowerFlex 755-EEMET AC Drive

Vendor: Rockwell Automation/allen-Bradley
Parent: LGXCO1END2 I Ethernet Address I
Name: I LGXCO1ENO2MTO1001 I O Private Network: 192.168.1. |:|

Description: ~ @Paddess: | 172. 18 . 2 .31 |
e OHostuame: | |

Module Definition

Revision: 9,001

Electronic Keying: Compatible Module
Connection: Parameters via Datalinks
Data Format: Parameters

4. In the Module Definition section, click Change.
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The Module Definition dialog box appears.

Module Definition
Bewvision: | 9 v | | 1 v | Input Data Output Data ~
Electronic Keving: - DriveStatus LogicCommand
eEronc Leying: | Compatible Madule v | Feedback Reference
. . | Use Network Reference
Dirive R ating: |2DD‘V’ 4.8 ([MD] 4.8[HD)] V| F =
Fiating Options: | Mormal Duty b |
Special Types: | Compact b |
Selected Rating: 2000 4,84
Selected Catalog: 20iG..B4P8
L
DANGER: Unexpected, hazardous mation of machinery may ocour
when improperly uzing software to configure a drive.
. _ _ F. names selected for the Input and Dutput D ata appear az
|CU””9'31'U”3 |Parameter5 via Datalinks ﬂl member names in the drive Module-Defined Data Types and defines
|Data Format: |Parameter5 g| necessary Datalink parameters in the RS Logix 5000 project. Actual

If the revision of your drive is not listed:

- click Create Databaze... button below if drive is online.

- click ‘Web Update... to download the databaze from
the web if drive iz offline.

To match revizsion and upload the configuration of an online drive:
- click b atch Drive.

|Ereate Database...| | ‘wieb Update...

5. Click Match Drive.

data transfer between controller and drive iz determined by D atalink,
parameters,

“Y'ou mugt download configuration to the drive to enzure that the
controller, drive and communication module configurations are
cohsistent with each other.

QK | | Cancel | | Help

Indude IjO
Allow fast Upload

Full or Partial Match?

Partial Match is not supported on this drive. Please use full
to match the entire drive and all peripherals.

6. Click Full on the message window.

Autobrowse Fiefrezh

Connect To Drive

|§||a—E Browsing - node 172.18.2.33 found

== Workstation, EWS01
== Linxk Gateways, Ethernet
-2 AB_ETH-1, Ethernet

g g :

17218210 17218211

ﬂ 172.18.2.10, 1756-EN2TR, 1756-EN2TR/C
. ﬂ 172.18.2.11, 1756-EM2T, 1736-EN2T/D
ﬂ 172.18.2.12, 1756-EM2T, 1736-EN2T/D
B 172.18.2.21, 1788- ENZFFR, 1788- ENZFFR:'

] 17218233 SMC-50, SMC-50
------ g 172.18.2.34, E300 Overload Relay, E300 Over
EI -,5'?5 AB_ETHIP-1, Ethernet

Standart

1756-EN2T... 1756-EN2T/D

17218212 17218221
y 1756-EN2T/D 1788-EN2F...

9

17218222  172.18.2.31
1788-EM2... PowerFlex...

5 B

17218232 172.18.2.33
PowerFlex ... SMC-30

= v
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7. Select the drive and click OK.
8. Click OK to the message that the online action is successful.

The Module Definition dialog box reappears with the input datalinks
for the matching drive.

Module Definition -

Bewvision: | 9 v | | 1 v | Input Data Output Data ~
Electronic Keving: - DriveStatus LogicCommand
eEronc Leying: | Compatible Madule v | Feedback Reference
. . L/| Use Network Reference
Crive R ating: |24DV 42[ND) 4.2 [HD) TorqueCurFdbk i =
Fiating Options: | Mormal Duty OutputCurrent
OutputPower
Special Types: | Stamdard ElapsedMWH
ElapsedRunTime
SpeedUnits
Selected Rating: 2400 4,24 Prediaintst
Selected Catalog: 20G...B4P2 Startinhibits
DriveStatus2
L
P Pt
DANGER: Unexpected, hazardous mation of machinery may ocour
when improperly uzing software to configure a drive.

. _ _ Farameter names selected for the Input and Output D ata appear az
|C°””9d'9”3 |Parameter5 via Datalinks ﬂl member names in the drive Module-Defined Data Types and defines
|Data Format: |Parameter5 g| necessary Datalink parameters in the RS Logix 5000 project. Actual

. . X data transfer between controller and drive iz determined by D atalink,

If the: revizion of your drive is naot listed: parameters.

- click Create Database... button below if drive iz anline.

- click. W'e_b U_pda_te... ta download the database from “Y'ou mugt download configuration to the drive to enzure that the
the web if drive iz affline. controller, diive and communication module configurations are

. . . X . congistent with each other.
To match revizsion and upload the configuration of an online drive:
- click b atch Drive.

|Ereate Database...| | ‘wieb Update...

[owea | [

9. Click OK.
10. Click Yes to accept the module changes.
11. Click the Connection tab and set an RPI value.
12. Click OK to add the drive.

For more information, see the PowerFlex 750-Series AC Drives

Programming Manual, publication 750-PM001.

PowerFlex 525 Example

IMPORTANT  This section shows how to configure the PowerFlex 525 drive. You can use
basically the same procedures for configuring other PowerFlex drives.
The Datalinks must be configured before using the respective PowerFlex
procedures. For Datalink information, see the following Rockwell
Automation® Library of Process Objects Add-On Instruction:

« PowerFlex 523/525 (P_PF52x), publication SYSLIB-RM048

Complete these steps.

1. In the I/O Configuration tree, right-click the remote I/O network and
choose New Module.
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2. From the Select Module Type dialog box, select a PowerFlex 525 module
and click Create.

3. Type a name and IP address for the drive.
4. In the Module Definition section, click Change.
The Module Definition dialog box appears.

Output Data

LogicCommand

Network Start |s Used

FreqCommand

N k Ref Is Used

Disabled Disabled =

Disabled Disabled =

| Compatible Module Disabled Disabled =
Disabled _* | Disabled =]

O Display as Tag Members

Mode St

DANGER: U i jous motion of hinery may occur when
improperly using soft to configure a drive.

Parameter names selected for the Input and Output Data appear as
member names in the dnve Module-Defined Data Types and defines

v Datalink in the RSLogix 5000 project. Actual data
transfer bey ller and drive is d ined by Datalink

If the revision of your drive is not listed:

- click Create Database... button below if You must download configuration to the drive to ensure that the controller,
drive is online. drive and ication module confi jons are i with each
- click Web Update... to download the other.

database from the web if drive is offline.

‘web Update...

Match Drive oK || Cancel || Help

5. Click Match Drive.

EWS01!AB_ETH-1\172.18.2.32 | | Change
Upload the entire device? Offline configuration data will be overwritten by any uploaded data.

Upload Entire Device

6. Click Upload Entire Device.

7. Click OK after a review of possible changes to the module definition on
a popup window.

This upload/import could change the module definition for this device in the project. Those
differences are identified below.

Press OK to accept the changes per the checkboxes below.

Press Cancel to discard the entire upload.

v Device Changes Summary
v Network /O Configuration Differences Summary

v MNetwork Communications Differences Summary

Include Network I/O Configuration Settings
Include Network Communications Settings
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8. Click OK on the Module Definition dialog box.

Module Definition®
Dirive Rating Input Data Output Data
1P 110V 50HP - . LogicCommand
| [ DrivesStatus Network StartIs Used
Revision FreqgCommand
| 4 |v| . | 1 |v| ERRlkiey etwork Reference Iz Used
. X Fault 1 Code isabled -
Elecironic Keying Cutput Current isabled =
| Compatible Module | - | Output Power isabled -
Disabled isabled [

If the revision of your drive is not listed:

- click Create Database... button below if
drive is online.

- click Web Update... to download the
database from the web if drive is offline.

‘web Update...

l'\

O Display as Tag Members

Mode Scect. [Velogty 7]

DANGER: Unexpected hazardous motion of machinery may occur when
improperly using software to configure a drive.

Parameter names selected for the Input and Output Data appear as
member names in the drive Module-Defined Data Types and defines

y Datalink p in the RSLogix 5000 project. Actual data
transfer between controller and drive is determined by Datalink parameters.

You must download configuration to the drive to ensure that the controller,
drive and communication module configurations are consistent with each
other.

Cancel | | Help

9. Click Yes to accept the module changes.

10.
11.

Click the Connection tab and set an RPI value.

Click OK to add the drive.

For more information, see the PowerFlex 520-Series Adjustable

Frequency AC Drive Programming Manual, publication 520-UMO001.
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Smart Motor Controller (SMC-50) Example

Complete these steps to use a module that is designed to maximize the
efficiency of motor starts and stops.

IMPORTANT  This section shows how to configure the SMC™-50 smart starter. You can use
basically the same procedures for configuring other motor starters.

The Datalinks must be configured before using the respective SMC™
procedures. For Datalink information, see the following Rockwell
Automation Library of Process Objects Add-On Instructions:

SMC-50 (P_SM(50), publication SYSLIB-RM052
SMC™ Flex (P_SMCFlex), publication SYSLIB-RM053

1. In the I/O Configuration tree, right-click the remote I/O network and
choose New Module.

2. From the Select Module Type dialog box, select an SMC-50 module and
click Create.

Type a name and IP address for the motor controller.
4. In the Module Definition section, click Change.
The Module Definition dialog box appears.
5. Click Match Drive.
6. Click Upload Entire Device.

7. Click OK after a review of possible changes to the module definition on
a popup window.
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The Module Definition dialog box reappears with the input datalinks
for the matching drive.

Module Definition*® -

Revision: 4 v] [2 v ||[patatink | nput Data [butput Data
. . - LogicStatus | ogicCommand
Elechopieona: | Compatbls Module hd | PhaseACurrent otUsed

Use Network Reference
ndefined_A1

Dirive R ating: | Standard W |

[~ RealPower - 10 ™M

PowerFactor - 17 ndefined_AZ ™M

B MtrThermUsage - 18 ndefined_B1 ™M

TimetoOLTrip - 19 ndefined_B2 ™M

C TimetoOLReset - 20 ndefined_C1 ™M

Fault1 - 138 ndefined_C2 ™M

D Undefined_D1 ndefined_D1 ™M

Undefined_D2 ndefined_D2 ™M
|Cunnediun: |Parameter5 via Datalinks Ll
|Data Format: |Parameter5 g|

Sort Input/Output selection lists by Parameter Mame

DANGER: Unexpected, hazardous mation of machinery may ocour
when improperly uzing software to configure a drive.

Farameter names selected for the Input and Output D ata appear az
member names in the drive Module-Defined Data Types and defines
necessary Datalink parameters in the RSLogix 5000 project. Actual

data transfer between controller and drive iz determined by D atalink,
parameters,

If the revision of your drive is not listed:

- click Create Databaze... button below if drive is online.

- click ‘Web Update... to download the databaze from
the web if drive iz offline.

To match revizsion and upload the configuration of an online drive:

- tlick Matoh Drive. “Y'ou mugt download configuration to the drive to enzure that the

controller, diive and communication module configurations are
cohsistent with each other.

|Ereate Database...| | ‘wieb Update...

I QK I | Cancel | | Help

8. Click OK.

9. Click Yes to accept the module changes.
10. Click the Connection tab and set an RPI value.
11. Click OK to add the motor controller.

For more information, see the SMC-50 Solid-State Smart Motor
Controller User Manual, publication 150-UMO11.

E300™ Electronic Overload Relay Example

Complete these steps to add an overload relay that features a modular design
and diagnostic information for motor control applications.

IMPORTANT  This section shows how to configure the E300 overload relay. You can use
basically the same procedures for configuring other protection relays.

The Datalinks must be configured before using the respective SMC
procedures. For Datalink information, see the following Rockwell
Automation Library of Process Objects Add-On Instructions:

- E300 (P_E3000vld), publication SYSLIB-RMO051
« E1Plus (P_E1PlusE), publication SYSLIB-RM049
- E3/E3 Plus (P_E30vld), publication SYSLIB-RM050

1. In the I/O Configuration tree, right-click the remote I/O network and
choose New Module.
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2. From the Select Module Type dialog box, select an E300 relay module
and click Create.

Catalog | Module Discovery | Favorites

|5'1fer5'ea-'i:>‘: Text for Module Type... Clear Filters Hide Filters %

Module Type Vendor Fitters
Advanced Energy Industries, Inc.
Endress+Hauser

FANUC CORPORATION
FANUC Robotics America

FLIO P

Module Type Category Filters ~
MotorOveroad

MotorStarter

Other O

PowerFlex 750-Series via Embedded EtherNet/IP

[ [T>

JRIRIRIRIE]

-~

193-ECM-ETR E300 Blectronic Overoad Relay, 2-Port Roclkowell Autom....

<l

1 of 545 Module Types Found

[[] Clese on Create

3. Type a name and IP address for the drive.

- General” _

e Tope: 193ECMETR E300 Electionic Dveroad Relay, 2-Part

Control Corfiguration Wendor: Fockwell Automationdalen-Bradley
- Relay / Logic-Defined Datz~ Parent: LGXCOTEND2 I Ethemet AddrESSI

-~ Sensing Configuration Mame: LGXCOTENDZMT 0004 Private Metwark: 192.168.1
- Overload Protection A © e e - |:|

. Advanced Protection Description: ~ ® |P Address: | 172 .18 . 2 . M |
- Expansion Modules :
- DevicelLogix e ) Host Name: | |

- Intemet Protocol
- Port Configuration Module Definition
- Metwork .
5 g A
- Time Sync Fes

Revision: B.1

Electronic Keying:  Compatible Module Digital Module 1 Undefined Analog Module 1 Undefined

Conrection: Data Digital Module 22 Undefined Analog Module 2. Undefined

Configured By: Thiz Controller Digital Module 31 Undefined Analog Module 31 Undefined
Input D ata: All Data Digital Module 4. Undefined Analog Module 4 Undefined
Sensing Module: Hold-ESM-1G-304

Contral kodule: 193-E10-43120 Operator Station:  Undefined

Operating Mode: 2 [Dverload)

4. In the Module Definition section, click Change.
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The Module Definition dialog box appears.

LG 1EN02MTO1004
-,5‘?5 Expansion Bus
‘.- Digital Modules Revision:
Analog Modules
Operator Station Electronic Keying: Compatible Module W
Motor Control Operating Mode
nput Data Connection:

Series:

!

o
b
7
<

Configured By: This Controller
Input Data:

Sensing Module

All Data v

X¥X-ESM-IG-30A

0.5A-30A, Current & Ground Fault

El
E
<

£

193-E10-43-120

4 Point 110-120v AC Input, 3 Point Relay Output

=
=]
2
o <

5. Click Upload
6. Click OK on the popup window when the Upload completes.

@ Uploaded configuration from 193-ECM-ETR at 172.18.2.34.

7. Click OK again on the Module Definition dialog box.
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8. Click OK on the New Module dialog box.

- General” _

- Connection™
- Module Info®
[=1- Control Configuration™
- Relay / Logic-Defined Datz
o Cofiouction*® Full Load Current

Trip Class: EC

e Primary Full Load Current
+|- Expansion Modules™

- DevicelLogic® FLAL:

- Intemet Protocol™

- Port Configuration™

.. Metwor™

Alternate Full Load Current
o o0 7]

load Trip / ing

Enable Trip on Overload
[#] Include Overload Trip In History

Trip Limit:

["]Enable Warning on Overload

Indude Overload Warning In History

Warning Limit: % TCU

Reset Mode:

Reset Level:

For more information, see the Bulletin 193/592 E300 Overload Relay
User Manual, publication 193-UMO015.
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Configure Redundant I/0
Modules

The 1715 redundant I/0 platform offers
flexibility, with no special wiring, and no user
programming code or Add-On Instructions.
The redundant I/0 system requires less
engineering because no additional hardware
is required.

This section shows how to configure a 1715 redundant I/O system with a
remote I/O chassis on an EtherNet/IP network. Using a ControlLogix
controller, this redundant system provides fault tolerance with a redundant
adapter pair and multiple I/O modules for enhanced diagnostics.

1. To set up a network adapter, right-click an Ethernet bridge in the I/O
Configuration tree and choose New Module.

pl 1/0 Configuration
4 B9 1756 Backplane, 1736-A7
[ [0] 1756-L75 LGXCO1
b [1]1756-EN2T LGXCOTENDA
b f [2]1756-EN2T LGXCO1ENDIB
4 [ [4]1756-EN2TR LGXCOTEND2

H Mew Module..,

14 Import Module...
4 Discover Modules...
FFO1
Gl Paste Ctrl=V  PPAD1
) TENOZMTO1001
Print TENO2MT01002

ﬁ SMC-50-E LGXKCOTENOZMTO1003

2. On the Catalog tab, use the filter to select a 1715 Ethernet adapter and

click Create.

Select Module Type

Catalog | Module Discovery | Favorites

|Eﬁfﬁr565.r'r>h Text for Module Type... |

Clear Filters

Hide Filters %

[=]  Module Type Category Fitters
Analog

CIP Mation Converter
Communication
Communications

Module Type Vendor Fitters
Advanced Energy Industries, Inc.
Endress+Hauser

FANUC CORPORATION
FANUC Robotics America

FLIO P

~10&O0

Ethemet Adapter, Twisted-Pair Media
Ethemet Adapter, 2-Port, Twisted Pair Media
hemet Adapter, Twisted-Pair Media
2-Port, Twisted Pair Media

1715-AENTR 1715 Ethemet Adapter, Twisted Pair Media Rockwell Autom...  Commurication |

alniy s e e
Rockwell Autom....
Rockwell Autom....
Rockwell Autom....
Rockwell Autom...

e s
Communication
Communication
Communication
Communication

142 of 545 Module Types Found

[[] Clese on Create

Add to Favorites
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3. On the New Module dialog box, type a name for the adapter and set an
IP address.

General” |Conned.ion Module Info A | Module Info B | Intemet Protocol I Port Configuration I Network |

Type:

Revision:

Connection:
Redundant:
Chassis Size:

1715-AENTR. 1715 Ethernet Adapter, Twisted Pair Media

Rockwell A... IEihemet Address I
LGY.

LGXCO1END2RO3 O Private Network 192,168, 1 l:l

@® IP Address | 72,18, 2 .71 |

O Host name | |

Module Definition

Electronic Keying: Compatible Module

Module A Slot: 0 Module B Slot :

11

Data
Yes
26

Status: Creating

4. Click the Connection tab and select an RPI value.

| Generalf|| Connection” BModule Infa A | Module Info B | Intemet Protocol | Port Configuration | Network |

[ Inhibit Module

Module Fault

Bequested Packet Interval (RPI)

[ Major Fautt On Contraller  Connection Fails While in Run Mode:

[#] Use Unicast Connection over EtherNet/IP

ms (60.0 - 750.0)

5. Click OK to add the module.

6. Right-click the new 1715 adapter and select New Module.
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7. Select a 1715-IF16 analog input module, click Create, then name
the module.

8. Assign a slot number.

General™ |Conned.ion Module Info A I Module Info B | Configuration

Type: 1715-IF16 16 Channel Current Analog Input
Vendor: Rockwell Automation/allen-Bradley
Parent: LGXCO1ENO2RO3

Mame: I LGXCO1ENO2RO3AION] I Module A Slot: Module B Slot: 3

Description: -
b

Module Definition

Revision: 11
Electronic Keying: Compatible Module
Connection: Data ~
Input Data: Analog Only |E|
Data Format: Float

w

9. Click the Configuration tab to check the channel signals.
10. Click OK to add the module.

| General" | Connection | Module Info A | Module Info B | Corfiguration

Low Low High High

Signal = Engineering Signal = Engineering
0-20 mA 4.0 3 0.0 3 20.0 5 100.0 3
0-20 mA 4.0 3 0.0 3 20.0 5 100.0 3
0-20 mA 4.0 3 0.0 3 20.0 5 100.0 3
0-20 mA 4.0 3 0.0 3 20.0 5 100.0 3
0-20 mA 4.0 3 0.0 3 20.0 5 100.0 3
0-20 mA 4.0 3 0.0 3 20.0 5 100.0 3
0-20 mA 4.0 3 0.0 3 20.0 5 100.0 3
0-20 mA 4.0 3 0.0 3 20.0 5 100.0 3
0-20 mA 4.0 3 0.0 3 20.0 5 100.0 3

Channel| Current Range

=]

o =dfamfenfas oo fpaf—

Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019 m



Chapter 5

Configure /0 Modules

11.

output module.

General® |Conned.ion Module Info A I Module Info B I Configuration I Limits I Fault/Program Action

Type:
Vendor:
Parent:

Mame:

Description:

Revision:

Connection:
Input Data:
Data Format:

1715-0F&I 8 Channel Current Analog Output, Isclated
Rockwell Automation/allen-Bradley
LGXCO1ENO2RO3

Module Definition

Electronic Keying:

Module A Slot:

LGXCO1ENOZRO3A001

Module B Slot: 5

| General® I Connection | Module Info A | Module Info B | Configuration I Limits. | Fault/Program Action

Repeat step 7 through step 9 to create a 1715-OF8I analog

Fault Mode

Fault Value

Ramp to
Fault Value

Program Mode

Program Value

Ramp to
Program
Value

Program Mode
Communication
Failure
Output State

Hold last state

0.0

Hold last state

0.0

Program Mode

Hold last state

0.0

Hold last state

0.0

Program Mode

Hold last state

0.0

Hold last state

0.0

Program Mode

Hold last state

0.0

Hold last state

0.0

Program Mode

Hold last state

0.0

Hold last state

0.0

Program Mode

Hold last state

0.0

Hold last state

0.0

Program Mode

Status: Creating

Hold last state

0.0

Hold last state

0.0

Program Mode

el Bl el B S ) O R

Hold last state

0.0

Hold last state

0.0

Program Mode

Status: Creating

12. Click OK.

13. Repeat step 7 through step 9 to create a digital diagnostic
input (1715-IB16D) module.

General™ |Conned.ion Module Info A I Module Info B | Configuration

Type:
Vendor:
Parent:

Mame:

Description:

Revision:

Connection:
Redundant:

Module Definition

Electronic Keying:

1715-1B16D 16 Point 24V DC Diagnostic Input
Rockwell Automation/allen-Bradley
LGXCO1ENO2RO3

LGXCO1ENO2R030I01| W

[ General” | Connection | Module Info A | Module Info B | Corfiguration |

Enable Change of State

Off-=
On

On-=

Custom

=

Open Wire

B

off

Tt

Detecti

Reset
Latched &
Diagnostics

Compatible Module

Full

Edit...

Full

Edit...

Data

Full

Edit...

Yes

Full

Edit...

Full

Edit...

Full

Edit...

Full

Edit...

Full

Edit...

o~ fendfeofraf=lo

<]<&]<]<]=]]<

]&]&]<]<]<]<]=]

Full

]&]&]<]<]<]<]=]

Edit...

]&]&]<]<]<]<]=]

172

[+ Enable Change of State for Diagnostic Transitions

® Full and custom diagnostics require use of an appropriate end-of-ine device.
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14. Click OK to add the module.
15. Repeat step 7 through step 9 to create a digital diagnostic

output (1715-OB16DE) module.

n New Module
General® |Connection Module Info A I Module Info B I Configuration I Fault/Program Action
Type: 1715-0B&DE 8 Point 24V DC Diagnostic Output, Electronically Fused
Vendor: Rockwell Automationfallen-Bradley
Parent: LGXCO1ENO2RO3

Name: I LGXCO1ENOZR030001 I

Description: -
b

Module Definition

1.1 Change ..,

Revision:
Electronic Keying: Compatible Module
Connection: Data
Redundant: Yes
Status: Creating

I I Mew Module -

n
| General” I Connection | Module Info A | Module Info B I Configuration | Fault/Program Action
. Output State During
Point
Program Mode| Fault Mode
0 joff W | OFF ™M
1 |off MG [
2 |of [ ] off [
3 Jofr [ ] off [
4 |off [ ] off [
5 |ofr [ ] off [
6 |off [ ] off [
7 |of [ ] off [
Communications Failure —
If communications fail in (®) Leave outputs in Program Mode state
Program Mode: () Change outputs to Fault Mode state
Status: Creating I QK I | Cancel | | Help

16.

Click OK to add the module.
All 1715 I/O modules are added to the remote I/O chassis.

Controller Organizer * 0 X

a s

4 Centroller LGXCO1
4 Tasks
4 Maotion Groups
b Assets
T Logical Model
4 . 1/0 Configuration
4 B3 1756 Backplane, 1736-A7
[ [0] 1756-L75 LGXCO1
b8 [111756-EN2T LGXCOTENDTA
b 8 [2]1756-EN2T LGXCO1ENOTB
4 f [4]1736-EN2TR LGXCOTEND2
4 5 Ethernet
f] 1756-EN2TR LGXCO1ENDZ
b f] 1756-EN2T LGXCO1ENDZROT
b f] 1756-EN2T LGXCO1ENDZR02
4 B9 1715Redundant
B [011715-AENTR/A LGXCOTENO2RO3
f 1211715-IF16/A LGXCOTENO2ROZAIDT
f [411715-OF8I/A LGXCO1ENOZROZA0DT
f 161 1715-1B16D/A LGXCO1ENDZRO3DIDT
£ [8]1715-0B8DE/A LGXCOTENOZRO3DO0T

For more information, see the Redundant I/O System User Manual,

publication 1715-UMO001.
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Add a Stratix Switch (CIP)
Connection

174

IMPORTANT A CIP™VLAN must be enabled for the switch to perform the following steps.
To enable CIP, see Chapter 1 in the PlantPAx Distributed Control System
Infrastructure Configuration User Manual, publication PROCES-UMO001.

Complete these steps to configure a managed switch to leverage ports for
sending messages only to the device that needs or requests the communication.

1. Right-click on an Ethernet adapter and choose New Module.

Controller Organizer v I X
J 5

P Controller LGXCO1

P Tasks

P Motion Groups

P Assets

Y. Logical Model
pl 1/0 Configuration

4 B9 1756 Backplane, 1736-A7
[ [0] 1756-L75 LGXCO1
4 [ [1]1756-EN2T LGXCOTENDA

4 f [211736-EN B Mew Module...

&= Ethernet e
b [4]1756-EN2] Discover Modules...
Paste Ctrl+V
Print G

The Select Module Type dialog box appears.

2. Select a Stratix managed port adapter and click Create.

Select Module Type

Catalog | Module Discovery | Favorites

Hide Filters %

|Eﬁ.-‘ff Search Text for Module Type... |

Clear Filters

[=]  Module Type Category Fitters ~ Module Type Vendor Fitters ~
[ Analog Advanced Energy Industries, Inc.
[] CIP Mation Converter Endress+Hauser
Communication FANUC CORPORATION
[ Communications o FANUC Robotics America o
[ - S W R [ I == -
< m > < m >
¥ (Catalog Mumber Description Vendar Category ~
Communication

1783-BMS520CA

Stratix 5700 20 Port Managed Switch, Full FW
BIS200 ; i in=hi

Rockwell Autom....

JO0 20 p Map=0ed aiteh

Stratix 5700 20 Port M

Ry e a5/ 00 20 Fort Managed swiich, (aigant UpInks, ... - LOMMUNICENoN
1783-BMS20CL Stratix 5700 20 Port Managed Switch, Lite FW Roclkwell Autom...  Communication
1783-BMS4525GA Stratix 5700 6 Port Managed Switch, Gigabit Uplinks, a... Rockwell Autom...  Communication | ™

< m

142 of 545 Module Types Found Add to Favorites

[[] Clese on Create

= e

IMPORTANT  The Stratix 5410 is accessed via the Managed Ethernet Switch
category filter. Other switches are accessed by using the
(ommunication category type.
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3. On the New Module dialog box, type a module name and assign an

Bevision:

Electronic Keying:

ER

EomEatibIe todule

in interuption of connections to and through the switch.

Cancel | |

Help |

Cancel | | Help |

6. Confirm the password and click OK.
The New Module dialog box reappears.
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| Connection: I Data iﬂl
Data Connection Passwordl| geeeeesee
1| |! Password Confirmation
DAMGER. Connection Interuption.
£ l Y "Data” Connection Output Tag can disable ports, resulting

IP address.
New Module
- General® General
- Connection
- Module Info Type: 1783-BMS20CGN Stratix 5700 20 Port Managed Switch, Gigabit Uplinks, Full ...
- Fault/Program Action
. Switch Corfiguration Vendor: Rockwell Automation/allen-Bradley
- Switch Status Parent: LGXCOIENO 1A
- Port Configuration Name: I Swo20 I ) Private Network: 192.168.1. &
- Smartports and VLANs X
- Port Thresholds Description: ~ (®) [P Address: | 72 .18 . 1 . 200
- Port Security
- Port Status - () Host Name:
- D:evic:e Level Ring (DLR) Module Definition
= Ring 1

- Redundant Gateway Ci »

. Satistics Revision: 9,001

.DHCP Electronic Keying: Compatible Module

- Members Connection: Input Data
- DHCP Pools
- DHCP Address Assignment
- Time Sync Configuration
- Time Sync Information
- NAT
- EtherChannels
- 50 Flash Sync
- Save/Restore

4. Click Change and select a Connection type ‘Data’
5. Type a password and click OK on the Module Definition dialog box.
Module Definition® -
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- Port Configuration
- Smartports and VLANs

- Port Thresholds

- Port Security

- Port Status

- D_evic:e Level Ring (DLR)

- General
- Connection

- Module Info

- Ring 1

Redundant Gateway Ci
Statistics

DHCP

Members

- DHCP Pools

- DHCP Address Assignment
- Time Sync Configuration

- Time Sync Information

- NAT

- EtherChannels

- 50 Flash Sync

- Save/Restore

Switch Configuration

Internet Protocol [IP] Settings

(®) tanually Configure IP settings

7. To enable a redundant power supply, if applicable, click ‘Enable

Dual Power Supply Alarm’ on the switch configuration for the
module properties.

() Obtain IP settings automatically using DHCP

IP Settings Configuration

Physical Module IP Address:

Domain Mame:

Host Hame:

Administration

172 .

Subnet Mask:

285 0285 286 . 0

Gateway Address: 72 .18 .0 .1
o.o0.0.0
Secondary DMS Server Address: o. 0.0 .0

1m0

Frimary DMS Server Address:

Cortact:

Geographic
Location:

Management Interface WLAM:

Spanning Tree Mode:
(O Rapid Spanning Tree Protocol/Multiple Spanning Tree (RSTP/MST)

O Per¥LAN Spanning Tree Plus [FYST+)

~ (®) Rapid PerLAN Spanning Tree Plus [RFVST+)

<

I Enable Dual Power Supply Alarm I

501

@
T

Eefresh Communication 5

Repeat step 1 through step 7 to configure all of your system switches.

A list of switches appears in the Controller Organizer.

Controller Organizer v I X
J 5

P Controller LGXCO1

P Tasks

P Motion Groups

P Assets

Y. Logical Model
pl 1/0 Configuration

4 B9 1756 Backplane, 1736-A7
[ [0] 1756-L75 LGXCO1
4 [ [1]1756-EN2T LGXCOTENDA

f] 1756-EN2T LGXCO1ENOTA
& 1783-BMS20CGN 5W020
& 1783-BMS20CGN SW021
& 1783-BMS20CGN 5W022
& 1783-BMS20CGN 5W023
4 fJ [2]1756-EN2T LGXCO1END1B
&= Ethernet
b [4] 1756-EN2TR LGXCOTENO2

For more information, see the Stratix Managed Switches User Manual,

publication 1783-UMO007.
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Add Diagnostics

This section describes how to add diagnostics to an I/O module. Complete
these steps.

IMPORTANT  Controller Status is among nine predefined periodic tasks in the controller
template. A diagnostics folder is within the Controller Status periodic task.

1. In the Logical Organizer, open the Controller Task folder.

2. Right-click Diagnostics and choose Add>New Routine.

Logical Organizer

a

Fi

The New Routine dialog box appears.

Legical Model LGXC01
P Process01
4 Systemn

4 Add L4 Mew Program...
¥ cut Ctrl=x Mew Equipment Phase...
Mew Ec t Sec e,
oo &l copy T quipment Sequenc
Mew Folder...
b L TGl Paste Cirl=V W rorder
PoLT Paste Special ’I MNew Routine... I
P LT Delet Delet
b !:, Tl Elete Elete Mew Local Tag... Cirl+=W
[ !j T Verify Mew Parameter...
3 T C Ref Ctri+E
’ ;j i ross Reference Tl Import Brogram...
Browse Logic... Ctrl=L Import Equipment Phase...

Find in Controller Organizer

Online Edits

Import Equipment Sequence...

Import Routine...

IMPORTANT

For a remote rack, include one routine per rack. Each rungis to

contain one Module_Sts. For an MCC, include one routine for each

MCC device.

Mew Routine

Name: I LGXCO1ENDZ] _I

vll_l

Type: Ladder Diagram
=— la J

Assignment: | <none:

[]Open Routine

3. Type a routine name and click OK.
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Logical Organizer

&l o5

4. In the Diagnostics folder, double-click the LCPU routine to access a

» o [

4 Legical Model LGXC01
4 Process01
4 Systemn
4 L Diagnostics
4 Legic and Tags
L2 Parameters and Local Tags
ALUTENDZ
L Task_&_MainProgram
L Task_B_MainProgram
L Task_C_MainProgram
L Task_D_MainProgram
L Task_E_MainProgram
L Task_F_MainProgram
L Task_G_MainProgram
L Task_H_MainProgram

v v v W v v v

Logical Organizer

ladder logic.
el e m
A NS IR N N NS ] ey
G5V result:
Task class,
InhibitTask
attribute
GSV
Class Name TASK

Instance Name Task_H_10s

Aftribute Name  InhibitTask

Dest L_Taskinhibited[7]
O

= S\ | ] BL GBS | v 2] abe v | oy
G5V result:
Task' class, Logix Task Monitor
InhibitTask 1=Task is Inhibited,
attribute 0 = Task is Active
NEQ L_TaskMonitor[7]. 5ts_Taskinhibited
Source A L_Taskinhibited[7] L.
O
Source B o

JSR

Routine Name LGXCO1ENO2 —]

5. Click the last rung, type JSR and press Enter.

6. Click the routine name box inside the JSR command, and select the
routine name that you created.

7. Double-click the routine that you created to access a ladder logic.

4 Legical Model LGXC01
4 Process01
4 Systemn
4 L Diagnostics
4 Legic and Tags
<7 Parameters and Local Tags
| CP
L Task_A_MainProgram
L Task_B_MainProgram
L Task_C_MainProgram
L Task_D_MainProgram
L Task_E_MainProgram
L Task_F_MainProgram
L Task_G_MainProgram
L Task_H_MainProgram

178

s I

L3 G S 8 e S B N

abed 20 ab. v by

Accept Pending Rung Edits

BIEI

Cancel Pending Rung Edits

Libs | el ke I
¥ CutRung Ctrl+X
|j—.| Copy Rung Ctrl=C
&l Paste Ctrl+V
Delete Rung Delete
"% Add Rung Ctrl+R
Edit Rung
i e
Import Rungs... I
port Rungs...
Start Pending Rung Edits Ctrl=Shift+5

8. Right-click the rung and choose Import Rungs.
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9. Browse to the Process Strategies folder and select the Module Status

process strat

cgy.

10. Click Open.

& Import Rung -
- o i i m-
I= MName - Type Size ~
-i;“’f 2 (RA-LIB)PS_LVMCC_FVR_E3000vld_OpMode... Logix Designer XM... 674 KB
Recent places i (RA-LIB)PS_LVMCC_FVR_E3000vld_OpMode... Logix Designer XM... 674 KB
2 (RA-LIB)PS_LVMCC_PF525_with_HOA 4 0-0.. Logix Designer XM... 486 KB
- 2 (RA-LIB)PS_LVMCC_PF753_with_HOA 4 0-0... Logix Designer XM... 601 KB
Desktop 2 (RA-LIB)PS_LVMCC_PF755_with_HOA 4 0-0... Logix Designer XM... 395 KB
— = e
LiE)ra:lrliis 1 A ogix Designer AM...
23 (RA-LIB)PS_Motor_E1PlusE_4_0-00_ROUTINE... Logix Designer XM... 506 KB
[:«L....ﬁ 23 (RA-LIB)PS_Motor_E30vl_4_0-00_ROUTINE.L.. Logix Designer XM... 305 KB
This PC 2 (RA-LIB)PS_Motor_E3000vI_4_0-00_ROUTIN... Logix Designer XM... 636 KB
2 (RA-LIB)PS_Motor25pd_4_0-00_ROUTINELSX  Logix Designer XM... 451 KB
2 (RA-LIB)PS_Motor2Spd_E30vI_4_0-00_ROUTI... Logix Designer XM... 331 KB
I (RA-LIB)PS_Motor2Spd_E3000vI_4 0-00_RO.. Logix Designer XM... 632 KB
2 (RA-LIB)PS_MotorHO_4_0-00_ROUTINE.LSX Logix Designer XM... 261 KB
I (RA-LIB)PS_MotorHO_E1PlusE_4_0-00_ROUT... Logix Designer XM... 344 KB
2 (RA-LIB)PS_MotorHO_E30vI_4_0-00_ROUTI..  Logix Designer XM... 342 KB e
S ——
File name: | (RA-LIB)PS_ModuleSts_4_0-00_RUNG.L5X W | I Qpen I
N—
Fies oftype: | Logix Designer XML Fies (".L5X) v Cancel
Help

11.  On the Import Configuration dialog box, click the Find/Replace button
to replace the default module tag with your device.

Import Configurat

ion - (RA-LIB)PS_ModuleSts_4_0-00_RUNG.L5X

X% o] ] &a

Find Within: Final Name, Description

Import Content:

L, Diagnostics

Preserve existing tag values in offine project

Ready

Programs Configure Rung Properties

Imported Rungs: 1

|Creahe w | after Rung 0

(i) References will be imported as
configured in the References folders

LGXCO1ENDZ

= |

Find / Replace

P ——
[use wildcards

s LGXCO1ENO2 (Rungs)
- gm| References Operation:
|

BT <7 Tags

[Br] Add-On Instruction:

A\ d B Other Components

-[@ Errors/Warnings Routine Properties

MName:
Description:
Type:
In Program:

Direction: Oup @ Down

|:| Import Mame Final Name Description

|:| Alias For |:| Data Type |:| Parameter

Find What: ||"“'ODDDI v| Find Next

[ search current view only
Find Wit

[x]

| oK | | Cancel

Help

12. Click Replace AllL
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13. Repeat step 11 and step 12 to replace “TagDescript’ with your own
description (EtherNet/IP 02 is the example).
Find / Replace -
Find What: |TEQDESU ipt v | Find Next
Replace With: [[ Metwork 02 v
[use wildcards
e e ]
[ search current view only
Direction: Oup @ Down
Find Within:
|:| Import Mame Final Mame Description
[ Alias For [pata Type [lparameter
14. Click Replace All
15. Click Close, and then click OK to import the routine.
16. Repeat step 7 through step 15 for all modules in the I/O configuration.
Controller Organizer - I Diagnostics - LGXCO1ENO2R0Z < _

ontroller LGXCO1 ~

Tasks
Motion Groups
Assets
Y. Logical Model
1/0 Configuration
4 B9 1756 Backplane, 1736-A7
[ [0] 1756-L75 LGXCO1
b [1]1756-EN2T LGXCOTENDA
b f [2]1756-EN2T LGXCD1END1B
4 [ [4]1756-EN2TR LGXCOTEND2
4 £ Ethernet
f] 1736-EN2TR LGXCOTEND2
4 [ 1756-EN2T LGXCO1ENOZRO1
4 B9 1756 Backplane, 1736-A7
f] (0] 1756-EN2T LGXCO1ENOZRO1
f] [111756-IFBIH/A LGXCO1EMOZRO1AIOT
f] (4] 1756-OFBIH/A LGXCO1END2RD1ADDT
4 ] 1756-EN2T LGXCO1END2RD2
4 B9 17536 Backplane, 1736-A7
f 756-EN2T LGXCOT1END2R02
756-1B16D LGXCOTEMOZRO2DI0
756-0B160 LGXCO1END2R02DO0T
756-0B32 LGXCO1END2R02D0O02
756-L5CAXIBAI/A LGXCOTENDZRO2DI03
f] 1788-EN2FFR/B LGXCO1ENO2FFOT
f] 1788-ENZPAR/B LGXCO1ENO2ZPADT v
< m >

ATEE | TE Comtenll nmie@ EET Canteallar

< m >

Tz= Controller Organizer &E‘Logical Organizer

17.

180

5 S R R EE
TagDescript
L_ModuleSts
L_ModuleSts  LGXCO1ENOZR0Z_Module [.]
Ref_Module LGXCOMENOZROZ
TagDescript
L_ModuleSts
L_ModuleSts  LGXCO1ENOZRO02DI0_Module [.]
Ref_Module LGXCO1ENDZROZDI01
TagDescript
L_ModuleSts
L_ModuleSts  LGXCO1EN0ZR02D001_Module [.]
Ref_Module LGXCOM1ENOZROZDO01
TagDescript
L_ModuleSts
L_ModuleSts  LGXCO1EN0ZR02D002_Module [.]
Ref_Module LGXCOMENOZROZDO02
TagDescript
L_ModuleSts

L_ModuleSts LGXCO1END2RO2DI03_Module [

abed 20 ab. w

Sts_|OFault

Sts_|OFault

Sts_|OFault

Sts_|OFault

This example shows that the routine rungs align with the I/O tree
configuration.

Save your work.
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Assign 1/0 and Diagnostics

After you have defined your I/O modules and built the process strategies, you
must connect the I/O definition to a physical device. This chapter describes
how to assign the I/O tags.

When we assign I/O, we are creating a relationship between process strategies
and the device. The I/O module is connected to the tags of the process
strategy.

This chapter illustrates the following three program examples:
¢ Ananaloginput channel with diagnostics
e An MCC device that uses a COP instruction to transfer raw data

e Analog input tags assigned to connectors within a PID loop

Typically, you can use the basic analog input procedures in the first example to
assign I/O tags to devices. The other two examples have additional
requirements, such as the creation of programs and routines for drives because

of differing data types.
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Figure 10 contains the topics that are described in this chapter. Click or see
the page number for quick access to a section.

Figure 10 - Assign 1/0 Workflow

( Start )

r

Connect Analog Input Channel with Diagnostics

See page 183

Y
Connect an MCC Device

« (reate Routines
« Assign Diagnostics

See page 187

r

Connecta PID Loop

See page 197

Y

See Chapter 7 Configure Asset Management Tools
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Connect Ana'og |nput This section shows how to connect I/O to the analog input channel process
. . . PS_AlIn_Chan). Complete these steps.
Channel with Diagnostics surategy (PS_Aln_ P P
1. InaLogix Designer application, open an existing program.

2. Double-click Parameters and Local Tags under the Area01>Logic and
Tags folders.

Logical Organizer v I X

a o5

4 Legical Model LGXC01
Process01
4 L Areall

[ 8

B FICO1002

Big MTO1001

B TTO1001
P Systemn

[@EI Controller Organizer 7‘&,_ Logical Organizer

IMPORTANT  The first time that you perform this procedure, the Connections
column is not visible. Complete step 3 to show the Connections
column.

3. Click the Edit Tab (at the bottom of the screen), then right-click a

column header.

4. Click Toggle Column and choose Connections.

ey
Scope: | [y |trean v| Show: |A|| Tags

Name e = Type Description

Mame o » P
TTO1001] X Temperature 01001 - ...

Include Tag Members In Sorting
TT01001) Temperature 01001 - ...
TTotppr) ~ Hide Column Tewnccature 01001 - .
Toggle Column b »  Name
[ REVILY 1) ES—— e 001 - Netwo...
~ Usage
FTO1002_Inp_Raw_... BOOL i D2 - Process ...
Sequencing

FTO1002_Inp_Raw_... BOOL ~  Alias For D2 - Process ...
FT01002_Inp_Raw REAL | Base Tag D2 - Process ...
FICOT002_Out_CV_... BOOL| + DpataType atrol 01002 - ...
FICO1002_Out_CV_... BOOL| « Description atrol 01002 - ...
FICO1002_Out_CV REAL | + External Access atrol 01002 - ..

B FICO1002_CVIOFau... FBD_B + Constant

< L oastyle
I Connections I

The process strategy tags that appear in the Edit Tags tab
show connections.

See Build Process Strategies on page 32.
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5. In the Connections column, click the pull-down to display a list of
I/O tags for the Inp_Raw Process Strategy.

The tag names can be broken down into the remote module, slot
number, and 1/0 module.

| LGXCO1ENQO2 ROl‘: 1:‘I.ChO.Data|

T T
Remote I/0O Adapter 1/O Module Data

Slot Number
The first letter in the 1/0 Module Data represents the type of /0 the
tag is:
+ I=Input
«  0=0utput
«  (=C(onfiguration

a °F

Cantroller Organizer » 0 X

B
B
P
B

F]

Controller LGXCO1
Motion Groups

e Logical Model
1/0 Configuration
4 B3 1756 Backplane, 1736-A7
[@ [0] 1756-L75 LGXCO1
[ ﬂ [111756-EM2T LGXCO1ENDTA
[ ﬂ [2] 1756-EM2T LGXCO1ENDIE
4 f] [4]1756-EN2TR LGXCD1END2 Remote /0 Adapter
4 - Ethernet

4 fJ1756-EN2T LGXCOTENOZRO1

BB 1736-EN2T LGXCO1ENOZRO2

Bl 1756-EM2TR LGXCOTEND2

4 B3 1756 Backplane, 1736-A7
Bl [0] 1756-EN2T LGXCO1ENOZRO1T

AN T1Th 736 IF8IH/A LGXCO1ENDZROTAIDT
4] 1756-OF8IH/ Qo1
3 & ) — Slot Number

Bl 1788-EM2FFR/B LGXCOTEMORFFO1
Bl 1788-EN2PAR/E LGXCO1ENDZPAD!

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019



Assign I/0 and Diagnostics ~ Chapter 6

6. Click a data tag (LGXCO01ENO02RO01:1:1.Ch0.Data) in the example) to
place the tag in the Connections text box.

Local Process Strategy Tags ——Jmt

Scope: | [y |trean v| Show: |A|| Tags v ” T
Name -=|~ Connections + Usage Data Type Description
TT01001_Inp_Raw_ModFault Input BOOL Temperature 01001 - ...
TT01001_Inp_Raw_ChanFault Input BOOL Temperature 01001 - ...
TT01001_Inp_Raw GXCO1ENO2ROT:1:1.Ch.Dataz Input REAL Temperature 01001 - ...
MTO1001_Inp_IOFault T. |v| Show:|A" Tags v [P
FT01002_Inp_Raw_ModFault |Name == | Data Type Usage Descriptio | ~ ||
FTO1002_Inp_Raw_ChanFault f LGXCO1ENOZRO1: 1 UpdatedStatusReady  BOOL
FTO1002_Inp_Raw B LGXCOMENOZR01:1:1. AnalogGroupFault BOOL
FIC01002_Out_CV_ModFault A 4 LGXCOM1ENOZR01:1:1.ChD AB:1756 IF&
i LGXCO1ENO2R01:1:1.Ch0.Data REAL I
FIC01002_Out_ CV_ChanFault T T T T T T T -
FICO1002_Out_CV
¥] Show cortroller tags
b FICO1002_CVIOFault_Bor
v] Show Areal1 tags

Show parameters from other program:

| “none: v |

7. To place the tag in the Connections text box, click an I/O tag.

8. Repeat step 5 through step 7 to assign a Fault tag to the
Inp_Raw_ChanFault Process Strategy.

Lo

Scope: | [y |trean

v| Show: |A|| Tags v ” T
Name ==2|~ Connections + Usage Data Type Description
TT01001_Inp_Raw_ModFault Input BOOL Temperature 01001 - ...
TT01001_Inp_Raw_ChanFault LGXCD‘IENDZRD‘I:1:I.ChDFauIt:EInput BOOL Temperature 01001 - ...
TT01001_Inp_Raw | T. v | Show: |A|| Tags w [
MTO1001_Inp_IOFault |Name == | Data Type Usage Descriptio | ~ ||
FT01002_Inp_Raw_ModFault f b LGXCO1END2ROT:1:C AB:1756_IF2l.. <controllers
FT01002_Inp_Raw_ChanFault B 4 LGXCO1ENOZRO1:1: AB1TS6_IFEL.. <controller=
FTO1002_Inp_Raw i LGXCO1ENOZR01:1:1.ChannelFaults INT
LGXCO1ENO2R01:1:1.ChOFault BOOL
FIC01002_Out_CV_ModFault TCRCUTENO 20T e ot oo v

FIC01002_0Out_CV_ChanFault
FIC01002_0Out_CV
b FIC01002_CVIOFault_Bor

Show controller tags
Show Areall tags

Show parameters from other program:

| “none: v |

9. For the Module input fault (Inp_Raw_ModFault) Process Strategy,

select Diagnostics from the Show parameters from other program pull-
down.

["] Show controller tags

[] Show Areal1 tags

Show parameters from other program:
I Diagnostics Y] I
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10. Click the Connections pull-down and double-click an

I/O diagnostics tag.
3 o e oo e
Scope: | [y |trean v| Show: |NI Tags v || T.

Name =2|~ Connections + Usage Data Type Description
TT01001_Inp_Raw_ModFault Diagnostics.LGXCO1ENO2R01AINT_Module.Sts_|OFaults u nput BOOL Temperature 01001 - ...
TT01001_Inp_Raw_ChanFault | T v| Show:|N| Tags v| Temperature 01001 - ...
TT01001_Inp_Raw | T = | Data Type e | " Temperature 01001 - ...
MTO1001_Inp_lOFault b \Diagnostics LGXCO1ENDZR01_Module L_ModuleSts  Public T | Motor 01001 - Netwa...
FT01002_Inp_Raw_ModFault 4 \Diagnostics LGXCO1ENOZRO1AIN_Module L_ModuleSts  Public T Flow 01002 - Process ...
FTO1002_Inp_Raw_ChanFault ‘\Diagnostics. LGXCO1ENOZR01AI01_Module Enableln  BOOL T Flow 01002 - Process ..

\Diaanustics.LGXCEH EN0ZR01AI01 Module.EnableQut BOOL T
FT01002_Inp_Raw \Diagnostics.LGXCO1ENOZRI1AIN_Module Sts_IOFault BOOL T Flow 01002 - Process ..
FIC01002_0Out_CV_ModFault Flow Control 01002 - ...
Show controller tags
FIC01002_0Out_CV_ChanFault Flow Control 01002 - ...
FICO1002_0ut_CV Show Areall tags Flow Control 01002 - ...
b FIC0O1002_CVIOFault_Bor .
< | Diagnostics Y]

11. To view the connections, open the routine.

P_AlChan -]
TT01001_Chan LT L.
21.598312 21
TT01001_Inp_Raw Inp_Raw Val_lnpRaw » TT01001 .
< £1.2303 1L
Inp_ModFault Val Inp_PV Val
0 21.598312
Inp_ChanFault Srcl Inp_PVSrcQ Val_InpPV
1 1.50000000e+038
Sts_PVGood Val_HiHiLim
0 1.50000000e+038
Sts_PWUncertain Val_HiLim
0 0 -1.50000000e+033
TT01001_Inp_Raw_ModFault Sts_PVBad 0 Val_LoLim | E00000002-028
-1.8 e+038
Sts_Err Val_LoLoLim 0
Sts_Err

TT01001_Inp_Raw_ChanFault
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Connect an MCC Device

Drives typically have different data types. You can create a program with

specified input and output routines to send raw data to a compatible data type.

Complete the following steps.

1. InaLogix Designer application, open an existing program.

2. In the Controller Organizer, right-click a task and choose
Add>New Program.

Controller Organizer

a o5

P Controller LGXCO1
4 Tasks
4 @ Task_4_50ms
P4 Task_A_MainProgram
4 @ Task_B_100ms
P4 Task_B_MainProgram
4 @ Task_C_250ms
P4 Task_C_MainProgram
rl Task_D_SOOms

b L Task_D_Ma Add MNew Program...

P Motion Groups
4 Assets

The New Program dialog box appears.

3. Typea program input name.

P4 Areall _— f— New Equipment Phase...
Lu C +A
4 GSTESlfr_E_:SE Vo ol Copy Ctrl=C Mew Equipment Sequence...
b Task E_Mai e R Import Program...
“ ®T35k‘F‘25 e e Import Equipment Phase
b L Task_F_Mai Paste Special 4 P auip
4 @Task_G_Ss Delete Delete Import Equipment Sequence...
P4 Task_G_Ma
4 @ Task_H_10s Cross Reference Ctrl+E
P4 Task H_Ma Print »
b (B _Controller_Sta
Unscheduled Properties Alt+Enter

Our example (EtherNetIP_Inputs_D) has an _D because we created our

program from the Task_D_500ms folder. When you create programs
from different tasks add an _x, with ‘x’ to denote the letter of the

selected Task folder.

For example, EtherNetIP_Inputs_C if this routine were to be used in the

Task_C_250ms task.
4. Click OK.

Mew Program -
Name: EtherMet|P_Inputs_D

Description: N
| e
Parent: |:n0ne> Y] |
[] Use as folder
Schedule in: | @ Task_D_500ms Y] |

[ Inhibit program

Synchronize redundancy data after execution

["] Open properties
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5. Repeat step 2 through step 4 and type a program output name.

Mew Program
Name: IEtherNetIP_Outputs_D| |
Description: N
| e
Parent: |:n0ne> Y] |
[] Use as folder
Schedulein: | @ Task_D_500ms v|
[ Inhibit program
Synchronize redundancy data after execution
["] Open properties

6. To organize programs within a task, right-click the Task in the
Controller Organizer and choose Properties.

The Task Properties dialog box appears.
7. Click the Program/Phase Schedule tab.

Unscheduled:

& Task Properties - Task_D_500ms
Program Schedue" | Monitor

Scheduled:

Areall
EtherMet|P_Outputs_D

Task_D_MainProgram
EtherNet|P Inputs [

™)

Move

<— Remove

~ o | e |[

[ e |

8. Click a program that you want to move and click the Up or Down
arrows to move the program. Position the programs in the following
execution order (top to bottom):

Input— Process Strategies—» Output

9. Click OK.
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10. Click the Logical Organizer tab and drag-and-drop the Inputs and
Outputs programs into the System folder.

Logical Organizer

a o5

* 0 x

4 Legical Model LGXCO1
L EtherMetlP_Inputs_
L EtherMetlP_Outputs D
Process01
4 L Areall
4 Legic and Tags
<7 Parameters and Lfcal Tags
@ MainRoutine
B FICO1002
Big MTO1001
B TTO1001

[ 8

P L Diagnostics

P4 Task_A_MainProgram
P4 Task_B_MainProgram
P4 Task_C_MainProgram
P4 Task_D_MainProgram
P4 Task_E_MainProgram
P4 Task_F_MainProgram
P4 Task_G_MainProgram
P4 Task_H_MainProgram

11. Save your work.

Logical Organizer

&l °s

4 Legical Model LGXC01
4 Process01
4 L Areall
4 Legic and Tags

<7 Parameters and Local Tags
@ MainRoutine
B FICO1002
Big MTO1001
B TTO1001

=
P L Diagnostics
P4 Task_A_MainProgram
P4 Task_B_MainProgram
P4 Task_C_MainProgram
P4 Task_D_MainProgram
P4 Task_E_MainProgram
P4 Task_F_MainProgram
P4 Task_G_MainProgram
bt Task H MainBroaran_
L EtherMetlP_Inputs_D
L EtherMetlP_Outputs D
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Create Routines

Complete the steps to create routines for the programs.

1. On the Logical Organizer, right-click a Program and choose
Add>New Routine.

Logical Organizer v I X

a o5

4 Legical Model LGXC01
4 Process01
4 Systemn
P L Diagnostics
P4 Task_A_MainProgram
P4 Task_B_MainProgram
P4 Task_C_MainProgram
P4 Task_D_MainProgram
P4 Task_E_MainProgram
P4 Task_F_MainProgram
P4 Task_G_MainProgram
P4 Task_H_MainProgram

% EtherMetlP Inputs D

L EtherMetlP Add 4 Mew Program...
¥ cut Ctrl=x Mew Equipment Phase...
|:T-| T Ctrl=C Mew Equipment Sequence..,
Mew Folder...
5 Paste Cirl=V e Folder
Paste Special 'I Mew Routine.., I
Delet Delet
Elete Elete 0 Mew Local Tag... Cirl+=W
Verify Mew Parameter...
Cross Reference Ctrl+E

Import Program..,

The New Routine dialog box appears.

2. Type ‘MainRoutine’ (for a jump to subroutine) and select
"EthernetIP_Inputs_D" in the pull-down for In Program or Phase.

Mew Routine -

Ladder Diagram Y] |

In P
E:' thags':'r' I L EtherNet|P_lnputs_D I v|
Assignment: | <none:
[]Open Routine
3. Click OK.
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4. Repeat step 1 and step 2 for an EtherNetIP Inputs routine name.

We suggest that you create one routine for each network. This routine
can contain all network adapters owned by this communication adapter.

Mew Routine -

Mame: LGXCO1ENDZ| _OK
Description: = —
W
Type: | Ladder Diagram v| Help
In Program
or Phase: | b EtherNetIP_Inputs_D v|

Assignment: | <none:

[]Open Routine

5. In the Logical Organizer, right-click the EtherNetIP program name
and choose Properties.

Logical Organizer v I X
J 5

4 Legical Model LGXC01
4 Process01
4 Systemn

L Diagnostics

;j :z:‘g‘m:;::s:::: of Program Properties - EtherMNetIP_Inputs_D -

L Task_C_MainProgram Generalj] Configuration™ BParameters | Monitor

L Task_D_MainProgram
L Task_E_MainProgram Assigned routines:
L Task_F_MainProgram Main:
L Task_G_MainProgram
L Task_H_MainProgram Fault:

4 % EtherMetlP Inputs D

4 Add 3

v T v VW v v v v

“none: v

[ Inhibit program

Synchronize redundancy data after execution
¥ cut Ctrl=+X

] copy Ctrl+C

L § 4] Paste Ctrl=V
Paste Special L4

Delete Delete

Verify

Cross Reference Ctrl+E

Browse Logic... Ctrl=L

Find in Controller Crganizer / I OK I| Cancel | | Aoply | | Help

Online Edits L4

Print L4

Export Program...

[@3 Controller
Properties

E‘Search (21—

6. On the Connection tab, select MainRoutine from the pull-down menu.
7. Click OK.
8. Repeat step 1 and step 2 for an EtherNetIP Outputs routine name.
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Logical Organizer

x

9.

In the Logical Organizer, double-click MainRoutine of the

Input Program.

P Logical Model LGXCO1
3 Process0l
Pl System
L Diagnostics
L Task A _MainProgram
L Task_B_MainProgram
L Task_C_MainProgram
L Task_D_MainProgram
L Task E MainProgram
L Task F_MainProgram
L Task_G_MainProgram
L Task H_MainProgram
L EtherMetlP_Inputs D
4 Logic and Tags
<7 Parameters and Local Tags
& MainReutine
LGXCO1EMD2
4 L EtherMetlP_Outputs D
4 Logic and Tags
<7 Parameters and Local Tags
& MainRoutine
LGXCO1EMD2

AT T T TTT T T W

es ey
—

L7 ks 5 B Q&

abed | 2% b v by

JSR
Routine Mame LGXCO1EN02Z

mzl Controller Organizer [T ReU LI

192

10.

11.

12.
13.

14.

15.
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Double-click a rung, type JSR, and press Enter.

An instruction that is named 'JSR' is shown in the rung.

In the instruction, select the Routine Name that you created in step 2
(MainRoutine in the example) from the pull-down list.

Repeat step 10 and step 11 for EtherNetIP_Outputs.
Under EtherNetIP_Inputs, open the LGXCO01ENO2 routine,

double-click the first rung, and type COP.

Press Enter.

A Copy instruction transfers raw data only and ignores data types. The
instruction lets you use a compatible data type to connect the tags.

In the instruction, click the Source pull-down arrow to select a drive

input from the list.
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Logical Organizer

16. In the instruction, click the Destination pull-down arrow and select a
destination data tag (for example, MT01001_Inp).

For MCC components, select the drive input that is created when
importing process strategies for drives.

L& b= (ST 1= [ e o T S T U TSR TS
4 Logical Model LGXCO1 | Wotor 01001 - PFTSS N
4 Processii Hetwork Input
] System
b L Diagnostics [x] Source LGXCO1ENOZMTO1001:
b4 Task_A_MainProgram | !:E'Et. WMTO1001_Inp v
b 4 Task_B_MainProgram | T. v| 5h0W2|NI Tags v
b 4 Task_C_MainProgram
b 4 Task_D_MainProgram | - ~
b 4 Task_E_MainProgram B » MTO1001_Inp P_PF7S5_Inp  <controller=
b4 Task_F_MainProgram ‘ 4 —n P =controller=
b 4 Task_G_MainProgram B » MTOT001_Out P_PF7S5_Out  =controller= M
b 4 Task_H_MainProgram B » MTO1001_RevPerm P_Perm <controller= M
4 L EtherMetlP_Inputs_D B » MTO1001_RunTime P_RunTime <controller= M
“ Logic and Tags [w#] Show controller tags
<7 Parameters and Local Tags
@ MainRoutine [+] Show EtherNetIP_Inputs_D tags
LGXCO1END2
4 Y EtherMetlP_Outputs_D Show parameters from other program:
F] Legic and Tags |Areaﬂ1 v
<7 Parameters and Local Tags
o MainRoutine
LGXCO1END2
v
1 4
The destination data tag appears in the COP instruction.
. . 1 1
17. In the instruction, type a Length of '1"
6 Logix Designer - LGXC01 [1756-L75 31.1]* o O =
% FILE EDIT WIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP
Ll © = AR N R NG | v] € 2l e e || Do o 2 02| R G
B Run Mode P
= Controllr OK 7 Peth: A ETHIP-11172.18. 1. 100 Backplane o O I R = B =T S S S 1 e S
: Emswageob( Rem Run E! Mo Forces }' No Edits av Redundancy |o! g 1) ‘Favorites  Adg-On  Alarms Bt  Timer/Counter Input/Output ~ Compare

Logical Organizer

EtherMetlP_In - MainRoutine*

& & e = G E

abd | 207 ab. v daby

4 Logical Model LGXCO1
14 Process01
4 System
L, Diagnostics
L Task A MainProgram
L Task B_MainProgram
L Task_C MainProgram
L Task D_MainProgram
L, Task E MainProgram
L Task F_MainProgram
L Task_G_MainProgram
L Task_H_MainProgram
L EtherMetlP_Inputs D
P Logic and Tags
<7 Parameters and Local Tags
MainRoutine
LGXCO1END2
4 1 EtherNetlP_Outputs D
P Logic and Tags
<7 Parameters and Local Tags
MainRoutine
LGXCO1END2

AT VT T T T T T T

[@EI Controller Organizer EIIReELE

Eﬂearch Results '.".'atch

Ready

Motor 01001 - PFT55
Network Input
cop
Source LGXCO1ENOZMTO1001:1
Dest MTO1001_Inp
Length 1

Communication Software: R5Linx Classic Rung 0 of 1

Rockwell Automation Publication PROCES-UM003C-EN-P - June 2019 193



Chapter6 Assign /0 and Diagnostics

18. Repeat step 13 through step 17 to tie the EtherNetIP_Outputs tag to
the I/0.

IMPORTANT  Observe that the Source and Destination are opposite for the COP

output instruction.
@ Logix Designer - LGXCOT [1756-L75 31.1]* - 0O =
2 OFILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP
Dok & ¥ R V)% % B e s

B Run Mode P

9 Controlier DK a Path: AB_ETHIP-1\172. 18.1.100\Backplane D o= A
I Energy Storage OK

¥ m 1/0 OK Rem Run ﬂ! No Forces . Mo Edits 2. | Redundancy

H A 4 £r U A
}-Favor\tes Add-On  Alarms Bt Timer/Counter Input'Output  Compare

Logical Organizer v & X [H EtherNetiP_inputs_D - MainRoutine EtherNetlP_Outputs_D - LGXCO1ENOZ* X -
fe e eq 17 L2 2 B st B ab. v s
Pl Logical Model LGXCO1 COP "N
B Process01 Source MT01001_Out
4 [ System Dest LGXCO1ENOZMTO1001:0
L, Diagnostics LETLT L

L Task A _MainProgram
L Task B_MainProgram
L Task C_MainProgram
L Task D_MainProgram
L Task E MainProgram
L Task F_MainProgram
L Task G_MainProgram
L Task H_MainProgram
L EtherNetlP_Inputs D
4 Logic and Tags
<7 Parameters and Local Tags
@ MainRoutine
LGXCO1ENDZ
4 L EtherMetlP_Outputs D
4 Logic and Tags
<7 Parameters and Local Tags
@ MainRoutine
LGXCO1ENDZ

LT T T T TTTT W

@EI Controller Organizer [IMhle RelELIEY

E‘Eearch Results '."."atch

Ready

Communication Software: R5Linx Classic Rung 0 of 1

19. Ifonline, click the Finalize All Edits in Program w icon.

IMPORTANT  You must finalize EtherNetIP_Inputs, EtherNetIP_Outputs, and
Process Strategies.

The Finalize all edits in program window appears.
20. Click OK to finalize edits in all programs.

21. Save the program.
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Assign Diagnostics

Complete these steps to connect the process strategy tags to the I/O Module
(PowerFlex® 755 in our example).

1. In the Logical Organizer, open a program from the Process01 folder and
double-click Parameters and Local Tags.
The program tags appear.

2. Click the Edit Tags tab.

6 Logix Designer - LGXCO1 [1756-L75 31.1]*
FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW  HELP

W e ¥ [ V% % s T

ql Path: AB_ETHIP-1172.18.1.100'Backplane\0 = A 4F 4+ {F Aup 4

" Favorites Safety Alarms Bt Timer/Counter Input/Output Compare Compute/Math  Mo|

Rem Run ﬂ! Mo Forces P NoEdits ® Redundancy

Logial Orgaizer ALIEYY © rrooram paremeters ana ocaiaps - arco0t < [ S

L Task_A_MainProgram
L Task_B_MainProgram
L Task C_MainProgram
L Task_D_MainProgram
L Task E_MainProgram
L Task_F_MainProgram
L Task G_MainProgram
L Task_H_MainProgram
L EtherMetlP_Inputs D
rl Logic and Tags
<7 Parameters and Local Tags
@ MainRoutine
LGXCOTEND2
4 L EtherNetlP_Outputs_D
i Legic and Tags
<7 Parameters and Local Tags
& MainRoutine
LGXCOTENDZ

LT T T T T TYTYTw

'@a Controller Organizer 7‘[3,_ Logical Organizer

[ Search Results JIy Watch

Ready

Scope: | FByAreal v‘ Show: |A|| Tags v” T, -
4 Logical Maodel LGXCO1 5
4 [ Processil Name =&|~ Connections - Properties ' ‘
4 L AreaDl TT01001_Inp_Raw_ModFault “\Diagnostics.LGXCOT1ENOZR01AI01_Module.Sts_|OFault B Exti v
4 Logic and Tags TT01001_Inp_Raw_ChanFault LGXCOTENDZROT:1:1.ChDFault 4 General
sagaamesteraniocalliags TT01001_Inp_Raw LGXCO1ENO2RO1:1:1.Ch.Data Name  MTO1007...
& MainRoutine - - . = = Descrip... Motor 010..,
Ty FICO1002 MTQ1001_Inp_|OFault Diagneostics.LGXCOTENOZMTO1001_Medule.Sts 1OFault) N B
fg MTO1001 FT01002_Inp_Raw_MedFault | T, v| Shaw:|A|| Tags "
g TTO10M FT01002_Inp_Raw_ChanFault - =T 5
4 System FTO002 Ino & ame - ata Type sage ~
!3 Diagnostics -_Inp_Raw I ‘Diagnostics. LGXCO1ENOZMTO1001_Module.Ste_IOFault

FICO1002_Out_CV_ModFault
FICO1002_0ut_CV_ChanFault
FICO1002_Out_CV

» FIC1002_CVIOFault_Bor

@

13gN0siics. 2 _Wodule |
p ‘Diagnostics. LGXCO1ENOZMTO1003_Module L_ModuleSts  Public
b \Diagnostics.LGXCO1ENO2ZR01_Module L_ModuleSts  Public

p ‘Diagnostics. LGXCO1ENOZR01AIN_Module L_ModuleSts  Public -

Show controller tags
Show Areall tags

Show parameters from other program:

| Diagnostics v

b Parameter Connecti...

][+ % Moniter Tags

(S8

Communication Software: R5Linx Classic

. Assign the I/O and the diagnostics by using the program connections.

4. Click a data tag to place the tagin the connections text box.
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5. To view the connections, click one of the tags in the Logical Organizer.

& Logix Designer - LGXCO1 [1756-L75 31.1]*

% B9 Run Mode .
I Controller OK a Path: AB_ETHIP-1\172.18.
I Energy Storage OK
= 110 0K Rem Run FI¥ NoForces

FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP
e AR SN I |- 3. 2

& @ A

1,100 Backplane'd

P NoEdits 2 | Redundancy L

4 Program Parameters and Local Tags - Area01

4 . Logical Model LGXCO1
4 1 Process01
4 Y Areadl
4 = Logic and Tags

& Parameters and Local Tags

@ MainRoutine

By FICo1002

Dy MTO1001

Dy TTO1001

4 1 System
b 4 Diagnostics

b L Task A MainProgram
b 4 Task B_MainProgram
b 3 Task C_MainProgram
b4 Task D_MainProgram
3
3
4
b
a

L, Task E_MainProgram
1, Task F MainProgram
1, Task_G_MainProgram
1, Task_H_MainProgram
L, EtherNetlP_Inputs D
4 ] Logic and Tags
& Parameters and Lecal Tags
@ MainRoutine
LGXCOTENG2
4 1 EtherNetlP_Outputs_ D
4 ] Logic and Tags
&) Parameters and Local Tags
@ MainRoutine
LGXCO1ENG2

el o1t Ll [ Logical Organizer

[ Search Results gl watch

196

FwdPermOK
2-H2 FwdNBPermOK
RevPermOK d 2-H2
3-H2 RevNBPermOK
IntikOK. 3-H2
4-H2 NBIntlkOK

4-H2

WT01001_inp_IOF ault
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AOD LB

HUL DIV BAND BOR BROR BHOT

»

B0 Area0t - MTO1001 X
Q=

Add-On  Process

P_PFT55

MT01001

Ref_FaullCodeList
Inp_{
Inp_FwdNBPermOK
Inp_RevPermOK
Inp_RevNBPermOK
Inp_intlkOK
Inp_NBIntkOK
Inp_IOFautt
Inp_Hand

Inp_Ovrd
Inp_OvrdCmd
inp_Reset

Drives  Fiters  Select/Limit

=

MTO1001_Inp
WT01001_Out
PF75x_FaultCodeList
Val_SpecdRef
Val_SpeedFdbk
Val_Fautt
Sts_Stopped
Sts_Starting
Sts_Running
Sts_Stopping
Sts_logging
Sts_ActualDir
Sts_Alarm
Sts_AtSpeed
Sts_SpeedLimited
Sts_Avalable
Sts_BypActive
Sts_Err

Sts_Hand
Sts_Waint
Sts_Ovrd
Sts_Prog
Sts_Oper

D B T O] e #a e - GSheet |1 w[ofd

0.0
0.0
18

Alarms Bt  Timer/Counter ~Compare

P_RunTime (=]
Stoppped NTO1001_RunTime
aFa Inp_Starting Val_Starts
Inp_Running  Val_CurRunHrs
Val_MaxRunHrs
Val_TotRunHrs
BypActive
2-F3 3-F3
4F3

P_PF755

0o
0.0
0.0
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ConnectaPID Loop Complete the following steps to assign I/O to a PID loop.

1. In the Logical Organizer, open the Process folder and double-click
Area01>Logic and Tags>Parameters and Local Tags.

2. Assign the I/O and the diagnostics by using the program connections.

@ Logix Designer - LGXCO1 [1756-L75 31.1]*
| FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP

S 2 e il | V“'ﬁ % ol I
= I Run Mode .
* I Gontroller OK q Path: AB_ETHIP-1}172.18. 1. 100'Backplane'd k= B AOD SUB HUL DIV BAND EBOR EXOR BHOT
E 50 og KE"B‘POK Rem Run HE Mo Forces F_ Mo Edits 2 Redundancy ) Favorites  Add-On Process Drives Fiters SelectLimt  Statistical Alarms Bt Timer!|
@ Program Parameters and LocalTags - Area01 < |08
Scope ‘ EylArea0t v| Show: ‘A” Tags v” T, o2
4 . Logical Model LGXCO1 i
a Process0] Name =2/~ Connections * Usage Data Type
4 1 Areall FT01002_Inp_Raw_MedFault ‘\Diagnostics.LGXCOT1ENOZR01AI0T_Module.Sts_|OFault Input BOOL
4 =l Logic and Tags FT01002_Inp_Raw_ChanFault LGXCOTENOZROT:T:1.Ch1Fault Input BOOL
kageamstendiocaliags FTO1002_Inp_Raw LGXCOIENO2ROT:1:1.Ch1.Data Input REAL
[0 MainRoutine
Og FICO1002 FICO1002_Out_CV_ModFault ‘\Diagnostics.LGXCOTENOZROTACDT_Module.5ts_|OFault Input BOOL
By MTO1001 FIC01002_Out_CV_ChanFault LGXCO1ENO2ROT:4:1.ChOFault Input BOOL
g TTO7001 FICD1002_Out_CV LGXCD1ENOZRO1:4:0.Ch[0].Data Output REAL
b Syst
ystem » FICO1002_CVIOFault_Bor Local FBD_BOOLE/
ab |

3. Click a data tag to place the tag in the connections text box.

4. Save your work.
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Notes:
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Chapter 7

Considerations

Configure Asset Management Tools

This chapter describes how to use application tools available with the
FactoryTalk® AssetCentre software.

For example, a Device Type Manager (DTM) contains Field Device Tool (FDT)
compliant interfaces to enable configuration and communication between
devices and the system. The interface helps create device parameters for
diagnostics, maintenance, and calibration purposes.

Disaster recovery is another benefit of AssetCentre software. Back up master files
of controller applications help to safeguard against a loss of data.

An Audit Log monitors FactoryTalk-related software products and logs user
interactions. For details, see Chapter 10 in the PlantPAx® System Infrastructure
Configuration User Manual, publication PROCES-UMO001.

Consider the following suggestions before starting this chapter:

e We strongly recommend additional licensing for disaster recovery that
automatically backs up supported devices.

e Ifyou are using HART, Fieldbus Foundation, and/or PROFIBUS PA
process devices, we recommend the DTM procedure, which starts on
page 201. DTMs contain device-specific data to enhance configuration
and communication with the system.

e Instrument calibration is an option with AssetCentre software.

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019 199


http://literature.rockwellautomation.com/idc/groups/literature/documents/um/proces-um001_-en-p.pdf

Chapter 7  Configure Asset Management Tools

Figure 11 shows the topics that are described in this chapter. Click or see the page

number for quick access to a section.

Figure 11 - AppServ-Asset Workflow

Use a DTM for Device Configuration . )
« Design for the Device
See page 201
r .
- (Configure a Logon
Configure Disaster Recovery . Add an Asset
- (Create a Working Folder
See page 215 - (reate a Backup Schedule
y
Configure An Asset Inventory
See page 226
r
See Chapter 8 Configure System Diagnostics
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Use a DTM to Configure
a Process Device

Use an Engineering Workstation
(preferred) or AppServ-Asset
server with these procedures.

p—
L ]
m
EWS01 or ASAMO1

This section describes basic Device Type Manager (DTM) configuration. Use the
DTM with FactoryTalk AssetCentre to connect Process devices. You can perform
this process in the AppServ-Asset server, but typically the engineering
workstation is used to store software.

IMPORTANT  For procedures on how to configure the AppServ-Asset server, see
the PlantPAx Distributed Control System Infrastructure Configuration User
Manual, publication PROCES-UMO001.

Complete these steps.

1. Click the Programs I symbol and choose Rockwell
Software”>FactoryTalk AssetCentre Client>AssetCentre Client.

The AssetCentre Client window appears.

AssetCentre Client . FactoryTalk AssetCentre Client
FactoryTalk AssetCentre Exported Log Viewer . FactoryTalk Historian SE 4
u Getting Results Guide . FactoryTalk Tools b | Accessibility 3
PDC Field Edition . FactoryTalk View b | . Administrative Tools 4
a Release Motes . FactoryTalk ViewPoint b | 1 CodeMeter 3
. FactoryTalk ViewPoint ME » | . FLASHProgramming Tools #
. Logix Designer Tools » | | Hiprom Software 2
. RSLinx » | | Maintenance 3
. Utilities b | | Microsoft Office 2013 3
a2} FactoryTalk Administration Console . Rockwell Automation »
& Studio 5000 | Rockwell Software
| Startup »
L VMware 3
. Windows Accessories 4
| Windows Systern 2
|_'| Desktop
& FactoryTalk View Studio
ﬁ PC settings
p Search
ﬁ Store

2. Choose Tools>DTM Catalog.

File Edit View Tasks | Tools | Windows Help
Opticns ups @ Archive

Archive Cleanup Wizard...
DTM Catalog

Log Cleanup Wizard...

The DTM Catalog window appears.
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Predefined filters

3. Click Scan Now to update the catalog.

IMPORTANT  Every newly installed DTM requires a scan.

If you do not have a new DTM installed, skip this step.

All DTMs Missing DTMs

Enabled DTMs Disabled DTMs

Awvailable DTMs Extra DTMs

All 34 DTMs (No filter)
Status  Awailable Vendor

B m

Protocols

@

@

DTM library details
Last scanned on 1/25/2018 11:02:53 AM

0 new, 0 removed, 0 upgraded

OTM Name “ersion  Library Version First Date Found  Last ™~

EndressiHanse

Hiprom Technolo...

CIP Backplane (..

1756-Chassis i 01/25/2018

Hiprom Technolo...

CIP Backplane, ..

1756-CNB i 01/25/2018

Hiprom Technolo...

CIP Backplane, ..

1756-ENET : : i 01/25/2018

Hiprom Technolo...

HS Ethernet/IP [

1756-ENET : : i 01/25/2018

Hiprom Technolo...

HS ControlNet, F_.

01/25/2018

Hiprom Technolo...

HS ControlNet. P..

01/25/2018

Hiprom Technolo...

HS Ethernet/IP [

01/25/2018

Hiprom Technolo...

HS Ethernet/IP [

1788-EN2ZPAR : : i 01/25/2018

Hiprom Technolo...

HS Ethernet/IP [

HS Ethernet/|P : : i 01/25/2018

Rockwell Autom..

HS Ethernet/IP [

1715 EtherNet/|P Gateway DTM 01/25/2018

Rockwell Autom..

HS Ethernet/IP [

1715-IF16 ! analoginput 01/25/2018

Rockwell Autom..

HS Ethernet/IP [

1715-0F8l ! analogOutput 01/25/2018

Rockwell Autom..

A-B 1719-Bus. H..

1713-CF4H combinedinputO . 01/25/2018

Rockwell Autom..

A-B 1719-Bus. H..

1718-IF4H analoginput 01/25/2018

Rockwell Autom..

A-B 1719-Bus. H..

1718-IF4HE analoginput 01/25/2018

RAAARAAAARARRARAAS

Rockwell Autom..

A-B ConfrolLogix.

1756-IF16H . . notSpecified 01/25/2018

-~

_Kﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬁi

g
:
&

4. Click Close when the scan is complete.

5. In FactoryTalk AssetCentre software, click the Tasks tab and choose DTM
Networks.

File Edit View |Tasks | Toocls Windows Help

% ﬂ ©| Backup to config data... Frg

DTM MNetworks

Add Mew Address Book Contact...
Add Mew Address Book Group...

Show all Schedules
Show Schedules containing the selected Asset

Add Mew Search...

& SYSTEMADMINISTRATOR 335 Connected 2, Agents 1
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The DTM Networks window appears.
6. Right-click Host PC>Add DTM.

DTM Networks = [ = -

Rename

Add DTM

Add DTM

Add Generic Container
Remove

Open

Scan network

DTM information

CO®O00O

Close | | Help

The Add DTM window appears.

IMPORTANT  The HART module must be configured in the I/0 configuration tree.
For details to enable HART channel data, see Chapter 5.

The same procedure must be performed on PROFIBUS PA and Fieldbus
Foundation modules.
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7. Select DTM 'RSLinx" 1756 Backplane (ControlLogix")' and click OK

Protocols OTM Name “ersion  Library Version Class

Bl Bl Bl Bl Bl &l
Rockwell Autom . HS EthemetIP (" 1715 EtherNetP Gateway DTM 3130 31.30 dtmSpecif

Hiprom Technola. HS Ethernet/IP (. HS Ethernet/IP 2.005 2.005 notSpecifi

Rockwell Autom. ~ A-B 1719-Bus RSLinx 1719 Backplane 2000 2000 notSpecifi

Rockwell Autom.. - 1737 RSLinx Flex Rail 1.1.13.28 1.1.13.28
- - I—

Rockwell fAutom.. A-B ConirolLogix.. A 1.0.1.13

Device Name Liree 1756 Backplane

Manufacturer Rockwell Automation

DTM Installation ... |file:///C./Program Files {«86)/Rockwell Automation/DTM Library/1756 Family/Rockwell1756Comm dl
Device 1D
Manufacturer [0
Hardware Revision
Software Revision
Device Revision
Profile Revision

ls Generic

8. In the DTM Networks window, right-click '(RSLinx 1756 Backplane)'
and choose Configuration.

Add DTM

Rename

Add DTM
Remove
Remove

Online

Device additional 3 QM

Configuration

Scan network

DTMinformation
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9. Select the path to the backplane.

I =) =)
o] || &
RSLinx 1756 Backplane Roclavell
Automation

CIP Path:

Select path: »r

C ication Timeout, msec:

@ e w
|<J|> Mo connection (0 Database

The Select 1756-Backplane dialog box opens.
10. Select '‘Backplane, 1756-A7/A or B' and click OK.

v Autcbrowse Refresh | m
B-&5 Linxk Gateways, Ethernet
=25 AB_ETH-1, Ethernet
ﬂ 172.18.2.10, 1736-EM2TR, 1736-EM2TR/C

ﬂ51 2 E_ET

B 172.18.2.22, 1788-EN2PAR, 1788-EN2PAR/B
172.18.2.31, PowerFlex 755, PowerFlex 755

172.18.2.32, PowerFlex 525, PowerFlex 525 1P 110V .50HP
B 172.18.2.33, SMC-50, SMC-50 Standard
B 177 127 24 FI00 Owerlnad Relay F20N Nuerlnad Relaw
|AB_I:—I'H—1\‘I'.-"2.‘IB.2.11\Backplane

0K Cancel
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11. In the DTM Networks window, click Next.

I =) =)
o] || &
RSLinx 1756 Backplane Roclavell
Automation

CIP Path: | AB_ETH-11172.18.2.11\Backplane|

0o O
] s : . :
=R

Communication Timeout, msec: | 4000 |

Il

[<J|> Mo connection (0 Database

12. In the DTM Networks window, right-click '(RSLinx 1756 Backplane)'
and choose Add DTM.

= Host PC
2. [RSLinx 1756 Backplanel

Add DTM

Rename

Add DTM
Remove

Rermove

Online
Device additional 3 QM

Configuration

Scan network

DTMinformation
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14.

The Add DTM window appears.
13. Select DTM '1756-1F8IH/A' and click OK.

Protocols

OTM Name “ersion Library Version Class
B B B B

Rockwell Autom..

A-B ConfrolLogixc. 1.01 10113 notSpecified

Rockwell Autom..

A-B ConfrolLogixc. 1.01 10113 notSpecified

Rockwell Autom..

1756-IFBHIA
A-B ConfrolLogixc. 10 1.002 notSpecified

Endress+Hauser...
Rockwell Autom..

1756-0FBHIA
1756-IF16H
100,00 1.00.00
—
1.001

HART, Profibus._ Placeholder FieldDevice
A-B ControlLogix.. notSpecified
T et

Device Name

Manufacturer

DTM Installation ...

C:\Program Files (cB6)\Rockwell Automation \DTM Library'.1756 Famiy.1756-IF8IH DTM\RS17561F8IH...

Device 1D

Manufacturer [0

Hardware Revision

Software Revision

Device Revision

Profile Revision

ls Generic

Select the module slot number and click OK.

Please enter a Slot Number for the added child device

<= No connection

0 Databaze
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15. Inthe DTM Networks window, right-click ' - (RSLinx 1756

Backplane)'>1756Bus> - (1756 IF8H/A1).
16. Choose Online.
17. Click Scan network.

=~ Host PC
T
=By - [RSLinx 1756 Backplane]

==

Rename

Add DTM

Rermove

Online

Device additional »

Configuration

Diagnosis

Add DTM

Remove

Open

Scan network

DTMinformation

The Select Communications Channel window appears.

18.  Select the channels to perform the Scan Network on and click OK.

The sel i device several ct |
Flease select the channel you want to scan for
connected devices.
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Design for the Device

==

Scan Results
ltems Found Selected Item Details
Channel (Offline Tag / Device Summary
Address Tag )
[HARTCH_00:0]  |-/TTO1001 Details: New device found
Selected Action: Add to project A

Hardware Information
Serial Mumber: 5573646
Bus Address: ]

Hardware Version: 1.0

DTM [ Hardware Compare

Device Tag
Device

Manufacturer

Device |D ({Cmd 0 Byte 2) / Sub ID

Manufacturer 1D {Cmd 0 Byte 1)

Software Revision (Cmd 0 Byte &)
Command Revision {Cmd 0 Byte 5)

Profile Revision (Cmd 0 Byte 4)

TR . T

DTM Information Change ...

Hardware

TTO1001

Device Type:

Quality:
Class:

Is Generic:

iTemp / TMT 162
Endress+Hauser

202/
17
10

1
temperature
No

Cument DTM Device
Type

iTemp / TMT 162 / ___
Endress+Hauser
202/DDCEHS_H11c_.
17

iTemp/TMT 162/V1.03

Any items found (temperature transmitter TT01001 in the example) are listed in
the Items Found area of the Scan Results window.

1.
2.

Click OK.

In the DTM Networks window, click Close.
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3. Inthe FactoryTalk AssetCentre window, select Design mode.

File Edit View Tasks Tools Windows Help

‘E&|*@u.m|@wm6mup& [@ Archive

@@ Add To Assets

-- Device ltems

[+ File and Folder ltems
[+ Organizational ltems
- Process Devices

File Edit View Tasks Tools Windows Help

‘E&|*@u.m|@wm6mup& [@ Archive

@@ Add To Assets

& SYSTEMADMINISTRATOR 33 Connected ', Agents 1
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S. Click DTM Addressing Info and then click Browse (ellipsis “...") to open
the Select a DTM device from the DTM network window.

Links an Asset to a node in the DTM Network. Mote: Setting this property will clear the
"Configuration Data’ property.

ok || Conced || b |

6. Select a Process Device (TT01001 in the example) and click OK.

Select a DTM device from the DTM network. The Find box can be used to filter the list of DTMs by entering the device
name, off-line tag name, DTM name, or DTM device class. For example, if you enter “temp 10017, the list of DTM is
filtered to only DTMs that contains both “temp™ and "1001" anywhere in those fields.
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7. Type the device name or tag and click OK.

=
4 1.General
(Parent) AssetCentre

Description
4 2 Hardware Information
Catalog Information
Configuration Data No file selected.
Device Name TT01001 [iTemp / TMT 162 / V1.03.0
OTM Addressing Info Linked to DTM Networks
Firmware Revision 10
Hardware Revision 1.0
Hardware Type iTemp / TMT 162
Manufacturer Endress+Hauser
3.Asset Information
Asset Number
Communication Path Hest PC. - [RSLinx 1756 Backplane]. 1
Location
ProCalVs Company
ProCalVs Linked tem

Name
Unigue name for the asset within the current parent.

==

8. Select DTM View, click the device (TT01001 in the example), and
click Online.

IMPORTANT  The Upload, Download, and Diagnostics functionality also
are available.

File Edit View Tasks Tools Windows Help
- lie ssets ent Groups rchive 4 ssets Lifecycle ibraticn iew s ules
> | A | @ Agent Group: Arch Assets Lifecycle B Calib DTM V Logs (¥) Schedul
= DTH View - TT01001
& Design | o | 38 | &2 _||@ Open @ Online & Actions ~ () Additional Functions

DTM Name: iTemp/TMT 162/V1.03.00
DTM Manufacturer: Endress+Hauser

Hardware Manufacturer: Endress+Hauser
Serial Number: 5573646

=
P Add Instrument to AssetCentre {g Download
..... Catalog
Device ltems _ _
File and Folder ltems Offline Current status: Offline
+-Organizational ltems :&D
- Process Devices
‘i Equipment Device / Network diagnostics
#0y |nstrument

: g Test Instrument
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9. Click Open to configure the device.

File Edit View Tasks Tools Windows Help
B E S b E DB M & Assets | T AgentGroups Archive 4t Assetslifecycle B Calibration @ DTM View &F Logs (&) Schedules

DTHM View - TTO1001

_|| @ Open QActions -+ {3 Additional Functions =

P Add Instrument to AssetCentre

Home |

DTM Name: iTemp/TMT 162/V1.03.00
DTM Manufacturer: Endress+Hauser

Hardware Manufacturer: Endress+Hauser
Serial Number: 5573646

® =]

Upload

&
Ew
.4
@

Online/ Offline Current status: Online

Device /Network diagnosiics

& SYSTEMADMINISTRATOR B33 Connected %, Agents 1

The Online configuration tab opens.
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10. Make any configuration changes you like.

When you are finished with changes, you can exit the FactoryTalk
AssetCentre window. You also can return to the Home tab to make
more changes.

File Edit View Tasks Tools Windows Help
% u I?j | * @ .jj x & Assets |@ Agent Groups @ Archive iﬂ) Assets Lifecycle a Calibration . DTM View J Logs ® Schedules

Asset View (Desi

DTHM View - TTO1001

|| @ Open | @ Online | @) Actions ~ (3 Additional Functions =

AssetCentre
oy TT01001

Home | Online conﬁgumﬁon|
L

P Add Instrument to AssetCentre

File and Folder ltems
Organizational ltems

E|||@

DeviceType: iTEMP TMT162 PV: 26,14 degC AO: 7.444 mA
Tag: TTO1001 Value Sensor 1: 26,02 degC Rlvalue: 25.07 m

Status signal [ OK Value Sensor 2:  9999.90 degC Endress+Hauser

Label Tag: TTO1001
E Instrument he
= B& TMT162 Descriptor: | TEMP 01001

E Measured v,

E Standard se Message: @®

E Sensor 1

E Output

LB Safety settin =

E Display

E Diagnostics,

= B Identificati

= E Measuri

Brag

@Descr

@Mess;_

L& Deviceir v
<[] >

[T Online | @| W& 45 By 3y Measuring point |

lgi;'%2|@IEIonnec:tet:I Ly 4] @l ? |

214

& SYSTEMADMINISTRATOR 53 Connected . Agents 1
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COnfigure Disaster Disaster Recovery software creates back-up files. This procedure schedules a

Recov ery comparison between master files, and processor program and data files.

Configure a Logon

Complete these steps to configure the user name and password to enable the
Agent service.

1. Click the Programs I symbol and choose Rockwell
Software®>FactoryTalk AssetCentre Agent>
Agent service logon config tool.

! ] =5 | FactoryTalk Alarms and Events 4
Agent Controller Launch Control Panel .. FactoryTalk AssetCentre Agent
!, Agent service logon config tool | FactoryTalk AssetCentre Client 4
= | Release Notes | FactoryTalk Historian 5B »
. || FactoryTalk Tools »| | Accessibility 8
. FactoryTalk View ¥ | Administrative Tools 4
|, FactoryTalk ViewPoint » | i CodeMeter 3
. FactoryTalk ViewPoint ME » | .. FLASH Programming Tools »
|, Logix Designer Tools » | | Hiprom Software 3
. RSLinx ¥ | | Maintenance 3
—— | Utilities b | . Microsoft Office 2013 3
FactoryTalk Administration Conscle . Rockwell Automation 4
e Studio 5000 | Rockwell Software
| Startup 3
1 VMware 3
.. Windows Accessories 4
1 Windows System 3
|| Desktop
&l FactoryTalk View Studio
ﬂ PC settings
p Search
ﬁ Store

The Agent Services Logon Configuration dialog box appears.

2. Type a user name (AssetCentre_DR in the example), password, and

click OK.

oy Agent Services Logon Configuration -

Please specify the user credentials for the account that will be used to
configure the Disaster Recovery services. This account will be created as
a local Windows administrator user and will be a Factory Talk Windows

linked user.
User Name: AssetCentre_DR |
Password: ssssssses |

Corfirn Password: fl|sssssssss |

After creating the logon, you must confirm that you need to restart
the Agent Service.

IMPORTANT  The HART module must be configured in the 1/0 configuration tree.
For details to enable HART channel data, see Chapter 5.
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3. Click Yes.

Agent Service needs to be restarted. Do you want to restart the Agent
Service now?

4. Perform step 1 and step 2 to reopen the Agent Service Logon
Configuration dialog box.

5. In the next dialog box that appears, confirm that the information is correct
and click Close.

The Agent Service Logon Configuration dialog box closes.

Add an Asset

IMPORTANT  AssetCentre version 9 includes an asset for FactoryTalk View SE, version 11.
This asset can be created to support disaster recovery for a FactoryTalk View
SE application.

To add a Logix5000™ controller as a new asset, complete the following steps.

1. In the FactoryTalk AssetCentre, click Design.
2. Drag-and-drop the Logix5000 Controller into AssetCentre.

File Edit View Tasks Tools Windows Help

% u L"‘j|‘=b @ Jﬁ x a Aszets |@ Agent Group

P Add Logix5000 Controller th AssetCel

£ Device ltems
-] ABB Robot (Use Ggneric
- Custom Device =
"] FANUC Robot (Usf Gene |~
. General DTM ce
-\ Generic Device

" [oai5000 Controller

‘1 Motoman Robot
-8 PanelView
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The Add a Logix5000 Controller to AssetCentre dialog box appears.

3. Choose Configuration Data and use Browse (ellipsis ...") to find and
click Add.

=]

4 1.General

(Parent) AssetCentre

Description

Mame Logic5000 Controller
4 2 Hardware Information

Addressing Info

Catalog Information

Change Detect Capable

No e selected

Device Name
Firmware Revision
Hardware Revision
Hardware Type
Manufacturer
4 3.Asset Information
Agent Group
Asset Number
Location
Serial Number

Configuration Data
Configuration data for the device

Filter: [RSLogix 5000files {"acd)

An .ACD file appears in the right side of the window.

4. Select the .ACD file and click OK.

Filter: [RSLogix 5000files {"acd)

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019

217



Chapter 7  Configure Asset Management Tools

&J\

In the Add a Logix5000 Controller to AssetCentre dialog box, choose
Addressing Info.

6. Click Browse (ellipsis “..").

M=
4 1.General
(Parent) AssetCentre

Description

Mame Logic5000 Controller
4 2 Hardware Information

|

Catalog Information

Change Detect Capable

Configuration Data

=)

¥ Autobrowss Refresh I ml

-2 Workstation, EWS01
: & Linx Gateways, Ethernet
&5 AB_ETH-1, Ethernet
El-&5 AB_ETHIP-1, Ethernet
Eﬂ 172.18.1.100, 1756-El
E.. Ea £ b

g

Mot Browsing

|>

MN2T, 1756-EN2T/D

02, 1756-EN2T, 1756-EN2T/D
-8 02, 1756HP-Time PTP Master, 1756HP-TIME/B
-f] 04, 1756-EN2TR, 1756-EN2TR/C

172.18.1,101, 1756-EN2T, 1756-EN2T/D

172.18.1.102, 1756HP-Time PTP Master, 1756HP-TIME/B

172.18.1.105, 1756-EN2TR, 1756-EN2TR/C

172.18.1.107, 1756-EN2TP, 1756-EN2TP/A ||

172.18.1,108, 1756-EN2TP, 1756-EN2TP/A

172.18.1.111, 1736-EN2T, 1756-EN2T/D

172.18.1.112, 1756-EN2T, 1756-EN2T/D

172.18.1,113, 1756-EN2T, 1756-EN2T/D

172.18.1,114, 1756-EN2T, 1756-EN2T/D

172.18.1,115, 1736-EN2T, 1756-EN2T/D

172.18.1.118, 1756-EN2T, 1756-EN2T/D

17218 1 150 17561 05E | NEIYSEO5E 1756 1 O5E/MD Lk Aaiv ~
>

(o (2

2T R a0 B O B WO O e O P
pl bbb L e

<l

Curmrent Device Remate Input/Output Options

Name: LGXCO
[[] Remote Input/Output De:

Type: 1756-L75 LOGIX5575

EWS01IAB_ETHIP-14172.18.1.100\Backplane\0

The Selecting Device For Asset Type window appears.

7. Select the path to the controller and click Select.
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8. Inthe Add a Logix5000 Controller to AssetCentre dialog box, type the
controller name (PACO1 in the example) and click OK.

8| =

1.Generl
(Parent)
Description

2 Hardware Information
Addressing Info

Catalog Information
Change Detect Capable
Configuration Data
Device Name

Firmware Revision
Hardware Revision
Hardware Serial Number
Hardware Type
Manufacturer

3.Asset Information
Agent Group

Asset Number

Location

AssetCentre

LGXCO

EWS01IAB_ETHIP-1\172.18.1.100\Bac

True

AssetCentre/Logix5000 Controller/LGX( _

LGXCO01
311

1756-L75 LOGIX5575
Rockwell Automation/Allen-Bradley

System Default

Name
Unigue name for the asset within the current parent.

[ Jre=Ce ]
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Create a Working Folder

Complete these steps to set the workbook (working folder) in any level
of the structure.

1. In the FactoryTalk AssetCentre window, select Archive.

2. In the Archive tab, click Set for the Working folder.

% FactoryTalk AssetCentre = =] 2=

File Edit View Tasks Tools Windows Help

ﬁ'}‘ 8BS P ,_Ttl o i a Assets @ Agent Groupsl Ld Archive I{ﬂ! Assets Lifecycle B Calibration @ DTM View &f Logs 'Q_') Schedules

Asset View (Design) o x Archive ] x
esign i g B eck Cut eckIn ndo Check Cut et ew Label @ Remove Label xport for PCDC
& D CER A AN Check O Check | Undeo Check O G @ New Label R Label Exp PCDi

ETI

----- K,’_; AssetCentre

g #_?;‘150%11 Q; AssetCentre

Description: |

‘working folder: |{none set)

Name User Check Out Location
; Browse For Folder
Set Working Folders 2
System working folder for this asset (set by administrator):
|“ b (8 Videos ~
I = Floppy Disk Drive (A:)
f‘} R Personal working folder for this asset (overrides system working folder if set): 4 |=j- Local Disk (C:)
| | | Browse | I* . Hiprom Software >
""" Catalog I inetpub =
=t Dewvi =
o I M50Cache
. Based on these settings, and those for assets further up the hierarchy, files for | Perflogs Versio
i this asset will be stored at: S
. Plantl Versio
. o E - ‘ersio
s | | [ @ PlantPAx Utilities
o fomate
G I | Program Files
-] s D Eilar fxBE) -
¥ (I N = J o=
[ rerorogT
-l MobileView v
< - m > < m >
Ready & SYSTEMADMINISTRATOR 53 Connected . Agents 1 y

The Set Working Folders dialog box appears.
If the System working folder is incorrect, click Browse (ellipsis “..).

4. In the Browse For Folder dialog box, navigate to the desired folder, select
it, and click OK.

5. In the Set Working Folders dialog box, click OK.
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6. In the FactoryTalk AssetCentre software, make sure the Check In, Check
Out, and Revision Control procedures are available in

the system.

File Edit View Tasks Tools Windows Help
P E S EE RS Ases |@ Agent Groups Archive 4t AssetsLifecycle M Calibration @ DM View &f Logs (%) Schedules

& Desiogn || o | 1% | [ 4 Check Out B9 Checkln ) UndoCheckOut 8 Get | @ MNewlabel @ Removelabel  Exportfor PCOC

§ LGXCO01.ACD

gy TTO1001
State: The file is checked in.

Do |

[] Store Iatest version only
[] Maximum number of versions

Currentversiontotal:[1 | Total diskusage: [4 | MB

History | Labels |

Fitter
(®) Versionrelated activities

Range
(®) Most recert 100 records
O Records from date: | 1/26/2018  [Elw | to: | 1/26/2018  El~ | O All activities

P Add Logix5000 Controller to AssetCentre

)
£ Device ltems ]
] ABB Robot (Use Generic FT = = = 0 ——

= ‘ersion ime ion ser mments
P ?;‘fg'm“"ﬂj’; 1 Today, B:05AM Created fie SYSTEM\ADMI..
- FactoryTalk Directory
] FANUC Fobot (Use Generic
. General DTM Device
-\ Generic Device

Generic FTP Device

=) MicrolLogix Processor
-l MobileView Gl
| »

& SYSTEMADMINISTRATOR B33 Connected %, Agents 1
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Create a Backup Schedule

Complete these steps to configure a backup schedule.

1. In the FactoryTalk AssetCentre Client, click the controller.

2. Select Schedules.

File Edit View Tasks Tools Windows Help

P S B O M & Asses | QF AgentGroups [ Archive {lf Assetslifecycle @ Calibration @ DTM View & Logs| &) Searches | [ @
;

AssetCentre >  LGXCO1

@ New.. |3 [ | B RnNow 1)

@) Ml Schedules (O Fiter by Schedules which include ‘LGXC01'

% Add Legix5000 Controller to AssetCentrg Mo Schedules have been created.

- Catalog
=} Device ltems
7§ ABB Robot (Use Generic FT | =
- Asset Inventory
- Custom Device
@ FactoryTalk Directory
-7 FANUC Robot (Use Generic
. General DTM Device
{0 Generic Device
Generic FTF Device
-0 MicroLogix Processor
(il MobileView

& SYSTEMADMINISTRATOR 23 Connected %, Agents 1

The Schedules tab appears.
3. In the Schedules tab, Click New.
The 'New Schedule Wizard - Step 1 of 3" dialog box appears.

4. Make sure that the Operation is correct.
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5. Type the name for the schedule and click Next.

Schedule Properties
Mame must be unique across all schedule names.

| Disaster Recovery - Backup

ame:
Ilmp« Schedule ||

Description:

Completion Email List:
| To... ||

The New Schedule Wizard - Step 2 of 3" dialog box appears.

6. From the pull-down menu, select the Start Time.

Timing Properties
Flease update the timing properties for this schedule.
Clicking on Mext button will create the schedule. You will not be able to retum to this page.

SanTime

Timing Properties

O Houry Every day(s)
® Daily

O Weekly
O Monthly

Maximum Runtime (0.0 means no limit) - Hours Minutes

Maximum Runtime is limited.

7. Set the Timing Properties.
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8. Set the Maximum Runtime.

IMPORTANT A maximum runtime of 0.0 means that there is no maximum limit.

9. Click Next.
The 'New Schedule Wizard - Step 3 of 3' dialog box appears.

Mew Schedule Wizard - Step 3 of 3 .
Operation Properties AR
Set operation properties for each asset in the schedule. "y

— — LGXCO1 Properties
(®) View By Location () View By Assst Type

Assets in PlantPfx Schedule:

4 1. Event seltings
§ Lexcot Master File Path Name AssetCentre/LGXCO1/LGXCO1.ACD . Lates!
4 2. Assetspecific properies
Always Run Events True
4 3. Email notification
Event Completed
Event Failed

Always Run Events
Indicates if events should always be processed.

Activate the Schedule

Help < Back || Cance

10.  Select the Email notification option and click Finished.
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11. In the FactoryTalk AssetCentre - Schedules tab, click Run Now to test the
functionality of the new schedule outside of the scheduling period.

AssetCentre > LGXCO1

o New.. 3 | E?I B Run Now h
= LGXCo1
®) All Schedules O Filter by Schedules which include LGXC01"

g LGXCO1ACD
- TT01001 Active Name Schedule Location Operafion Last Time Next Time Status Completion Email List]
i ] [&] [&] ]

(=]

PlantPfux Schedul | AssetCentre/LGXCO1  Backup Friday, January  Saturday, Januar  \Waiting To Run

J <] m
LGXCO01 Properties
(®) View By Location () View By Asset Type
A 5
Assets in PlantPfx Schedule: ZJ' | ;
Gp Add Logix5000 Controller to AssetCentr = ' i 4 1.E
Master File Path Name AssetCentre/LGXC01/LGXC01.ACD . Lates

- Catalog "
[=}- Device ltems . 4 2. Assetspecific properties

"] ABB Robot (Use Generic FT | = Always Run Events

&% Asset Inventory 4 3. Email notification

i Custom Device Event Completed

W FactoryTalk Directory Event Failed

] FANUC Robot {Use Generic

. General DTM Device
W Generic Device Always Run Evenis
Indicates if events should always be processed.

Generic FTP Device

= MicroLogix Processor
g

) MobileView
& SYSTEMADMINISTRATOR 555 Connected . Agents 1

The backup of the controller runs. After a few minutes, the backup

is complete.
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Config ure An Asset This section describes procedures for configuring an inventory list of assets.
|nventory Complete these steps.

1. In the FactoryTalk AssetCentre window, select Design mode.

2. Drag-and-drop Asset Inventory into the AssetCentre tree.

Asset View (Design) 3 x

~_H Add To Assets /

Catalog
=t Device ltems

Ly 1

generic FT
Asset Inventory [

o FactoryTalk Directory

"] FANUC Robet (Use Generic

@ General DTM Device

W Generic Device

"1 Generic FTP Device
Logix5000 Controller

= MicroLogix Processor

@ MobileView

' Y PUPURGR . N Ty

< m >

3. Click Scanning Configuration and then click Browse (ellipsis “...).

Add a Asset Inventory to AssetCentre -
(Parent) AssetCentre
Deescription
Mame Asset Inventory
4 2 Hardware Information
Backup Data Mo file selected.
4 3.Asset Information
Agent Group System Default

Scanning Configuration

Scanning configuration

oK || Cancel |[ Hebp
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4. From the Scanning Configuration dialog box, click Advanced Settings.

[+] Scan devices using CIP

Start scanning with this device: [EWS0T
Maximum scanning depth: ¥ Unlimited scanning

[+] Scan devices using SNMP

Scan within: (®) |P address range

Start IP address: - 18 . 0

End IP address: - 18 . 0

Maximum number of hops: [¥ Unlimited hops

[+] Scan software using WMI
Scan type:

Scan within:

Start IP address:

End IP address:

Maximum number of hops:
Login:
Password:

4 General setfings
Maximum scanning time [min]
4 Scan devices using CIP
Device response timeout [msec] [v/] Scan devices using CIP
MNode identification timeout [sec] L .
4 Scan devices using SNMP Start scanning with this device: | EWS01
PlantPAx j 3 - f o i 3
Device response fimeout [maed) 60000 Maximum scanning depth: [+ Unlimited scanning
4 Scan software using WMI
Host response timeout [msec] 60000 [+] Scan devices using SNMP
Software scanning mode Synchronous

Scan within: (®) |P address range

Start IP address: - 18 . 0

End IP address: - 18 . 0

Type the SNMP community string. You can type up to 255 characters. If you type more, the string Maximum number of hops: [v] Unlimited hops
shortened to match the limit.

[+] Scan software using WMI
Scan type:

Scan within:

Start IP address:

End IP address:

Maximum number of hops: [¥ Unlimited hops

Login: [SYSTEM\Administrator

Password: |‘““““

6. Click OK.
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7. Type PlantPAx Inventory into the Name text box, and click OK.

BElsi| =
4 1.General
(Parent) AssetCentre

Description

PlantP A« Invertory

4 2. Hard Informatie
Backup Data Mo file selected.
Scanning Configuration CIP:SNMP:WMI
3.Asset Information

Agent Group System Default

Name
Unigue name for the asset within the current parent.

8. Click Schedules on the menu bar, then click Inventory Schedule.

File Edit View Tasks Tools Windows Help
2 E S +E B B Ases |@ Agent Groups Archive 4t AssetsLifecycle M Calibration @ DM View &f Logd

Searches | [# @)

AssetCentre > PlantPAx Inventory
@ New.. 3|3 | B> RunNew [

O Al Schedules @ Filter by Schedules which include "PlantP Ax Inventory’

Active Name Schedule Location ‘Dperation Last Time Mext Time
A 8] [&]

AssetCentre/PlantPAx  Backup

@@ Add To Assets
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9. Click Run Now to generate an inventory list.

File Edit View Tasks Tools Windows Help
% u |‘=¥ @ x ‘ Assets |@ Agent Groups Archive I} Assets Lifecycle a Calibration . DTM View O Schedules a Searches

AssetCentre >  PlantPAx Inven
B New.. 3 |2 B gonnow B
O Al Schedules @ Filter by Schedules which include "PlantP Ax Inventory’
E-E-El_ﬁl_ﬁl—

rm Inventory Schedule AssetCentre/FlantPAx  Backup

Add To

10. To access the inventory list, right-click on the inventory name in the left
column of the FactoryTalk AssetCentre dialog box.

File Edit View Tasks Tools Windows Help

P E S D D 8B Asses @ Agent Groups [ Archive

& Design | [ #4 AssetCentre >  PlantP
P New.. 3|3 |

) Ml Schedules @) Fil

Archive

Schedules

=] &
[v] Inventory

Check Qut...
Get...

Open |
Create Shortcut...

Select Left File for RA Compare

Export for PCDC

11. Choose Open from the pull-down menu.
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You can view Devices or Software from the respective tabs.

O search |@§olumns @ Undo & Check|n Eﬁxpor‘t |E;Add £ Update g Help

Start Time:  1/26/2018 2:45:08 PM
End Time:  1/26/2018 4:56:47 PM
Succeed

® add O Update [ ExpandAll | [ Collapse All
Device Name Device... Product..  Product. Preduct. Revi. WVendo. Commissio.. Additional .. Additional .. Additional ..

EWwS01 017262018
SNMP_172.18.0.1 172.18.0.1 01/26/2018
SNMP_172.18.0.10 172.18.0.10 01/26/2018
SNMP_172.18.0.20 172.18.0.20 01/26/2018
SNMP_172.18.0.21 172.18.0.21 01/26/2018
SNMP_172.18.0.22 172.18.0.22 01/26/2018
SNMP_172.18.0.23 172.18.0.23 01/26/2018
SNMP_172.18.0.30 172.18.0.20 01/26/2018
SNMP_172.18.0.31 172.18.0.31 01/26/2018
SNMP_172.18.0.40 172.18.0.40 01/26/2018
SNMP_172.18.0.42 172.18.0.42 01/26/2018
SNMP_172.18.0.43 172.18.0.43 01/26/2018
SNMP_172.18.0.44 172.18.0.44 01/26/2018

Ot

o

O search | [#) Columns

@ Undo & Check|n Eﬁxpor‘t |E;Add £ Update g Help

Start Time:  1/26/2018 2:45:08 PM
End Time:  1/26/2018 4:56:47 PM
Result: Succeed

Name Install Date Vendor ersion

PADCA System. PlantPlx local
PADCE. System.PlantPlx local
PASS01. System. PlantPlx local
PASS0Z2A System. PlantPlx local
PASS0ZE. System. PlantPlx local
ASNMO3. System. PlantPloc local
ASCG03.System. PlantPloc local
EwS01. System. PlantPlx local
ASIHO1A System. PlantPlx local
ASIHO1B. System. PlantPlx local
ASIS01. System. PlantPlx local
ASIVD1. System. PlantPlx local
asaml. System. PlantPlx local
ASIHOZ System.PlantPlx local
ACPO1. System. PlantPlx local
ASCGO1.System PlantPloc local
ASCGOZ System PlantPloc local
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Add Basic System Diagnostics

This chapter describes how to add controller and PASS server diagnostics to
your system health screen that is provided in the HMI template. HMI
templates are provided with the Rockwell Automation® Library of Process

Objects. As you develop your project, you can add additional diagnostics for
your system.

We recommend that you familiarize yourself with the HMI template. See the
Rockwell Library of Process Objects, Configuration and Usage Reference
Manual, publication PROCES-RM002.

Figure 12 shows diagnostic displays that are explained in this chapter.

Figure 12 - HMI Diagnostics Example

PlantPAx

Distribufed Control Sysiem

Area01 Areal?

tn [ o X = B

Current User:

SYSTEMADMINISTRATOR

Process01

Waiting for Alarm Events..

Modify this screen to represent your network c
Logix status objects are available on the (RA-B

LGXCOo1

Remote Run

Process System - /PlantPAx//Area

Server Status

Area:
Server:
Machine:
Primary:
Secondary:

FT Server

Server Status - State Popup

HMI Server Data Server
Not Applicable IArea IArea/Data :“Jgg ‘Cj”?”_s'“"us
FTDirectory PlantPAx_HMI PlantPAx_DAT
pass01 pass02a passi2a
T T
Not Applicable | Standby | [ Standby |
Select Server... | selectServer.. | | selectServer.. | |  Close |

Remote Run

Shortcut:

IArealData:[LGRCO1]

Name:

LGXC01

Time:

6/07/2018 11:41:50.974 am

Firmware:

Revision: 31.11

Device Path:

ControlLogix in slot 0 of the chassis at 172.18.1.100

-~ Ni@E=EEs> ™

Enter Software S/N or Support Contract #

LGXCO1 - fArea/Data:[LGXCO1] .
OK
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Figure 13 shows the topics that are described in this chapter. Click or see the

page number for quick access to a section.

Figure 13 - Basic Diagnostic Workflow

( Start )

r

Configure Controller Diagnostics

See page 233

Y

Add Controller Diagnostics to an HMI Project

See page 234

r
Configure PASS Server Status

See page 239

r

Additional Resources

See page 244

See Appendix A
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Configure Controller
Diagnostics

Use an Engineering Workstation
with all procedures.

EWS

Controller Organizer

X

Pl Controller LGXCO1
<2 Controller Tags
Controller Fault Handler
Power-Up Handler
Pl Tasks
b (D) Task_A_50ms
b (E) Task_B_100ms
b (D) Task_C_250ms
b (D) Task_D_500ms
b (D) Task E_1s
b (B Task_F_2s
b (D) Task_G_5s
b (D) Task_H_10s
4 (B) _Controller_Status
4 1, Diagnostics
<7 Parameters and Local Tags
@ LCPU
Unscheduled
Pl Motion Grouns

f1= Controller Organizer E&Logical Organizer

The Logix Controller CPU Ugtilization (L_CPU) Add-On Instruction
faceplate monitors a Logix controller and provides controller information on
the system status page of the HMI template. This status information includes
controller CPU utilization, communication usage, memory usage, task scan
times, and controller loading.

1. In the Studio 5000 Architect” application, expand a controller project
and open diagnostics under Controller Status.

2. Right-click LCPU and choose Open Routine.

Project Bxplorer -~ 3 X
4 PlantPAx -
4 Projects
4 [ Lexcot
< Controller Tags
4 Tasks

4 (B _Controller_Status
a b Diagnostics

<? Parameters and Local Tags
B& Loen
> (® Task_A_§
> Task B_
> (® Task_C_250ms
> (® Task_D_500ms
> (D Task E_1s
> (® Task_F_2s
> (® Task_G_5s
> (® Task_H_10s

Unscheduled Programs

The Logix Designer application opens with the LCPU routine.

Diagnostics - LCPU > hd
el 3 (= B b T
Utilization (V24) Instance Number of ~
Controller Slot Continuous Task if
Humber in local it exists (1..31)
haaais (setto 0 if none)
GBSV
Class Name Task
Instance Name THIS
Dest L_CPU.Cfg_SlotNumber Attribute Name INSTANCE
0 Dest L_CPU.Cfg_ConfTaskinstance
G
Processor
Utilization (WV24)
L_CPU_24_Up
L_CPU_24_Up LcPu []
Cfg_ContTaskinstance kL = Sts_Enabled ==
Cfg_SlotNumber 0w
Cfg_UpdateT S Sts_Timing
Ref_Out L_CPU_OQut
Ref_MsgSetWindow L_CPU_MsgSetwindow [..] = Sts_Busy ==
Ref_MsgGetTrendObjUse L_CPU_MsgGeiTrendObjUse []
Ref_Ms L_CPU_MsgGethemlUse [ - Sts_Done
Ref_MsgGetTaskTimes1 L_CPU_MsgGetTaskTimes1 [.] w
3

3. Inthe MOV instruction, type the controller slot number into the
Source text box.

4. Save your project.
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Add Controller Diagnostics to Follow these steps to add controller diagnostics to your HMI project.
an HMI Project

1. From the Architect application, right-click an application and choose
Open in Designer.

Project Bxplorer - 0 X
4 FlantPAx
4 Projects
- B Lexco
LGXCO2
LGXCO3
LGXCD4
LGXCO5
4 §& PlantPax
4 T prea
4 B plarm
2 PlantPax_AE
4 & Data
“B PlantPAx_DAT

PACH pianipay B
Open Project in Designer |

Delete

Paste
Properties...

Macros
4 Devices

© & Process Area

2. From your FactoryTalk® View project, expand your HMI application
and displays.

3. Right-click a system diagnostic display (for example, process system)
from the template and choose Open.
process Tmon displaymap

| process 4mon displaymap
| proress sustem

Dn

- p on
ol Delete

5 pre Remove

pre Rename ¥

prd Duplicate...

-|E| processvrarcavruspray

process01 areall equipment01 display
process01 areall equipment02 display
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4. From the Global Objects folder, right-click (RA-BAS) Logix Graphics
Library and choose Open.

S8 PlantP A HMI
—a Systemn
IZI Command Line
53 HMI Tags
@ Tags

=53 Graphics

(ra-bas) p
(ra-bas) p 8
(ra-bas) p_
(ra-bas) p_
(ra-bas) p_|
(ra-bas) p_l
(ra-bas) p_l
(ra-bas) p_motorho graphics library

+E Displays

=[] Global Objects

(ra-bas) builtin faceplate objects
(ra-bas) builtin graphics library
(ra-bas) builtin help objects
(ra-bas) common faceplate objects
(ra-bas) logix faceplate objects

(ra-bas) loni Aranhice lihran,

Delete
Rermove

Rename

Duplicate...

5. Right-click the controller graphic in the L_CPU box and choose Copy.

(RA-BAS) Logix Graphics Library.ggfx

(ra-bas) logix graphics library - /PlantPAx//Area (Global Objects)
Copyright @ Rockwell Automation, Inc. All Rights Resenved

Version 4.0-00 BETA B

Display Elements for use with the Logix Library on overview and detail displays

To use these Display Elements on your display:
1) Copy the object and paste it to your display

2) Right click on the new object and select "Global Object Parameter Values”

3) Populate the Values as specified in the description column

— Control Logix

i E

information

5.

s

Objects that use RSLinx diagnostics tags to display controller

r L_TaskMon

_##
_#E
_##
##
_##

~ L_TaskMon Summary —

(=l=]E

NOTE: Many of these display elements use the AOI tags ‘Inf_Type’ (AOI
name) and ‘Inf_Lib" (library name) to determine which faceplate should be
displayed. Fthe faceplate is not displayed correctly, please verify that these

tags are set correctly.

r Logix with Data from L_CPU

Edit
VBA Code...
Objects Methads...
Arrange
Animation
r L_Redun —

Tag Substitution...

n Property Panel
= Object Explorer

v
0

iPU AOI, and UDT
fon

Paste without localized strings
Delete
Duplicate
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6. On the Process system display, right-click anywhere in the window and
choose Paste.

Display Settings...
Display Keys...
VBA Code...

Screen Statistics

Property Panel
Object Explorer

Haste special...

Paste without localized strings

7. Right-click the L_CPU graphics on the Process display and choose
Global Object Parameter Values.

IMPORTANT  To open the L_CPU faceplate, you must open the Display folder
under the FactoryTalk® View SE folder.

HEE N
M - v
@ Edit
] VBA Code...
Methods...
Arrange 3
Animation L4

Convert to Wallpaper
Tag Substitution...

Property Panel
Object Explorer

Cut

Copy

Paste

Paste without localized strings
Delete

Duplicate

8. Type the controller shortcut string in #101.
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9. Select the shortcut in #102, and click OK.

m Yy Global Object Parameter Values -
Mame Value Tag Description
1| #1101 LGXCO1 +++ || Controller Identification {(enter a text string, not a tag)
2 | #102 {/Area/Data:: [LGXCO1]} s++ || Processor Shortcut Mame (j.e. '[MyCLX]")
3 |#120 +++ || Additional display parameter (e.g. /%100 or CC) (optional)
4 | #121 +++ || Additional display parameter (e.g. /¥ 100) {optional)

Cancel | | Help

10. Save the display.
11. Open an HMI template.
12. On the HMI display, click the System Status icon.

P 'aﬂtP AX &D _ >< s E e iisaizon Brocess01 System Status

Distributed Conirol System

Areal1 Areal2

Process System - /PlantPAx,

Modify this screen to represent your network communications.
Logix status objects are available on the (RA-BAS) Logix Graphics Library global object display.

LGXCO1 - fArea/Data:[LGXCO1] .
oK
AILUO Online
LGXCH
Homore R Remote Run

Shortcut:

[Area/Data: [LGXCO1]

Name:

LGXCO01

Time:

Server Status

Firmware:
Revision: 31.11

Device Path:

ControlLogix in slot 0 of the chassis at 172.18.1.100

~ EmBEE:"

Enter Software S/N or Support Contract #

On the HMI template, the controller graphic has some animation that
shows the position of the key switch and controller status indicators.
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13. Click the controller to access the controller status faceplate.

LGXCO01 - fArea/Data:[LGXC01] .
Home Controller Memory Overall (Bytes) [E——
Total: 34584576 Free: 3012776
Communication 1o Data and Logic
Faults Free Free
997,496 33,015,280
Used Used
(PU Usage 32,648 539,152
Total Total
Controller Memory 1,030,144 33,554,432
Max Used Max Used
. 33,728 32,558,016
Maintenance Largest Block Free Largest Block Free
996.416 996,416

Tabs on the faceplate also provide information on the CPU usage and
the status of controller memory and connections.

For details, see the PlantPAx® Library of Logix Diagnostic Objects,
publication PROCES-RM003.

Rockwell Automation Publication PROCES-UMO003C-EN-P - June 2019


http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm003_-en-p.pdf

Add Basic System Diagnostics

Chapter 8

Configure PASS Server Status

In this section, we describe how to add diagnostics for your PASS servers.
These diagnostics provide information on the software components that run
on the PASS, including an HMI server, data server, and an alarm and event

SCI'VCI.

AN

Open Knowledgebase Answer ID 44624 at http://

rockwellautomation.custhelp.com and download the
zip attachment.

Right-click the .zip file and choose Extract All
Open the View 5.0 CPR9 folder.
Right-click the file and choose Open.

Right-click server status-state cpr9 v505 and choose Extract All

| E:-,‘ ih = | Compressed Folder Tools
Home Share View Extract
(-:I - T| . v ThisPC » Documents » AID 44624 View 5.0 CPRS » View 5.0 CPRI »
- Favori MName * Date modified
- Favorites
B Desktop B AddingAFourthServerGroup 2/8/2011 2240 PM
4. Downloads IE]AID 44624 View 5.0 CPR 9 3/28/2011 312 PM
=] Recent places 1) server status-state 4Servers CPRO 2/8/2011 2:40 PM
1) server status-state cprd v305 2/8/2011 2:40 PM
1M This PC | VBACode] Open ) PM
j Desktop Open in new window
| Documents | Extract All
4 Downloads ﬂn T
& Music Open with...
L T P

The example shows the unzipped files.

L EN View 5.0 CPR9
Home Share View

(-:I - T| . v ThisPC » Documents » AID 44624 View 5.0 CPRS » View 5.0 CPRI »
- . Mame - Date medified
- Favorites
B Desktop . server status-state cprd v303 11/1/2015 7:20 PM
4. Downloads 2/8/2011 2:40 PM
£ Recent places IE]AID 44624 View 5.0 CPR 9 3/28/2011 312 PM

1) server status-state 4Servers CPRO 2

/8/2011 2:40 PM

1M This PC 1) server status-state cprd vi0s /872011 2:40 PM
j Desktop || VBACode_ServerStatusState 2/8/2011 2:40 PM
| Documents
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6.

In the FactoryTalk View HMI application, right-click Displays and
choose Add Component Into Application.

2 System
20 Command Line
23 HMI Tags

MNew

I Add Component Into Application...

Delete
Rermove

Import and Export...

& Trend Templates
% Trend Snapshots
] TrendPro Templates

7. Open the server status-state cpr9 V505.gfx file from the files that were

unzipped in step 5.
Zl Add Component Into Project
i(-) - TI| < AID 44624 View 5.0 CPRY » View 5.0 CPR9 » server status-state cprd v303 v & |I| Search server status-state cpr... @ |
Organize v New folder =~ [@M @
¢ Favorites ~ MName * Date modified Type Size
B Desktop || L server status-state cprd v505.gfx fo20073:23Pm  GRxFile 149 KB

4. Downloads

= Recent places

1M This PC
j Desktop
| Documents =
4. Downloads
Jf Music
=| Pictures
& Videos
i, Local Disk (C2)
S Users (\WPASS024
5 C (pass01) ()

€ Matnrl v

File name: | server status-state cprd v305.gfx

240

8. Right-click the imported display and choose VBA Code.

h
VBA Code...

= server status-state cpr9 v505 - /PlantPAx//Area (Display)
FT Server HMI Server
Display Settings... areaname
Display Ki servername

machine name

Property Panel

g Object Explorer
Paste

Paste Special...
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I

Private WithEvents appStatus As Application

9. Find the text circled in the example and type the name of your HMI

server and data server.

'app events used to update real time status

Private Const NUMBEROFDATASERVERS = 2

10. Save the changes to the VBA code and close the server status display.

11. Open the Process system display.

12.  From the Objects menu, choose Push Button>Button.

FactoryTalk View Studio - View Site Edition (Network Distributed)

File Edit View Settings | Objects | Arrange Animaticn Tools Window Help

@EE D@ s I & R 2

(N[O Ao
Explorer - PlantPAx_HM

'modify to suit actual number of DATA servers in app

Private Const ROOT A= String = "/"

Private Const HMISERVEENAME As String = "PlantPAx HMI" '‘default HMI server name - change to actual name
Private Const HMIAREANAME L= String = "/LArea” 'default area for HMI server - change to actual name
Private Const DATASERVEENAME As String = "PlantPAx DAT" 'default OPC Data server name - change to actual name
Private Const DATAARELNAME A= String = "/Lrea/Data" 'default area for data server - change to actual name
Private Const NUMBERCFHMISERVERS = 2 'modify to suit actual number of HMI servers in app

process dmon displaymap
process system

process01 alarm hbuttonbar_4mon

Import...
Faulted [i ]

Symbol Factory L]

e e L

process01 alarm hbuttonbar_Tmon
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Drawing 3 .
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E’E_E Indicater L3 Maintained
e Gauge and Graph L4 Latched 3 . o
-l € Key b Multistate odify this screen to represent your network communications.
Trending v interlocked 1gix status objects are available on the (RA-BAS) Logix Graphics Library global object
Advanced 3 Ramp
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13. Click the display and drag the mouse to draw a button.

>

14. From the Action tab, click Browse (ellipse “...) next to Release action.

process system

5 . Button Properties -
Modify this screer 2
Logix status objeq [ Generl| Acton| Up Anpearance | Down Appearance | Dissbled Appearance | Common | | (dI
Action:
| Run command W |
Press action:
A E
W
Repeat action
~| [

W
Repeat rate (zecs):
Release action:
| ~
v
Confirm Action
Configure
ok |[ cancal |[ Hep

15. From the All Commands and Macros list, select Display and click Next.

Command Wizard Step 1 of 2

Choose a command and click Mest to fill in its parameters.

Command Categories: Commands:
-{_7] Most Recently Used Name Description | Syntax ~
=4 Al Commands and Macros DatalogMergeT... Merges data in the secondary pathto ... DatalogMerge...
-] System DatalogMewFile  Creates a new data logfile inthe spe...  DatalogMewFil...
-] Graphics DatalogOff Stops data logging for the specified M...  DatalogOff <file=
{2 Legacy Alams DatalogOn Start; Qma logging for the specified M...  DatalogOn <file>
(] Data Log DatalogRename... Specifies a new name for the Ioggedf... DatalogRenam...
(1 Logic and Control DataLogSnapshot Logs tag values to .the.data log file for... DataLogSnaps...
gic and L.ontro DatalogSwitchB... Switches from logging in the secondar...  DatalogSwitch... =
-1 RecipePro+ DDEExecute Sends a command or series of comma... DDEExecute <.
i) Mam and Evert Define Creates a symbol. Define <symbal...
Derived(Off Stops running the specified derivedta...  DervedOff <file=

Opens and runs the specified graphic

R = e i
DisplayClientOpen  Open the specified Active Display Clie...  DisplayClientOp...
DisplayMavigatio... Displays a list of previously opened sc...  DisplayMavigati...
DisplayMext Screen  Opens the next graphic display in navi...  DisplayMextScr...
DisplayPrevious... Opens the previous graphic displayin ...  DisplayPrevious...

Download Writes the value in the selected input ... Download
DownloadAll Whites the values in all input fields of t...  DownloadAll
EventOff Stops running the specified evert file. EventOff <file= A

Display <display> [/B] [/E] [/U] [/0] [/Z] [/£A] [/Pfile] [/T<tag>.<tag>....] [/Hnnn] [/Wnnn] [/Min] [/Max] [/M] [position]

Opens and runs the specified graphic display file.

Help | | Cancel Mext = Finish
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16. From the File pull-down menu, choose the server status display.

Command Wizard Step 2 of 2

Syntax: Display <display> [/B] [/E] [/U] [/O] [/Z] [/ZA] [/Ffile] [/ T<tag>.<tag>...]
[/Hnnn] [/Wnnn] [/Min] [/Max] [position]

[] /Mzx - Display Maximized
[T - Parameter tags
[1/Z - Cache Display

= =
["]/B - Display In Background []Window Position

["]/E - Disable Enter Key []/H - Height

[]/U - Upload Data Entry Fields [ - Width

[] 40 - Disable Key List []/%- Left

[ /Min - Display Minimized 77 -Top

[C]/ZA - Cache Display Aways Updating

[ /P - Parameter Fils

Command String:  Display "server status-state cprd v505"
T .
17. Click Finish.

18.  On the Button Properties dialog box, click the Up Appearance tab.

19. In the Caption text box, type Server Status.

Button Properties -
Genemll Action| Up AF'IZ'EE"ElnCE| Down ﬁppeamncel Disabled ﬁppeamncel Common |

General

Back style:

Fare color

.

Pattem style: [ Back color

I Pattem cobr
Caption

Server Status| ~

W
Insert Variable...

Fant: Size:

Aral vl o v Bz (m []
Image settings

(®) No image

Image:
(O Use image reference
) Import file
P Import....
Scale image
==

20. Click OK.

21.  Save the changes to the Process system display.

22. Run the client file and access the System Status page.
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23. Click Server Status.

Modify this screen ti
Logix status objects

Server Status

The Server Status display appears.

Server Status - State Popup
FT Server HMI Server Data Server
Area: Not Applicable IArea IAreal/Data
Server: FTDirectory PlantPAx_HMI PlantPAx_DAT
Machine: pass01 PASS02A PASS02A
Primary: i | Active | | Active |
Secondary: | Standby | | Standby |
| SelectServer.. | | SelectServer.. | | SelectServer.. | |  Close |

Add These Additional
Resources

The example shows a networked station application with the
FactoryTalk server, HMI server, and data server on one workstation.
None of the servers are redundant in this application example.

IMPORTANT  We recommend that diagnostic alarms for network adapters and |/0
modules be added to the Alarm server. The alarms are displayed on
the alarm banner and are included in the alarm log and history

The following resources are available to assist with developing your application.

Topic

Description

Where To Find Information

DLR diagnostics

Device Level Ring (DLR) faceplate shows network status
and where a break is in the EtherNet/IP™ network.

The DLR diagnostics faceplate application can be
downloaded from the Rockwell Automation® Sample
Code website at http://
samplecode.rockwellautomation.com

L_ChangeDet, L_Redun, L_TaskMon library objects

Objects that comprise the PlantPAx Library of Logix
Diagnostic Objects manual monitor Logix controllers on
the network, checking for changes that impact operation
for primary and secondary controller status.

PlantPAx Library of Logix Diagnostic Objects,
publication PROCES-RM003
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Appendix A

Recommended I/0 Module Ranges

You can scale your module to represent I/O data in specific terms for your
application. When you scale a channel, you select two points that represent
signal units: a Low Signal and a High Signal. You also select two points that
represent engineering units: Low Engineering and High Engineering.

For example, if you are using the 1756-IF61 module in current mode, the
module maintains a 0...21 mA range capability. But if your application uses a
4...20 mA transmitter, you can scale the module to represent 4 mA as the low

signal and 20 mA as the high signal.

The NAMUR NE 43 international standard uses the 3.8...20.5 mA signal
range for measurement information. Likewise, signals >21 mA or <3.6 mA
indicate diagnostic failures. By using the range values in the standard,
instrument faults are separated from process measurements.

By staying within the NAMUR value references, instrument faults are
separated from process measurements. Thus, you can adopt maintenance
practices for instruments to operate at peak efficiency.

Figure 14 - NAMUR NE 43 Values.

|
|
\
|
-« 36

-« OperatingRange ——————»

| |
| \
Alarm | | Alarm
| \
| NE 43 ‘21 2
38 Raw Units 205
mA 2 TA
| )
' I
I I
0% Engineering Units 100%
Underrange Alarm Overrange Alarm
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An Overrange or Undcrrange condition is a common cause of inaccurate
channel data reported to the controller. If an input signal is beyond the low and
high signals for the module, the data is represented in terms of engineering
units set during scaling.

Scaling Example Using 1/0 Value Range

In the example for the 1756-IF8IH HART module on page 142, the signal
range is 4...20 mA and the engineering unit range 0...100%.

By default, module channels are scaled in current mode at 4...20 mA that
equates to 0...100% engineering units. Other module channels scale 1:1
regarding signal units and engineering units by default.

EXAMPLE  Using our example, the 1756-IF8IH module in current mode supports
0...22 mA actual range capability. But your application uses
a4...20 mA transmitter.

If you want to receive values in signal units, configure the module as
follows:

Low Signal =4 mA

High Signal = 20 mA

- Low Engineering = 4 EU

High Engineering = 20 EU

If you want to receive values of Percent of Full Scale, configure the
module as follows:

- Low Signal =0 mA
- High Signal = 20 mA
— Low Engineering = 0%

- High Engineering = 100%

See the faceplates on page 247 for scaling by using the numbers in the example.
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The pair of screens in the example shows a Basic and Advanced faceplates.

Using the values in the Example (on page 246), you want to configure scaling

of the raw and engineering units on the Advanced faceplate. The raw values are
entered in the Input text boxes and the engineering range and units are entered
in the Scaled text boxes.

In the Threshold text boxes, which are shown on the Basic faceplate, enter the

recommended threshold limits and Deadband in raw units. These values

account for calibration tolerances and differ slightly from the NAMUR limits
0f 3.60...21.0 mA.

See Figure 15 for more details.

Basic Faceplate

TT01001 - Temperature 01001 B

th Theshot

(raw units)

Deadband

Input Failure

R

(am>

Use Substitute PV

-25.00 No C:- Yes

By clicking the + l T icon, the Advanced faceplate appears to scale
values based on your application requirements and the NAMUR values
shown in Figure 14 on page 245.

Figure 15 - Threshold Limits

Allowable Input
Error=(1.25%/3)

B < 8 < =0.416 % (call it 0.4 %)
DE ~E
™ [3e]
| ‘ | I ‘ |
I 1 I 1
Fail
- -t
> >
Return to Valid
Fail
*Deadband‘b

4—02mA=125%—P

Advanced Faceplate

TT01001 - Temperature 01001 B

?

Raw Input Scaling
Input Scaled

_)@_): 10 |E| |E| |E| :
- 0.00
Uris

Maximum | 20.00

Minimum | 4.00

Allow selection of Substitute PV

PV Source and Quality
(@) Generate SrcQ

() Pass thru connected Channel's SrcQ value

PV Filter Time Constant (sec)
0 = unfiltered

Fail

» »

> >
< <
- -

Return to Valid
" Fail »
Deadband

1 1 1 1
</t >t —a»
6 3 3 6

Fail Threshold
Return Point

3.66667 mA = -2.0833 % 20.63333 mA = 103.9583 %
3.73333mA = -1.6667 % 20.56667 mA = 103.5417 %
ffffffffffffffff - Difference = ---—-—-——--—-

0.06667 mA = 0.4166 % Deadband 0.06667 MA = 0.4166 %
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Notes:
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additional resources 12
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creation 69
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/0 input modules 139
/0 output module 145
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input diagnostics 183
Architect
workflow 15
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alarms 72
asset management
tool configuration 199
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manual 8
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Create
alarm banner 75
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working folder 220
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define
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diagnostics
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configuration 183
controller configuration 233
HMI project 234
1/0 133,177
workflow 232
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1/0 input module 148
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device configuration 201

E300 overload 165
editing

bulk 105
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Excel

bulk editing 105
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process devices 133
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data channel 142
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configure historial points 87
workflow 88

HMI
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1/0 156
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Rockwell Automation Support

Use the following resources to access support information.

Knowledgebase Articles, How-to Videos, FAQs, Chat, User

Forums, and Product Notification Updates, https://rockwellautomation.custhelp.com/

Technical Support Center

Local Technical Support Phone Numbers Locate the phone number for your country. http://www.rockwellautomation.com/global/support/get-support-now.page
Direct Dial Codes Find the Direct D.'al Code for your'produn. Use th? wode to http://www.rockwellautomation.com/global/support/direct-dial.page

route your call directly to a technical support engineer.

Installation Instructions, Manuals, Brochures, and

Literature Library Technical Data. http://www.rockwellautomation.com/global/literature-library/overview.page
Product Compatibility and Download Get help determining how products interact, check !

L2 e ¥ . . g /support/pcdc.pag
Center (PCDC) features and capabilities, and find associated firmware. bt fecusackeselautomatiar sam:global/sLnpott XL page

Documentation Feedback

Your comments will help us serve your documentation needs better If you have any suggestlons on how to improve this document, complete the
How Are We Doing? form at hetp:

Rockwell Automation maintains current product environmental information on its website at http:

Allen-Bradley, CompactLogix, ControlLogix, E300, FactoryTalk, Integrated Architecture, Logix5000, PlantPAx, PowerFlex, Rockwell Automation, Rockwell Software, RSLinx, SMC, SMT, Stratix, Studio 5000 Architect,
and Studio 5000 Logix Designer are trademarks of Rockwell Automation, Inc.

Common Industrial Protocol, ControlNet, DeviceNet, and EtherNet/IP are trademarks of ODVA, Inc.
Microsoft, Excel, and Windows are trademarks of the Microsoft Corporation.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

Rockwell Otomasyon Ticaret A.S., Kar Plaza Is Merkezi E Blok Kat:6 34752 kerenkéy, Istanbul, Tel: +90 (216) 5698400

www.rockwellautomation.com

Power, Control and Information Solutions Headquarters

Americas: Rockwell Automation, 1201 South Second Street, Milwaukee, W1 53204-2496 USA, Tel: (1) 414.382.2000, Fax: (1) 414.382.4444
Europe/Middle East/Africa: Rockwell Automation NV, Pegasus Park, De Kleetlaan 12a, 1831 Diegem, Belgium, Tel: (32) 2 663 0600, Fax: (32) 2 663 0640
Asia Pacific: Rockwell Automation, Level 14, Core F, Cyberport 3, 100 Cyberport Road, Hong Kong, Tel: (852) 2887 4788, Fax: (852) 2508 1846
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